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Welcome to FFI and FFI-Lite 

The FFI ecological monitoring utilities are an integration of FEAT and FIREMON, two respected, 

science-based programs used for fire effects monitoring on public lands. Funded by the 

Interagency Fuels Management Committee and developed jointly by the National Park Service 

and Forest Service, FFI is designed as a comprehensive, database-driven framework that 

organizes sampling protocols, stores field data, and provides analysis tools for vegetation 

sampling and monitoring programs. FFI is designed for people with vegetation sampling 

experience who need a way to organize their sampling data so that it can be readily accessed.  

The goal of FFI is to act as a robust monitoring tool that can be used across public agencies, as 

well as private entities, to consistently describe ecological systems. It incorporates components 

necessary to conduct a successful monitoring program, including an integral database, analysis 

and reporting tools, a modular spatial component, and a protocol manager that enables users 

to develop their own sampling methods when needed. 

FFI-Lite is a version of FFI that is easier to install and manage than FFI. Unless otherwise specified, 

any description of FFI in this user guide also pertains to FFI-Lite. 

Key concepts 

FFI was designed and developed with several key concepts in mind, and it is these concepts 

that distinguish FFI from other contemporary monitoring tools. Understanding these concepts will 

help you to make the best use of FFI's capabilities. 

o FFI is based on the monitoring protocols and methods used in FEAT and FIREMON and 

adds several new protocols. (For descriptions of each, see About the FFI protocols in the 

Additional information section.) Collected monitoring data is maintained independently of 

the methods and protocols. 

o Your methods and data will be permanent and portable. FFI is designed to support your 

monitoring and data management routines while ensuring that your methods and data 

remain separate from the tool itself. The tool is database-driven, rather than method-

driven. This means that your assembled methods and collected data will always be 

available to you, whether or not you use them within the framework of FFI.  

o Monitoring data is auditable data. FFI can help to ensure that organizations can collect, 

validate, track, and store auditable environmental monitoring data over the long term, 

and that the data will continue to be accessible. 

o FFI is hierarchical. The tool is based on a hierarchy of geography, time, and method. This 

hierarchy is imposed and preserved by the database structure. The geographic hierarchy 

is represented by the administrative unit (whole study area), project unit (sample 

population), macro plot, and sample. The temporal component is represented by 

scheduled sample events. 
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Text conventions in the User Guide 

The table below shows the text conventions used in this manual. 

CONVENTION DESCRIPTION EXAMPLE 

Bold Something to be selected or clicked; name of 

module, tab, menu or file. 
The Database Select window opens. 

Click the New Program icon. 

Italic Name of field, dialog box, or window; options to 

be selected; directory path. 
Click Next on the Confirm Installation 

screen 

courier font Text to be entered using the keyboard Enter string of text using the 

keyboard. 

NOTE Note Notes provide additional information 

pertinent to a topic. 

CAUTION Caution Cautions provide warnings. 

Blue underlined 

italics 
Internal links; Web links See Using FFI for more information. 
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FFI-Lite 

The user experience of the FFI and FFI-Lite applications were designed to be as similar as 

possible. Unless otherwise specified, any description of FFI in this user guide also pertains to FFI-

Lite. The major differences are: 

 Computers with FFI-Lite cannot be part of a FFI network configuration (i.e., not used as a 

client or database master computer)  

 FFI-Lite does not support the FFI GIS Toolbar 

 FFI-Lite does not support PDA data collection 

If you need any of these capabilities then FFI and SQL Server Express must be used.  

Additionally, if you want to create custom protocols they will need to be created in Protocol 

Manager, which is only available with the full version of FFI. A custom protocol can be imported 

into FFI-Lite after being created in Protocol Manager. 

FFI-Lite Software Components 

FFI-Lite database are created in Microsoft SQL CE, which is native on Windows XP, 7 and 8 

operating systems and does not require a separate installation of off-the-shelf software. The only 

installed software for FFI-Lite is the FFI-Lite application itself.  

FFI-Lite Use Cases 

FFI-lite is designed to be an easy-to-install alternative to FFI. It will be most useful for: 

 Field data collection 

 Smaller monitoring programs that do not need to access FFI databases from multiple 

workstations, do not use the FFI GIS toolbar and do not use PDA data collection devices 

Using FFI-Lite: Things to not do on the field computer 

These things should not be done on the field computer or field database. Do them on the 

master computer, in the master database instead: 

1) Do not use the New menu to create Administrative Units, Projects Unit, Macro Plots or 

Sample Events with the same name as those in the master database. I.e., all 

Administrative Units, Projects Unit, Macro Plots and Sample Events should be imported to 

the field computer, not created on the field computer. 

2) Do not change local species codes in Species Management 

3) Do not identify unknown species using the Identify Unknown utility in Species 

Management 

4) Do not replace a species code using the Replace Species in Method Data utility in 

Species Management 

5) Do not add or edit Monitoring Statuses using the Monitoring Status Builder utility 

6) Do not assign Monitoring Statuses to Sample Events 
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7) Do not change the names of Project Units or Macro Plots. 

NOTE: If you use FFI-Lite to store your master database then items 1 through 6 can be done 

using FFI-Lite, but only in the master database.  

FFI-Lite Installation Process 

NOTE: You will need a .zip extraction utility such as WinZip to unzip the FFI Installation 

package. 

 NOTE: You must have Windows administrator privileges or ability to “Run Elevated” to install 

FFI-Lite on your computer. A standard Windows user can use FFI after a Windows 

administrator has installed it. 

1.  Get Administrator Privileges on the computer you are installing FFI on. 

2.  Open Windows Explorer or My Computer, create a temporary directory on your C: drive 

where you will store the installation files (e.g., c:\FFITemp).  

3.  Open a browser, go to the FFI-FRAMES website and download FFI-Lite Install Package from 

the FFI Software and Manuals page, Software Instructions and Training Data tab. Save the file in 

the temporary directory you created above. 

4.  Close your browser. 

5.  In Windows Explorer or My Computer, navigate to the temporary directory and unzip the 

installation file into the same temporary folder. 

6.  In Windows Explorer or My Computer, double-click the FFI installation file you unzipped in #3: 

Setup.exe. 

NOTE: Forest Service Users: To install FFI-Lite right-click on Setup.exe, select Run Elevated, 

type a justification and click OK. 

7.  The FFI-Lite Setup Wizard page will open. Click Next. 

 

http://www.frames.gov/ffi
http://www.frames.gov/partner-sites/ffi/software-and-manuals/


14 
 

8.  Accept the default installation folder and click Next. 

 

 

 9.  Click Next on the Confirm Installation screen.  

 

 

10.  Click Close when the installation is complete. The FFI-Lite 1.05.03 icon will be placed on your 

desktop. 
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Creating a FFI-Lite Database 

1.  Double-click the FFI-Lite icon to open the application. 

 

 

2.  Select the Create a New Database radio button and click the gray button next to the red 

circle. 

 

 

3.  Name the database and click Save. 
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4.  Click OK. 

 

 

5.  Click New Administrative Unit, enter a name and click Save & Close. 

 

 

6.  Check the box for the new administrative unit and click Continue.  
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7.  The new FFI-Lite database will open and you can set up you database following in Using FFI: 

Basic Steps for the Beginner. 

 

 

 

 

Opening an Existing FFI-Lite Database 

1.  Double-click the FFI-Lite icon to open the application. 
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2.  Click the Open an Existing Database radio button, highlight the database in the window 

below by clicking on it once and click Open.  

 

 

3.  If the database can’t be found in the specified location a warning will be displayed. Click 

OK. Select a new database to open. 

  

 

4.  The database will open to the Administrative Unit selection screen. Select the Administrative 

Unit you want to work in and click Continue to open your data. 
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5.  To search for the database in a different location highlight More Files… by clicking on it once 

and click OK. 

 

 

6.  Navigate to the location of the database, click the database name once to select it and 

click Open. 
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7.  The database will open to the Administrative Unit selection screen. Select the Administrative 

Unit you want to work in and click Continue to open your data. 

 

Backing up a FFI-Lite database  

You should always have at least two copies of your FFI-Lite database: 1) the “master” database 

which is the working database you open in FFI-Lite and 2) a “backup” database that includes 

your most recent edits. Your backup database should be saved on a different computer than 

your work computer – preferably a computer in a remote location such as a network server. 

Every time you modify your FFI-Lite database, such as when entering or editing data, you should 

create and save a backup copy of your database.  

1. Open Windows Explorer or My Computer and navigate to the folder where your FFI-Lite master 

database is saved  

2.  Right-click on the database filename (it will have an .sdf extension). 

3.  Select Copy. 

4.  Right click in the same folder and select Paste. This will create a backup database with the 

name databasename – Copy. sdf (e.g., MyDatabase – Copy. sdf).   

5.  Next, rename the backup. Right-click on the backup database filename and select Rename. 

6.  Modify the database name to include the date (e.g., MyDatabase – Copy – Oct012014) and 

hit the Enter key. 

7.  Right-click on the backup database filename and select Cut. 

8.  In Windows Explorer or My Computer navigate to the location where you save your backup 

databases. 

9.  Right-click and select Paste.  
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FFI 

FFI Software Components 

FFI incorporates a combination of off-the-shelf and custom software products. 

Off-the-shelf software 

o Microsoft SQL Server – This is the database software that FFI uses. This software was 

selected because it has been approved by the land management agencies and 

because the “Express” version is free. 

Custom software 

Custom software consists of three major components. After the FFI software is installed there will 

be an icon for each component on the computer desktop:  

o FFI Database Administration – FFI uses Microsoft SQL Server databases for storing field data 

and FFI protocols. The Database Administration component is the connection between FFI 

and SQL Server and used for managing your FFI and Protocol Manger Databases. 

Examples of database management activities include creating, restoring, backing up, 

patching and deleting databases.  

 

o FFI Data Tools – Labeled “FFI” on the computer desktop icon this component is where users 

spend most of their time entering and editing field data, managing species lists and 

querying data and running reports.  

  

 FFI GIS module. An optional component available in FFI Data Tools, FFI GIS uses an 

Arc Toolbar to assist project unit development, sample design, macro plot location, 

and spatial data query, allowing you to see your plots in the 'real world'. 

  

o FFI Protocol Manager - This component is for creating and managing protocols. The FFI 

installer includes a number of pre-made, “standard” field sampling protocols so most users 

do not use protocol manager.  

Data Hierarchy 

The basic goal of FFI is to provide structured storage of monitoring data collected multiple times 

at the same sampling location, over time. Understanding the data hierarchy in FFI will help you 

visualize how your data is stored: 

o Database: FFI databases stored in SQL are the highest level in the hierarchy. Databases 

are managed in FFI Database Administration.  

o Administrative Unit: This major division in a database is usually created so data within are 

from distinctly different geographic and/or vegetative types. In FFI, each Administrative 

Units has its own local species list. There is no limit to the number of Administrative Units in a 

database. Administrative Units and all lower levels of the data hierarchy are managed the 

FFI Data Tools. 
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o Project Unit: Generally used to aggregate data that were collected to assess very similar 

treatment objectives and collected with very similar field sampling methods. Reports and 

analysis can only be accomplished for the Macroplots assign in one Project Unit. There is 

no limit to the number of Project Units in an Administrative unit. 

o Macroplot: Physical location where field sampling takes place. A Macroplot is typically 

defined as a two-dimensional area (e.g., fixed area plot for sampling trees or area where 

multiple sample points are established), one-dimensional transect or set of transects 

(sampling planes for down woody material) or combination of one- and two-dimensional 

sampling sites. Ideally, the same field sampling procedures are repeated at every sample 

event. There is no limit to the number of Macroplots in a Project Unit. A Macroplot (and 

associated Sample Event(s)) can be assigned to more than one Project Unit 

o Sample Event: The date of a field sampling visit to the Macroplot. There is no limit to the 

number of Sample Events at a Macroplot. Often it takes days or weeks to sample all the 

Macroplots that will end up all being analyzed together. FFI uses Monitoring Status to order 

group and order Sample Events for analysis, regardless of the Sample Event date, for 

analysis.  

o Monitoring Status: A label defined and assigned by the user that describes the reason 

and/or temporal order of Sample Event. For example, three Sample Events might occur for 

the Macroplots in a Project Unit: Pretreatment, Immediate posttreatment and one-year 

posttreatment. Only one Monitoring Status per Sample Event per Project Unit is allowed.  

Nomenclature 

FFI uses specific terminology, some of which is adapted from FEAT and FIREMON, its 

predecessors. Please familiarize yourself with the terms used in FFI. 

FIREMON 

TERM 

FEAT TERM FFI TERM DESCRIPTION 

Registration 

ID 

Land unit Administrative 

unit 
The study area, or the entire geographic area covered by a 

sampling effort.  

Project ID Monitoring 

unit 

Project unit A subset of the administrative unit; a sample population. A 

project unit, or project, consists of macro plots, sample events, 

and status. 

  Sample site Candidate site A geographic point within a project that has been identified as 

a potential macro plot. 

Plot 

location 

Macro plot Macro plot A regularly shaped plot within the project unit that contains the 

target population to be monitored. A macro plot has a specific 

azimuth around which method data are collected. 

Sample 

event 

Monitoring 

event 

Sample event The date on which sampling or treatment is scheduled. 

Sample 

events 

Status Monitoring 

Status 

A context for a monitoring event in relation to treatments or 

disturbances. 

    Protocol A collection of related methods. 

Method Protocol Method A set of specifications, procedures, and requirements for 

collecting data during a sampling event, and an associated 

set of attributes. 

Field Attribute Sample 

attribute 

Sample attributes describe the conditions associated with a 

particular sampling event, such as date and time, plot and 



23 
 

sample size, weather, names of sampling team members. 

These attributes are generally collected once per sampling 

event. 

    Method 

attribute 

Method attributes describe the data being collected and 

analyzed, such as species, count, tree dbh, tree height, 

percent cover and status. These attributes are generally 

collected more than once per sampling event. 

 

Suggested file structure 

A suggested organization for your FFI directories is shown below. This folder structure should be 

created under C:. 

In general, FFI will allow you to file documents wherever you wish. However, there are some 

instances in which FFI will place, or search for, files in specific locations: 

o Photos should be stored in C:\FFI\Photos. 

o Files exported by the Project Files function in Reports and Analysis may be placed in 

C:\FFI\AdminUnit\Project Files. 

o Forest Vegetation Simulator (FVS) export files may be placed in C:\FFI\FVS. 

NOTE: If you are not using the FFI GIS module, you may not need all of the folders shown. 
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Using FFI - Basic steps for the beginner 

If you are a new user just getting started FFI can be pretty overwhelming and, while this User 

Guide is comprehensive, it is not organized in an easy 1-2-3 cookbook format for new users. Here 

are the basic steps you’ll need to use FFI. Each step is linked to the applicable section of the User 

Guide. 

o Install the FFI and SQL Server software. Installation instructions 

o In FFI Database Administration, create an empty FFI database. Managing Databases 

o In FFI (Data tools), import protocols. Protocols and Methods 

o In FFI (Data tools), add project units, macroplots and sample events. Project 

Management 

o In FFI (Data Tools), assign protocols to sample events. Working with Sample Events 

o In FFI (Data Tools), create a local species list. Species Management 

o In FFI (Data Tools), enter monitoring data. Data Entry and Edit 

o In FFI (Data Tools), assign monitoring statuses to sample events. Monitoring Statuses 

o In FFI (Data Tools), create data reports. Reports and Analysis 

o In FFI Database Administration, backup your database. Managing Databases 

Getting additional help 

If you need help beyond the information provided in this User Guide, visit the FFI FRAMES website. 

This FRAMES page provides: 

  

o A link to the FFI Google Discussion Group. 

o Help/How-to documents 

o Links to FFI documentation and training information. 

o General information about the FFI ecological monitoring utilities. 

o Contact information for email and phone support. 

o Links to other FRAMES pages. 

Links 

o On-line FFI information at FFI FRAMES website 

http://www.frames.gov/ffi 

o On-line users community at Google Groups 

http://groups.google.com/group/FFIemu 

 

In addition to the FFI User Guide you are currently viewing there are three more User Guides 

available on the FFI Software and Manuals page on the FFI Frames website: 1) Protocol 

Manager, 2) PDA and 3) GIS.  

http://www.frames.gov/ffi
http://groups.google.com/group/FFIemu
http://www.frames.gov/ffi
http://groups.google.com/group/FFIemu
https://www.frames.gov/partner-sites/ffi/software-and-manuals/
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FFI Installation 

This section of the User Guide addresses: 

o Installation requirements 

o Installing FFI 

Installation requirements 

FFI is based on Microsoft® SQL Server 2012. FFI users have two SQL Server choices: 1) SQL Server 

Express 2012 is a free program that can be used with databases up to 10 GB in size; 2) the full 

version of SQL Server 2012. The full version does not have a maximum database size limitation but 

must be purchased.  

SQL Server 2012 Express is available for 32-bit and 64-bit (Windows 7) operating systems. 

Installation files for both the 32- and 64-bit versions of SQL Server Express are posted on the FFI 

FRAMES website. If you wish to use the full version of SQL Server contact your IT representative. 

Hardware and software requirements 

General requirements: 

o Minimum screen resolution of 1024 X 768 (XGA). 

o Windows 7 or Windows 8. 

o Microsoft SQL Server 2012 Express. 

http://www.fs.fed.us/rm/pubs_int/int_gtr016.pdf
http://www.treesearch.fs.fed.us/pubs/24042
http://www.nps.gov/fire/wildland-fire/resources/documents/fire-effects-monitoring-handbook.pdf
http://www.nps.gov/fire/wildland-fire/resources/documents/fire-effects-monitoring-handbook.pdf
http://plants.usda.gov/
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Stand-alone or database master computer: 

Minimum requirements 

NOTE: The minimum requirements are adequate for small (less than 50 MB) FFI databases. 

o Free disk space: 600 MB before installing SQL Server Express, plus sufficient space for 

database storage. 

o Memory: 512 MB or more of RAM. 

o Processor: 1 GHz or higher. 

Recommended requirements 

For larger databases, we recommend: 

o Free disk space: 600 MB before installing SQL Server Express, plus sufficient space for 

databases, which can range in size from 600 MB to 4 GB each. 

o Memory: 1 GB of RAM. 

o Processor: 2 GHz or higher. 

NOTE: We have noted that there is a significant improvement in performance between 512 

MB and 1 GB of RAM. Additional RAM above 2 GB yields limited improvement. 

Database client computer: 

o Free disk space: 600 MB. 

o Memory: 512 MB or more of RAM for databases smaller than 50 MB; 1 GB for larger 

databases. 

GIS-capable stand-alone or database client computer: 

o ArcGIS 10.0 and ArcGIS 10.1 

o Recommended system requirements as stated above. 

Database server: 

o Free disk space: sufficient space for databases, which will range in size from 600 MB to 4 

GB each. 

NOTE: FFI does not have to be installed on the database server. 
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Personal digital assistant (PDA): 

NOTE: PDA development ended with FFI v1.04.00 

o Windows Mobile 5. 

o 256 K RAM memory (minimum) 

o 520 Mhz (minimum)  

Computer configurations 

As depicted below, FFI can be installed as a stand-alone system with GIS or PDA options, or as a 

networked system, also with options for GIS and PDA. 

 

Stand-alone, field or database master computer: 

o The stand-alone computer has no other computers attached to it that share its internal 

databases. The FFI and FFI-Lite import/export utilities are used to move data between 

databases. 

Client computer:  

o Connected to the local area network (LAN) and uses data stored on the database master 

or database server. This can be a field computer. This configuration is not available when 

using FFI-Lite. 
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GIS-capable stand-alone or database client computer: 

o Configured like the stand-alone or client computer, but equipped with GIS software. The 

FFI GIS toolbar is not available when using FFI-Lite. 

Database server: 

o A dedicated computer running a database engine that can be accessed either directly 

from a server or client computer with password protection, or via an intranet connection. 

This configuration is not available when using FFI-Lite. This configuration requires that the FFI 

administrator has physical access to the server. See the Database Administration section 

for more information. 

Personal Digital Assistant (PDA) 

o A PDA is a portable device that stores data collected in the field for later transfer to the 

client or stand-alone computer. FFI-Lite does not include PDA support. 

  

FFI Installation Process 

NOTE: You will need a .zip extraction utility such as WinZip to unzip the FFI Installation 

package, GIS files and Training dataset. 

You must have Windows administrator privileges or ability to “Run Elevated” to install FFI on 

your computer. A standard Windows user can use FFI after a Windows administrator has 

installed it. 

Create a temporary directory on your C: drive, such as C:\FFITemp, where you will store the 

installation files.  

To complete the FFI installation you will need to download the install files from the FFI FRAMES 

website.  

Download the following files from the FFI Software and Manuals page, Software Instructions and 

Training Data tab, on the FFI FRAMES website and save them in the temporary directory you 

created above: 

1. FFI Install Package 

You may also want to download these optional files: 

2. If you plan on installing the GIS Tool then download the FFI GIS Installers and User Guide 

3. If you want to use our test dataset to practice with then download the FFI Training 

Dataset 

 

 

http://www.frames.gov/ffi
http://www.frames.gov/ffi
http://www.frames.gov/partner-sites/ffi/software-and-manuals/
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There are four key steps involved in installing FFI and creating a database.  

NOTE: The full installation process typically requires about an hour to complete. 

1. Part 1 - Installing FFI and .NET 

2. Part 2 - Installing SQL Server 2012 Express 

3. Part 3 - Creating a database using FFI Database Administration 

4. Part 4 - Opening FFI, logging on, and selecting database 

Part 1 – Installing FFI and Microsoft .NET 

To install FFI follow these steps: 

1.  Create a backup of your data in FFI Database Administration. See Backing up a Database. 

2.   Uninstall any earlier versions of FFI using the Windows Add/Remove Programs function. (Do 

not uninstall any Microsoft SQL Server components.) 

3.  In Windows Explorer or My Computer, navigate to the temporary directory where you stored 

the FFI files you downloaded from FRAMES. 

4.  Double-click on the .zip file for the FFI install package and unzip the files into the same 

temporary directory you downloaded the .zip file from FRAMES. The file name will be similar to 

FFIv10500.zip. 

5.  Double-click the FFI installation file: Setup.exe. 

NOTE: Forest Service Users: To install FFI right-click on Setup.exe, select Run Elevated, 

type a justification and click OK. 

6.  The installer will check to see if Microsoft .NET Framework 3.5 SP1 is installed. 

7.  The FFI Setup Wizard page will open.  

8.  Click Next. Select the installation folder and click Next. 
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9.  Click Next on the Confirm Installation screen.  

10.  When FFI finishes installing click Next. 

11.  Click Close when the installation is complete. 

Three FFI icons will now be on your desktop: 1) FFI Protocol Manager, 2) FFI Database 

Administration, 3) FFI. 

 

 

Part 2 – Installing SQL Server 2012 Express 

CAUTION: Follow these SQL installation directions carefully. There are a number of options you 

must change during installation of SQL. Review each step before proceeding and use the 

Back button if you think you missed something. Also, remember the password you select in 

Step 17 or you will not be able to use FFI. 

NOTE: If you have existing FFI databases be sure make backups of each one before installing 

SQL Server 2012. 

1.  Click the link below (or copy and paste the URL into a browser) to go to the SQL Server 2012 

Express download site:  

 http://www.microsoft.com/en-us/download/details.aspx?id=29062 

2.  Click Download 

 

http://www.microsoft.com/en-us/download/details.aspx?id=29062
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3.  Check the box next to ENU\x86\SQLEXPR_x86_ENU.exe and click Next 

NOTE: Download size is 116.7 MB. You can use this file to install SQL Server 2012 on machines 

running both 32 and 64 bit Windows operating systems. 

 

 
 

 

4.  Click Save. Do Not select Run.  
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5.  Navigate to the temporary folder you created above (e.g., C:\FFITemp) and click Save. 

 

6.  After the download is complete close your browser. 

7.  Using Windows Explorer or My Computer, navigate to your temporary FFI folder and double 

click on the file name: SQLEXPR_x86.EXE. A progress bar will appear while the files are being 

extracted.  

NOTE: Forest Service Users: To install SQL Server Express right-click on SQLEXPR_x86.EXE, 

select Run Elevated, type a justification and click OK. 
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8.  When the SQL Server installation Center window opens it will be set at the Installation step 

shown on the left side of the screen. Click the option to install a New SQL Server stand-alone 

installation or add features to an existing installation.  

 
 

 

9.  A progress bar will display as the Setup Support Rules are checked. This process checks to 

make sure the system is capable of completing the SQL Server installation. You will be warned if 

system updates and/or changes are needed. 
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10.  Check the box to accept the License Terms and click Next. 

 

 
 

11.   The Install Setup Files Screen will be displayed. 

12.   If you are not connected to the internet the Project Updates window may display. You may 

click Next to ignore checking for updates. Windows will check for updates the next time the 

computer is connected to the internet. 
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13.  A progress bar will be displayed as the Setup Support Rules are checked. 

 

 

14.  On the Feature Selection window make sure the boxes are checked for Database Engine 

Services, SQL Server Replication and SQL Client Connectivity SDK. Click Next. 
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15.  On the Instance Configuration there are two options depending on the agency you work 

for: 1) if you are not a Forest Service user you may use all the default settings or 2) if you are a 

Forest Service user you must change the Instance Root Directory to C:\Users. If there is already a 

SQL Server Express instance installed on the computerenter enter  a new name in the Named 

Instance field (e.g., SQLEXPRESS2). Remember that you will need to connect to that instance 

name when using FFI. Click Next. 

 

 
 

 

16.   On the Server Configuration window set the SQL Server Browser to Automatic and click 

Next. 

 

 
 

Forest Service Users Only: 

Click the box with three 

dots on the right and 

change this directory to 

C:\Users  
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17.  On the Database Engine Configuration window click the Mixed Mode radio button, enter 

your Password and confirm it. No changes are needed on the Data Directories or User Instances 

tabs. Click Next. 

NOTE: Select a password that you can remember because you can’t access your FFI 

database(s) without it. If you are IT staff installing FFI for a user, make sure you let the 

user know what password you selected for them.  

When password complexity policy is enforced, new passwords must meet the following 

guidelines: 

The password does not contain the account name of the user. 

The password is at least eight characters long.  

The password contains characters from three of the following four categories: 

Latin uppercase letters (A through Z) 

Latin lowercase letters (a through z) 

Base 10 digits (0 through 9) 

Non-alphanumeric characters such as: exclamation point (!), dollar sign ($), number 

sign (#), or percent (%). 

 

(More info: http://technet.microsoft.com/en-us/library/ms161959.aspx) 

 

 
 
 
 
 
 
 
 
 

You can allow other users to 

access this instance of SQL:  

1) Click Add… 

2) Type the user’s computer 

login name in the box 

3) Click Check Names  

4) Click OK 

http://technet.microsoft.com/en-us/library/ms161959.aspx
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18.  No changes are needed on the Error Reporting window. Click Next. 

 

 
 

 

19.  A progress bar will be displayed on the Installation Progress window as the SQL Server Express 

is installed. Click Next when complete. 
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20.  The Complete window will display any errors encountered while installing SQL Server Express. 

If no errors are shown click Close and then Exit the SQL Server Installation Center window.  

 

If errors are displayed, help may be linked on the screen or a Google search of the issue may 

help resolve it. 
 

 
 

Setting Folder Permissions 

NOTE: Forest Service users do not need to set folder permissions and can skip this section 

If you are an agency employee and you do not typically have Administrator Privileges on your 

computer follow the directions in this section to set folder permissions for SQL Server.  

If FFI and SQL are installed on the same computer and you always have Administrator Privileges 

on the computer you do not need to set folder permissions. Proceed to: Part 3 – Creating a FFI 

database. 

 

1.  Open Windows Explorer or My Computer and navigate to the C:\Program Files 

(x86)\Microsoft SQL Server folder.  

 

2.  In Windows Explorer or My Computer navigate to C:\Program Files(x86)\Microsoft SQL 

Server\MSSQL.1\MSSQL. 
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3.  Right-click the MSSQL folder and select Properties. Look for the Security tab. If you see the 

Security tab, select it and proceed to step 4. 

 

a. If you do not see the Security tab, you will need to turn off Simple Sharing. In Windows 

Explorer, highlight the Error Logs folder by clicking on it once and at the top of the 

Windows Explorer screen select Tools > Folder Options.  

b. In the Folder Options dialog, switch to the View tab. 

c. Scroll down the list of Advanced Settings and uncheck Use simple file sharing. 

 

d. Click OK. 

e. Return to the Properties dialog for the folder as described above. 
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4.   Select the Security tab and if you see your Windows user name in the Group or user names 

box skip to step 7, otherwise click Edit and then in the new window that opens click Add. 

 

 

5.   In the Select Users or Groups dialog, type your Windows user/login name in the window 

entitled Enter the object names to select. (This is the user name you use when you log in to 

Windows.  E.g., Barney Fife = bfife).  

 

6.   Click Check Names and watch to see if the format of your username changes (indicating 

that it was found by Windows). Click OK. 
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7.  On the Security tab, highlight your user name in the list of Group or user names and check to 

Allow, Full Control. Click OK. 

 

 

8.  Next, make sure your user/login has Full Control access to the Backup, Data and Log folders. 

The steps used to set permission for these folders are the same as used to set permissions for the 

MSSQL folder. 
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9.  Finally, check to make sure SQL Server permissions are set for the Backup, Data and Log 

folders: 

a. Right-click the folder name (Backup, Data and Log). 

b. Select Properties. 

c. Select the Security tab. 

d. Click the MSSQL$SQLEXPRESS instance user. 

e. Click the checkbox to Allow, Full Control. 

f. Click OK. 

 

10.  SQL Server 2012 Express is ready for use. 

 

Part 3 – Creating a FFI database  

FFI uses a SQL Server 2012 database to store protocols and methods. If a database is not already 

available for your project, you must create one before you can begin to work with FFI. Use FFI 

Database Administration to create a new database. 

 

1.  Double-click the FFI Database Administration icon on your desktop.  
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2. In the Connect menu, select SQL Server. 

 

 

3.  If the SQL Server Instances field is blank click the Find Servers button to refresh the list. It may 

take a minute to find all of the servers. During that time the hour glass will be displayed. When 

the hourglass disappears click the down arrow to select the SQL instance you created in Part 2, 

step 15. 

NOTE: If the SQL instance is not found you can manually enter it. The SQL instance name will 

typically be in the format: computer name\SQLEXPRESS. If you don't know your computer's 

name click Start > Control Panel > System, click the Computer Name tab and look for the Full 

Computer Name. 
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4.  Enter sa (which stands for System Administrator) as the User Name and the SQL password that 

you created in Part 2, step 17. Click Connect. 

 

 

5.   In the tree view in the left pane of the Database Manager window, highlight the name of the 

SQL server instance by clicking on it once. 
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6.  In the Server menu, select Create Database. Select FFI. 

 

 

7.   Enter a unique name, such as a park or forest name, for the new database and click OK.  

NOTE: You cannot use a database name that already exists in your SQL instance. Database 

names cannot contain spaces and must begin with an alphabetic character. Database 

names cannot be changed so choose one you can live with. 
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8.  A DOS window and a progress bar open, as shown below. Wait while the database is 

created, which could take a few minutes, depending on your computer. 

 

 

 

9.  A dialogue box will notify you when the database has been created. 

10.  In the tree view of the Database Manager window, open the Databases folder by clicking 

on the plus sign to the left of the Databases label. The new database will be listed. The schema 

name, schema version and other information is displayed in the right pane. 

 

 

11.  Close FFI Database Administration.  
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Part 4 – Opening FFI and logging in 

1.  Double-click the FFI icon on your desktop, or launch FFI from your Start menu (Start > All 

Programs > FFI 1.05.03 > FFI 1.05.03). The Database Select window opens. 

 

NOTE: The FFI splash screen may be visible for a few moments while the program loads. 

 

2.  If the SQL Server Instances field is blank click the Find Servers button. An hourglass will be 

displayed for up to a minute as the FFI locates SQL instances. When the hourglass disappears 

click the down arrow to see the available servers. Select your SQL Server instance from the 

dropdown. 

NOTE: The server name is typically in the format: computer name\SQLEXPRESS.  
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3.  Enter the User Name, which will be sa (System Administrator), enter the SQL password you 

selected in Part 2 of the SQL Server installation and click the down arrow on the Select or Enter a 

Database Name field. An hourglass will appear while the list is populated, then the list will flash 

briefly. Click the down arrow again to select the database you created in Part 3 of the SQL 

Server installation. If the server instance is not available in the SQL Server Instances field type it in 

manually.  

 

NOTE: If the Select or enter a database name field is blank you have most likely entered an 

incorrect SQL password. You must re-enter the User Name AND Password when you re-

attempt to log on to the server.  

4.  FFI will open and the new database will be connected.  

5.  You have successfully installed the FFI components and created a test database. 

  

For further instruction using FFI features and functions, see Basic Steps for the Beginner. 
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Database Administration 

In FFI, administrative functions, including SQL Server and database management, are managed 

by the FFI Database Administration module, which connects directly to the database server. 

When you first install FFI, you create an SQL Server, system administration (sa) account. This 

account enables you to access the server and build user databases and administrative units. 

When using a server or master computer configuration all the database administration tasks 

listed in (1) and (2) below will be done on the server or master computer by someone logged on 

as an FFI administrator. The FFI administrator must have physical access to the server or master 

computer. If the server is in a remote location a designated SQL Server manager must be 

assigned as a FFI administrator and willing to do the tasks list in (1) and (2) below. 

  

The Database Administration module lets you manage: 

1. Databases: 

o Creating a database 

o Restoring a database from backup. 

o Deleting a database 

o Backing up a database 

o Patching a database to function under the current version of FFI. 

2. Users and roles: 

o Adding and deleting users. 

o Assigning and deleting user roles. 

NOTE: For information about user roles, see User roles and permissions. 

  

Logging in to the Database Administration module 

To open the Database Administration module and work in SQL Server: 

1.  Double-click the FFI Database Administration icon on your desktop or launch the module from 

the Start menu. The Database Manager window opens. 
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2. In the Connect menu, select SQL Server. 

 

 

3.  If the SQL Server Instances field is blank click the Find Servers button to refresh the list. It may 

take a minute to find all of the servers. During that time the hour glass will be displayed. When 

the hourglass disappears click the down arrow to select your SQL instance.  

NOTE: You can also manually type in your SQL instance name. It has the form 

computername\SQLEXPRESS E.g., HPLT934759\SQLEXPRESS. Some Windows 7 users MUST type 

in their SQL instance name for the first use. 
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4.  Enter your User Name and Password.  Click Connect. 

 

 

5.  The Database Manager opens. 
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Managing databases 

Both the Server and Database menus in FFI Database Administration provide access to 

database management functions. 

NOTE: If using a server or master computer configuration all these tasks must be done on the 

server or master computer by someone logged in as an FFI administrator 

Server menu 

 

o Creating a Database – create new FFI or Protocol Manager databases. 

o Restoring a Database – restore a deleted or damaged database from a backup 

database file. 

o Deleting Database – delete a database. 
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Database menu 

 

 

o Backing up Database – create a backup copy of the selected database. 

o Patching a Database – update an existing database so that it works correctly with a new 

version of FFI. 
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Creating a database 

To create a new SQL Server database: 

1.  In the tree view of the Database Manager window, highlight the name of the SQL server 

instance. 

 

 

2.  In the Server menu, select Create Database. Select FFI. 
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3.  Enter a unique name, such as a park or forest name, for the new database and click OK.  

 

NOTE: If a database with the name that you selected already exists, FFI will prompt you to 

enter a different name or to overwrite the existing database. Database names cannot 

contain spaces and must begin with an alphabetic character. 

 

4.  A DOS window and a progress bar open, as shown below. Wait while the database is 

created, which could take up to 5 minutes, depending on your computer. 

 

 

NOTE: Under some circumstances, you might receive an error message reading "Database 

Creation Failed - The database you have created does not appear to have a valid schema". 

This generally occurs when using a slow processor. Simply try creating the database a second 

time. 
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5.  In the tree view of the Database Manager window, open the Databases folder. The new 

database is listed in the tree view. Note the information about the new database that is shown 

in the right-hand pane: 

o Creation date, name, owner, and size. 

o Database type - FFI. 

o Schema module name and version. 

o SQL server name and user ID. 

 

6.  Close the Database Manager window. 

NOTE: In order to store data in your new database it must have the FFI protocols 

available in the database. To get protocols into a new, empty database you must 

either: import the protocols, restore a database that has protocols in it or import data 

from another computer.  

 

Backing up a database 

The Backup Database command creates a backup copy of the selected database and files it 

on your computer. Back up your databases often! A deleted database cannot be recovered, 

but you can restore a database from a backup file. 

NOTE: Database backup must be done on the computer where SQL Server is installed and 

must be done by a user logged in with an SQL Administrator role. 
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To back up a database: 

1.  In the Database Manager tree view, highlight the name of the database. 

2.  Click Backup Database in the Database menu. 

 

 

3.  After a moment or two, a confirmation box opens. Note the name of the backup file and 

click OK. 

 

NOTE: The default location for backup files is C:\Program Files\Microsoft SQL 

Server\MSSQL.1\MSSQL\Backup. You should save the backup file in a safe location 

preferably on a server at an external site. 

NOTE: You may not be able to back up your database due to permissions issue with the SQL 

Server Backup folder but you can typically save the back up on a flash drive. If that doesn’t 

work open the database in FFI and export each Administrative Unit. In all cases save copies 

of the files in a safe place. 
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 Patching a database 

The Patch Database command lets you update an existing database so that it works correctly 

with a new version of FFI. 

In this example, the schema version of the database is 1.04.02, but the version of FFI is 1.05.03. 

Apply the Patch Database command to upgrade the database to the current schema version. 

To patch a database: 

1.  In the tree view of the Database Manager window, highlight the name of the database to be 

patched. 

2.  In the Database menu, select Patch Database. 

 

 

3.  Click OK in the Utilities window to confirm. 
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4.  A DOS window will open as the database is patched. When the window closes the schema 

version will be updated (FFI 1.05.03.xx database will be patched to the 1.05.03 database 

schema. 

 

5.  Back up the patched database using the Backup Database command in the Database 

menu. 
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Restoring a database 

A backed-up database can be restored if it is inadvertently deleted or damaged. You must hold 

an administrative role to restore a database. 

NOTE: Back up your databases often! A deleted database cannot be recovered, but you 

can restore a database from a backup file. Store your backups in a location separate from 

your active database(s) such as on a remote server. 

NOTE: You cannot restore a database that already exists in the SQL "Data" folder. 

To restore a database: 

1.  Highlight the name of the SQL server instance in the tree view and select Restore Database in 

the Server menu. 

 

 

2.  The Database Restore window opens. Enter the Database Backup File Name by clicking the 

top Browse button and navigating to the backup file (it has a .bak extension). Highlight the 

backup file and click Open. Leave the Database Restoration Location as the default. Click 

Restore. Depending on the computer speed and database size it can take several minutes for 

the database to be restored. During that time it will look as though nothing is happening. 
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3.  Click OK to close the message window. 

 

  

4.  The Haven database is again listed in the Database Manager tree view in the left pane. Its 

new creation date is the date of the backup file used in the restoration. 

 

NOTE: The Restore Database function can also be used to “import” a database to another 

computer in a remote location for analysis purposes. Keep in mind that any changes made 

to the copy on the remote computer cannot be recombined or “synchronized” with the 

source database. 
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Deleting a database 

FFI administrators and managers can delete databases that are no longer required. 

CAUTION:  A deleted database can NEVER be recovered, but you can Restore a database 

from a backup file. 

To delete an FFI database: 

1.  Highlight the name of the database to be deleted. 

2.  Click Delete Database in the Server menu. 

 

 

3.  If you are sure that you wish to delete the database, click OK in the confirmation window and 

the database will be deleted. 
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Managing users and user roles 

CAUTION: Unless you are an experienced SQL Server user we suggest having all users sign in 

as “sa” using the sa password. This is the password you selected when SQL Server was 

installed.  

If you set up individual SQL users and permissions be advised the FFI user and roles 

functionality is not working properly when multiple FFI databases are being used. If you have 

FFI data in more than one SQL database, every user must be given the administrator role to 

all databases.  

 This section covers: 

o User roles and permissions 

o Adding and deleting users 

o Assigning and deleting user roles 

o Password guidelines 

User roles and permissions 

Four user roles are available in FFI. The range of tasks that you can perform is dictated by your 

role, which is assigned by your FFI administrator or manager. These roles are defined below. 

 

1. Administrator 

 Performs any activity in FFI and in SQL Server. 

2. Manager 

 Manages log-ins, adds and removes user IDs, and changes passwords. 

 Assigns user roles. 

 Creates, alters, and deletes databases; reads error logs. 

 Creates and edits administrative units, project units, and macro plots. 

 Imports new protocols and methods from the Protocol Manager module. 

 Cannot restore databases. 

 Cannot make changes in SQL Server instances. 

3. Data entry 

 Creates macro plots and sample events. 

 Enters protocol data. 

 Runs reports and analyses. 

 Cannot access the Database Administration module. 

 Cannot create administrative units or project units. 

4. Reader 

 Reads data. 
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 Runs reports and analyses. 

 Exports queries and reports. 

 Cannot access the Database Administration module. 

 Cannot create administrative units, project units, macro plots, or sample events. 

  

 Adding and deleting users 

FFI administrators and managers can create and delete user accounts for a database. Use the 

Database menu in the Database Manager to add and delete users. 

 

Adding a new user 

To add a new user: 

1. Select the database name in the tree view of the Database Manager. In the example, 

above, a new user is to be added to the Haven database. 

2. Click Add User in the Database menu. 
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3. Enter a name and password for the new user, and click Save. 

 

NOTE: Select a password that you can easily remember, since it cannot be retrieved if it is 

forgotten. See Password guidelines for help in selecting a password. This is your sa user (SQL) 

password, and you will use it each time you log on to FFI. Be sure to write your sa user 

password down in a safe place. Your sa user (SQL) password is different than your Windows 

password. 

4. Addition of the new user is confirmed. Click OK to close the confirmation window. 

 

 

Deleting a user 

NOTE: No data is lost when a user or user role is deleted. 

To delete a user: 

1. Select the database name in the tree view of the Database Manager. In the example, 

above, a user is to be removed from the Haven database. 

2. Click Delete User in the Database menu. 
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3. Enter the name of the user to be deleted and click Delete. 

 

4. Click Yes to confirm that you really want to delete the user. 

 

5. Click Yes to respond to the warning and delete the users login name. 

 

6. Deletion of the user is confirmed. Click OK to close the confirmation window. 
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Assigning and deleting user roles 

FFI administrators and managers can assign and modify or delete user roles for a database. 

Managing user roles helps to ensure the integrity of the database by allowing users access to 

only the tools and functions that they require to do their work. Use the Database menu in the 

Database Manager to handle user roles.  

Note: The available user roles are Administrator, Manager, Data Entry, and Reader. See User 

roles and permissions for descriptions. 

 

Assigning a role to a user 

To assign a new role to a user: 

1. Select the database name in the tree view of the Database Manager. In the example, a 

role is to be assigned to a user of the Haven database. 

2. Click Add Role in the Database menu. 
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3. Enter the name of the user and select the desired role in the Add Role dropdown. Click 

Save. 

 

4. Addition of the user new role is confirmed. Click OK to close the confirmation window. 

 

Deleting a user role 

NOTE: No data is lost when a user or user role is deleted. 

To delete a user role: 

1. Select the database name in the tree view of the Database Manager. In the example, a 

role is to be deleted for a user of the Haven database. 

2. Click Delete Role in the Database menu. 

3. Enter the name of the appropriate user and select the role to be deleted in the Role to 

Delete field. Click Delete. 
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4. Click Yes to confirm that you really want to delete the user role. 

 

5. Deletion of the user role is confirmed. Click OK to close the confirmation window. 

 

  

 

Password guidelines 

To ensure security, new FFI passwords should meet the following guidelines: 

o The password does not contain all or part of the username. 

o Passwords should be at least eight characters long. Some installations of Windows 7 

require passwords at least 12 characters long. 

o The password contains characters from three of the following four categories: 

 Uppercase letters A through Z. 

 Lowercase letters A through Z. 

 Numerals 0 through 9. 

 Non-alphanumeric characters such as !, $, #, or %. 
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Using FFI 

This section of the User Guide contains detailed procedures for: 

o Starting FFI 

o Project management 

o PDA coordination 

o Data entry and edit 

o Query 

o Reports and analysis 

o Species management 

o Toolbox utilities 

Also, see Data entry guidelines for general tips on entering data in FFI. 

 

Starting FFI 

To start FFI: 

1. Double-click the FFI icon on your desktop or launch FFI from the Start menu. 

2.  If the SQL Server Instances field is blank click the Find Servers button. An hourglass will be 

displayed for up to a minute as the FFI locates SQL instances. When the hourglass 

disappears click the down arrow to see the available servers and select your SQL server 

instance from the dropdown menu. 
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3. Enter the User Name and the SQL Password and click the down arrow on the Select or Enter a 

Database Name field. An hourglass will appear while the list is populated then the list will flash 

briefly. Click the down arrow again to select the database you want to connect to. 

 

NOTE: If the Select or enter a database name menu is blank you have most likely entered an 

incorrect SQL password. You must re-enter the User Name AND Password when you re-

attempt to log on to the server.  

4. Create a New Administrative Unit or select the administrative unit you wish to work with and 

click Continue. 

 



73 
 

NOTE: You can use this window to edit information about an existing administrative unit. Click 

the name of the unit and click Edit Administrative Unit. Make any necessary changes and 

click Save. 

5. The main FFI window opens. Note that your SQL Server database instance and administrative 

unit are identified in the footer of the window. Click the FFI module you wish to use and proceed 

(e.g., Data Entry and Edit). 

 

The Attention icon 

On many forms and input screens, you will see the Attention icon: . This icon indicates required 

or incorrect input. Mouse over the icon for messages about the required data. Once you resolve 

the errors and click Save, the Attention icon will disappear. 

  

See also: 

o FFI user interface 

o Protocols and methods 

o Project management 

o Using FFI 
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The FFI user interface 

The figure below shows the main FFI window. All user activities take place within this window, or 

within dialog boxes that are opened from this window. Each numbered component is described 

below. 

 

Tree view(1) 

This pane (component 1) shows a tree view listing your project units, macro plots, and scheduled 

sample events. You can choose to list All Project Units or All Macro Plots in your tree view. The 

toolbar of the tree view changes to reflect the function that you select. Depending on which 

function is active, dropdown menus, toggle bars, or other controls will appear in the tree 

viewtoolbar. 

Navigation button bar (2) 

 The navigation button bar (component 2) lets you switch between the seven FFI functions. The 

current function is always highlighted.  

Work pane (3) 

All data entry, viewing, editing, analysis, and querying take place in the work pane (component 

3) or in dialog boxes that are called up from this pane. The work pane and its menus change to 

reflect the functions that you select.  

1 

2 

3 

4 
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Footer (4) 

The footer (component 4) remains the same while FFI is open. It identifies the current user, 

database server, database, and administrative unit.  
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Protocols and methods 

FFI protocols and methods 

FFI incorporates the field sampling methods used in FEAT and FIREMON as its standard methods 

and protocols. In addition, FFI adds several new protocols. The table below lists the standard 

protocols that are available. For descriptions of each, see About the FFI protocols in the 

Additional information section. 

NOTE: FEAT and FIREMON users - see Comparison of sampling protocols in the Additional 

information section for a crosswalk between the FFI, FEAT, FIREMON, and FMH protocols and 

methods. 

Each of the standard protocols has its own forms, data summary reports, and data analyses. 

When you use the Data Entry and Edit function to enter monitoring data for a completed sample 

event, you will use familiar data entry forms that specifically correspond to each protocol that is 

assigned to the sample event. 

  

STANDARD PROTOCOL STANDARD PROTOCOL 

Biomass – Fuels* Biomass - Plants 

CBI* Cover - Line Intercept 

Cover - Points Cover - Points by Transect 

Cover - Species Composition Cover/Frequency 

Density - Belts Density - Quadrats 

Disturbance History FCCS* 

Fire Behavior* Pilot Sampling 

Plot Description* Post Burn Severity 

Rare Plant Species Surface Fuels 

Surface Fuels - Alaska Duff/Litter Surface Fuels - Piles 

Surface Fuels - Vegetation Trees 

Trees - Individuals Trees - Saplings (diameter class) 

Trees - Seedlings (diameter class)   

 * Single-record protocols – only one record per sample event. 

Adding additional protocols and methods 

To add other protocols and methods to support your monitoring program, install and run the 

Protocol Manager module, which is included in the FFI installation package.   

Importing protocols 

FFI users with administrator or manager permissions can create new monitoring protocols in 

Protocol Manager and import them into FFI. After protocols are imported, they can be assigned 
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to sample events (see Scheduling a sample event for information on assigning protocols). 

Importable files have a .pmd extension. 

To import protocols: 

1. Select Utilities > Import Protocols. 

NOTE: If you do not have the correct permissions, the Utilities menu will not appear in your FFI 

window. 

 

2. Navigate to the protocol file you wish to import and click Open. (The .pmd files are 

included in the installation file you downloaded from FRAMES and will be found in the 

temporary folder you created during the installation process.) 

3. A query window opens. Review the message. To continue, click Yes. If you select No, your 

database will not be changed. 

 

 

4.  It may take up to 5 minutes for protocols to import. While they are importing an hourglass may 

or may not be displayed. A dialog will inform you when the protocols have imported. Click OK. 
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See also: 

o Database administration 

o Project management 

o Using FFI 
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Project Management 

The Project Management functions in FFI include: 

o Working with Administrative units 

o Working with Project Units 

o Working with Macro Plots 

o Working with Sample Events 

o Batch Macro Plot Builder. 

o Import/Export Utility 

o Default Monitoring Status 

NOTE: Your assigned role and permissions determine which functions you can perform in FFI. 

See User roles and permissions for more information, or consult your FFI administrator. 

Working with Administrative Units 

Administrative Units provide a way to intuitively organize your data. For instance, if you manage 

multiple refuge units, parks, or districts you can store the Project Unit, Macro Plot and Sample 

Event data for each unit within its own Administrative Unit. Local species lists are managed at the 

administrative unit. If you manage units with exceptionally different species then storing the data 

for each management unit in a separate Administrative Unit may make sense. If species do not 

vary greatly across management units then using one Administrative Unit for all data will likely be 

a better choice. A potential cost of using multiple Administrative Units is that data from different 

administrative units cannot be simply combined for analysis. 

Creating a new Administrative Unit 

To create a new administrative unit: 

1. Open FFI and log on to your database. 
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2. The Administrative Unit window opens. This window lists any administrative units that 

currently reside in the database. Click New Administrative Unit. 

 

 

3. The Administrative Unit Builder opens. Name the new administrative unit and add any 

descriptive comments. If you wish, you can use the user variable fields to further describe 

the administrative unit. Click Save & Close when finished. 
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4. The new administrative unit will be listed in the left pane of the Administrative Unit window. 

Select its radio button and click Continue. 

 

 

5. The Project Management window opens. Note that the name of the new administrative 

unit appears in the footer of the window. 

 



82 
 

Editing information about an Administrative Unit 

You can edit information about an Administrative unit by clicking on the Edit Administrative Unit 

button. 

 

 

Add or change the data fields and click Save & Close. 
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Deleting an Administrative Unit 

1.  You can delete an entire administrative unit by clicking Delete Admin. Unit button.  

CAUTION: This is a powerful function that should be used carefully. 

 

 

2.  Click Yes to continue or No if you do not want to delete the administrative unit. 

 

 

3.  You will be asked if you would like to export a copy of the administrative unit. Select Yes. 
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4.  Select a location and filename for the export file. 

 

NOTE: The administrative unit backup file is saved as an .xml file. To restore this file use 

the Import Administrative Unit function when you log into FFI. You cannot restore an 

.xml file in FFI Database Administration. 

5. A progress bar will be displayed as the administrative unit is exported and a dialog will inform 

you when complete.  

 

 

See Importing an Administrative Unit for more information. 

 

Working with Project Units 

This section covers: 

o Creating project units. 

o Editing project units. 

o Deleting project units. 
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Creating a new Project Unit 

In FFI, a Project Unit is defined as a division of the entire sample population of the 

administrative unit.  

Project Units are usually defined so that they represent an area on the ground. For example, a 

project unit could consist of "all areas in the Ponderosa vegetation type between 1500 and 2000 

meters above sea level, more than 500 meters from the nearest road, and more than 1000 

meters from the nearest stream." Project units provide a means to functionally group macro plots 

for management and analysis. They can be defined so that they overlap spatially, and you can 

associate macro plots with multiple project units. You can spatially define project units using the 

FFI GIS module. 

To create a new project unit, select New > Project Unit. The Project Unit window opens. 

 

The Project Unit pane contains data entry fields and forms, accessed through a series of tabs, 

with which you can fully describe the new project unit. The numbered paragraphs in this section 

correspond to the numbered functions in the window, as identified out below. 
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1. Add Identity information for the new project unit. 

o Name. Enter a meaningful name for the unit. 

o Date. The default is the date that you create the project unit. Use the dropdown 

calendar or enter text to select a different date. 

2. Add Properties information about the new project unit. 

o Agency. Enter the agency name. 

o GRID file location. This is the file location of the GIS layer, if used. This field will auto-fill 

if the project unit is spatially defined. 

o Area. Enter the number of acres or hectares contained in the project unit. 

o Units. Use the dropdown to select acres or hectares. 

3. Macro plots tab. In this tab, click Assign Macro Plots to open the Macro Plot Selection 

form, which lets you assign macro plots to a project unit. Select the desired macro plots 

from the left-hand pane and assign them to the project unit by clicking the >> arrow. Click 

OK when finished. The assigned macro plots will be listed in the Macro plots window after 

you save your work. 

NOTE: Use the << and >> arrows to add or remove macro plots from the Assigned Macro Plots 

pane. 

 

NOTE: After you complete data entry in a form field, click Save at the top of the Project Unit 

pane. 

4. Monitoring status tab. This tab contains the Monitoring Status Builder, which lets you add, 

edit, delete, and order monitoring status for a project unit. Monitoring status identifies the 

project unit's status in time in relationship to a treatment or disturbance. 
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NOTE: You can assign monitoring status for a sample event in Reports and Analysis or Utilities 

> Change Monitoring Statuses in Project Management. For information on using monitoring 

status in analysis, see Analysis setup. 

 

Click Add to open the Monitoring Status Builder. After you have assigned monitoring 

statuses to each project unit, the status list can be edited or deleted, and rearranged in 

any order. You can either assign the standard criteria listed below, or build your own. 

o Prefix: Pre, Post, Re. 

o Base: Burn, Disturbance, Measure, Treatment. 

o Suffix: Years 1 - 5. 

In the first example, the monitoring status uses the standard criteria and is Post-burn Year 2. 

In the second example, the status descriptors have been customized to meet a specific 

program need. 
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When you are finished assigning monitoring status, click OK & Close. 

NOTE: Also see the Monitoring Statuses section. 

 

5. Candidate plots tab. Use this tab to create, edit, delete, promote, or reject candidate 

macro plots. 

 

o Click Add in the tab toolbar to open the Candidate Plot Builder. Name the 

candidate plot, and add appropriate descriptive data. Click OK & Close when 

finished. 

o If you promote a candidate plot, the plot will be moved into the Project 

Management tree view as a macro plot. Click Promote to promote a plot. 

o Click Reject to remove a candidate plot from the list of candidate plots. 
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NOTE: The  indicates a required field. 

6. Metadata tab. To add metadata to further describe the project unit, click the Metadata 

tab and select New. The Metadata Builder window, shown below, opens. 
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o You can cut and paste text, such as existing documentation about the project unit, 

into the metadata tab text fields, or enter text directly. Metadata can be added, 

edited, or updated at any time. Text can be copied and pasted into a word 

processing package for formatting and printing. 

o Metadata records are labeled and sorted by date. Accept the default date, or use 

the calendar to select another date for the record. 

o Link to a separate document be adding the path in the Document field. This is 

especially useful if the metadata documentation is already in electronic form 

and/or contains images (which can’t be displayed in the tabbed fields). See the 

Suggested File Structure section for information about where to store electronic 

documentation. 

o After entering data, click OK & Close to save the record. The record will be listed 

within the Metadata tab in the Project Unit details window. 

7. In the Objectives tab in the Project Unit window, enter the monitoring objective. 

8. In the Description tab in the Project Unit window, enter a description for the project unit. 

9. Use the Comment tab in the Project Unit window to enter any pertinent notes and 

comments. 

10. GIS code tab. If the project unit is spatially described, this field will auto-fill. 

Editing a project unit 

To edit an existing project unit: 

1. In the Project Management tree view, highlight the project unit to be edited. The Project 

Unit window opens. 

2. Make any necessary changes or updates to the data in the Project Unit window, and click 

Save. 
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Deleting a project unit 

Project units can be deleted from the main Project Unit window. You might want to delete a 

project unit if it was initially set up incorrectly, or after a project has been completed. Deleting a 

project unit does not affect your macro plots or collected and stored data. 

To delete a project unit: 

1. In the tree view in the main Project Management window, highlight the project unit to be 

deleted. 

2. Click Delete at the top of the Project Unit window. 

 

3. Click Yes in the confirmation box, as shown below. 

 

NOTE: Any assigned macro plots will be retained, although the linkage to the project unit will 

be lost. 
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Working with Macro Plots 

This section covers: 

o Creating macro plots individually. 

o Creating macro plots in the Batch Macroplot Builder 

o Assigning macro plots to Project units 

o Editing macro plots 

o Deleting macro plots 

  

Creating a macro plot individually 

NOTE: A macro plot is a geographic sample point within a project unit that has a specific 

area around which method data are collected.  

To create a new macro plot in a project unit: in Project Management click once on the desired 

project unit folder to highlight it.  

 

 

Select New > Macro Plot.  
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The Macro Plot window opens. The numbered sections correspond to the functions in the Macro 

Plot window, described below.  

 

 

1. Add Identity information for the new macro plot. 

 Name. Add a meaningful name for the macro plot. 

 Type. Use the dropdown menu to select the appropriate plot type. 

 Purpose. Briefly describe the purpose of the plot. 

2. To assign the macro plot to a new or different project unit, click the Assign to project units 

button. Available project units will be listed in the Project Unit Selector. Check the 

appropriate checkboxes and click OK. 

 

1 

3 

2 

7 6 5 4 
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NOTE: A macro plot can be assigned to more than one project unit. 

3. Add Properties information for the new macro plot, using dropdown menus where 

provided to assign values. 

 Site Characteristics: 

o Elevation 

o Elevation Units 

o Azimuth 

o Aspect 

o Hill slope 

o Transect slope 

 Location:  

o UTM Easting  

o UTM Northing  

o UTM Zone 

o Datum 

o Error (m) 

o PDOP 

o Longitude (decimal degrees) 

o Latitude (decimal degrees) 

 Installation: 

o Install date - Enter the date when the macro plot was created. 

o Retire date - Enter a date when the macro plot will no longer be used. 

o Located by - Enter the name of the individual who located the macro plot. 

4. In the Directions tab, enter direction and location data in the Start Point and Directions 

fields. 

5. In the Metadata tab, enter metadata as appropriate. 

6. In the Comments tab, add comments as appropriate. 

7. In the User Variables tab, enter any additional notes or criteria that pertain to the macro 

plot. You can add up to eight strings of information. 

NOTE: The data that you enter as user variables can be used for stratifying, filtering, reporting, 

or analysis. 

8. Click Save to save the new macro plot. 
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Batch Macro Plot Builder 

Batch Macro Plot Builder simplifies adding a number of macro plots with one sample event 

each. If you want to create macro plots individually see the Creating a Macro plot section. 

To open the batch macro plot builder select Project Management in the navigation bar and 

select New > Batch Macro Plot from the menu bar above the Tree View. The Batch Macro Plot 

Creator screen will open. Enter information to create the desired number of Macro plots and the 

associated data. The fields are described below. 

  

  

 

 

Batch Macro Plot Builder field descriptions 

Number of Plots to create: (Required; Positive integer). Maximum number of macro plots you 

can create at one time = 999. Each new macro plot will have one sample event assigned to it. 

Assign to Project Unit: (optional; text). Assign new macro plots to a project unit by selecting one 

from the dropdown list or typing in a new project unit name. If a new project unit name is 
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entered it will be added to the tree view. If no project unit name is entered plots will be added 

but not assigned to a project and the new plots will only be visible when the All Macro Plots tab 

is selected in the Tree View. 

Sample Event Date: (required; date format). By default this is set to the date the macro plots are 

created in Batch Macro Plot Builder. You can accept the default or change it if desired. When 

entering field data in FFI the sample event date should be changed to the date the data were 

collected in the field. 

Default Monitoring Status: (optional; text). Select from the dropdown or click New to add a new 

default monitoring status. The default monitoring status is provided as a way to track why the 

sample event was initially created. If a default monitoring status is entered it will be 

automatically by the assigned monitoring status used in Reports and Analysis. Note that, the 

assigned monitoring status used in Reports and Analysis can be different than the default 

monitoring status assigned the plot in Project Management.  

Starting Plot Number: (required; integer). By default this is set to 1. Maximum is 999. Longer 

numbers can be accommodated by using this field in combination with the Name and Prefix 

options below. The plot number will be three digits long with leading zeros. This ensures proper 

sorting in the macro plot tree view. Negative plot numbers are valid but do not display well in 

the tree view. 

Increment By: (required; integer). Default is 1. Used to increment plot numbers.  

Name: (required. text. concatenated with the Macro Plot Number to create the complete 

macro plot identifier. If setting plot numbers greater than 999 then include digits in the name. 

Name as Prefix/Suffix: (required; set as Prefix or Suffix). Orders the macro plot name relative to 

the macro plot number. E.g., If set to Prefix then Plot001, if set to Suffix then 001Plot.  

Type: (optional; text). Populates the Type field for the macro plot in Project Management. Select 

from the dropdown list or add your own. 

Purpose: (optional; text). Populates the Purpose field for the macro plot in Project Management. 

Assign Protocols: (optional; protocol list). Click to select protocols to all the new macro 

plot/sample events. If no protocols are selected they can be added in Project Management. 

  

Batch Macro Plot Builder example 

In this example four new macro plots will be added to an existing project. Each new macro plot 

will have one sample event and will have the Cover - Points and Density - Belts protocols 

assigned to them.  
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This is what the Project Management window looks like before the macro plots are added. 

 

 

Open the Batch Macro Plot Builder window by selecting New > Batch Macro Plot in Project 

Management. 
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In the Number of Plots to create field enter 4. In the Assign to Project Unit field type 

ExampleProj1. Leave the Sample Event date as the default. Add a New Default Monitoring 

Status called PreTreatmentYear1. Set the Starting plot number to 3. Leave the Increment by 

field set to 1. In the Name field type NewPlot. Leave the Type and Purpose fields blank and click 

Assign Protocols. 

 

 

 

Highlight the Cover - Points protocol in the Available Protocols list on the left side of the Protocol 

Selector window and click the top arrow button in the middle of the screen to move the 

protocol to the Assigned Protocols list on the right. Assign the Density – Belts protocol following 

the same steps. Click OK. 

 

 

 

 

 

 

 



99 
 

Click OK in the Batch Macro Plot Creator window. 

 

 

Click OK in the dialogue box. 
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The Project Management screen will refresh with the new macro plots and sample events 

displayed in the tree view on the left. Highlight a macro plot name and note the Default 

Monitoring Status has been set and protocols assigned. 

 

 

Select Reports and Analysis on the navigation bar and note that Monitoring Statuses set for the 

sample events are all set to the default. 
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Editing a macro plot 

To edit an existing macro plot: 

1. In the Project Management tree view, double-click the macro plot to be edited. 

2. Make any necessary changes to the data in the Macro Plot window, and click Save. 

 

 

Deleting a macro plot 

You can delete a macro plot for which no data has been collected. However, once a macro 

plot contains data, it cannot be deleted. To delete an empty macro plot: 

 

 

 

 

 

 

 



102 
 

1. In the tree view in the main Project Management window, highlight the macro plot to be 

deleted. 

 

2. Click Delete at the top of the Macro Plot window. 

3. Click Yes in the confirmation box, as shown below. 

 

 

Working with Sample Events 

This section covers: 

o Scheduling sample events 

o Copying protocols and tree data from a previous sample event 

o Editing sample events 

o Deleting sample events 
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Scheduling a sample event 

In FFI, a sample event is the date of a sample event, treatment, or disturbance. The sample 

event is a specific point in time at which sampling is to be conducted, and identifies which 

sampling protocols are to be applied. This section explains how to schedule a sample event and 

assign the protocols to be used. 

To schedule a sample event, select the appropriate project unit and macro plot In the Project 

Management window. In the New menu at the top of the pane, select Sample Event. 

 

 

The numbered paragraphs in this section correspond to the functions in the Sample Event 

window, called out below. 

 

1. Identity. Assign a Date for the event, using the dropdown calendar. The Macro Plot field 

fills in automatically with the macro plot name. 

 

1 

2 

3 4 5 
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2. If desired, add User Variables (UV1) in the Properties pane. User variables can be simple 

notes or descriptors. In this context, they are not used for stratifying or filtering records. 

 

3. Use the Protocols tab in the main Sample Event window to select the protocols to be used 

during the sample event: 

o Click Add/Remove Protocols to open the Protocol Selector. Scroll through or filter 

the listing to locate the protocols you wish to assign to the sample event. 

o Highlight the desired protocol and either double-click or use the >> button. 

o Click OK when all applicable protocols have been added to the sample event. 
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NOTE: To store photos associated with a sample event, assign the Plot Description protocol to 

the event. See Using photos in FFI for more information. 

4. In the Team tab in the main Sample Event window, identify the team scheduled to 

conduct the sample event. 

5. Use the Comments tab in the main Sample Event window to enter any additional notes or 

information.  

Click Save in the Sample Event window toolbar to save the scheduled sample event. 

Copying protocols and tree data from a previous Sample Event 

When you create a new sample event and select Copy Protocols and Tree Data from a Previous 

Visit the protocols are automatically added in the new sample event and all of the Trees-

Individual data are also added to the new sample event. This is meant as a time saving measure 

because the attributes for large trees generally don't change much between sample visits.  

  

1. In Project Management select a macro plot by clicking on it in the tree view on the left. 

Select New > Sample Event.  
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2. Change the sample event date if desired. Select Copy Protocols/Tree Data From 

Previous Visit. 

 

 

3. Select the visit to copy the data from, click OK. The protocols and data will be added to 

the new sample event. 
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4. In Data Entry and Edit select the sample event just created. In this example the Trees 

protocol tab has been selected. The sample attributes (plot sizes and breakpoint 

diameter) and method attributes (tag number, species, status, etc.) for the trees have 

been copied from the previous visit. Note the Is Verified filed is set to No. Set this field to 

Yes as each data record is verified against the field data sheets. In many cases the tree 

method attributes will not change from visit to visit.  

 

 

5. For all other protocols only the sample attributes are copied to the new sample event. 

In this example the Cover_Frequency tab is selected and the Num. Transects, Tran. Length, 

etc. fields have been copied but none of the method attributes have been copied. 
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NOTE: When using the Copy from Previous Visit option the Visited field is set to Yes and, 

thus, the Plot Report will indicate this plot has been visited; however, no method 

attributes will have been entered. 

Editing a sample event 

To edit or update a sample event: 

1. In the Project Management tree view, select the event to be edited. 

 

2. Make any necessary changes, and click Save. 

Deleting a sample event 

You can delete a sample event for which no data has been collected. Once an event contains 

data, it cannot be deleted. 

To delete an unused or empty sample event: 

 

 

 

 

 

 

 



109 
 

1. In the tree view in the main Project Management window, highlight the sample event to 

be deleted. 

 

2. Click Delete to delete the sample event. 

3. Click Yes in the confirmation box, as shown below. 

 

 

Using photos in FFI 

You can file photographs taken during sample events and link them to your macro plot using the 

Plot Description protocol. 

Naming and filing photos 

When naming your photos, be as descriptive as possible. A photo named plot1.jpg is difficult to 

tie to plot data. Instead, try something like admin_ proj_plot_date_D, where, admin is the 

administrative unit, proj is the project unit, plot is the macro plot ID, date is the date of the 

photograph, and D is the direction the photo was taken or the sequential photo number on the 
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plot. For example, redbench_001_Oct0907_N.jpg would be a photo of plot 1, facing north, on 

the Red Bench project in Glacier National Park taken October 9, 2007. 

Choose whatever format works best for you, but be sure to record the format in your project 

metadata so photos can be located at a later date. Store plot photos in the C:\FFI\Photos 

subdirectory. It is also helpful to include plot information in the photograph itself. One simple way 

to do this is record project information (project unit, macro plot, date, direction, etc.) on a small 

whiteboard and then include the whiteboard in your plot photos. Be sure that the whiteboard is 

legible in the photos. Other considerations: 

o Focus the camera on the environment surrounding the plot, not the distance or 

foreground. 

o Make sure that the camera is set for the correct exposure and aperture for existing light 

conditions. 

o Try to include the plot center in your photographs to reference the photos geographically.  

Using the Plot Description protocol for photos 

You can capture digital images at every sample visit and store their location and file names in 

the FFI database. To link photos, assign the Plot Description protocol to the sample event. When 

you go to the Plot Description form for the sample event in Data Entry and Edit, you can link ten 

photos using the hyperlink fields in Plot Photos, as shown below. 

 

 

Import/Export utility 

The FFI Import/Export utility uses .xml files to move data between FFI and FFI-lite databases. When 

an export file is created it includes all macroplot data, data associated with the protocols, local 

species list, user species list, pick lists, and fuel constant sets. When creating an export file a copy 

of the data are stored in the .xml file - data are not removed from the database. 
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Data import, especially using the Append option in FFI, can take a few minutes to hours 

depending on the amount of data. For example, appending two or three sample events with a 

few protocols assigned in FFI can take about 5 to 10 minutes. Replacing data takes less time in 

FFI and all importing in FFI-Lite takes less time than in FFI. Some users have tried to use Microsoft 

Task Manager to monitor the DataCapture process to check if the import is working but be 

aware the CPU usage for DataCapture will drop to zero for extended times and then increase 

right as the import process ends. The FFI progress bar that is displayed during import will stop if 

another application on the computer is selected; however, the import process is still working. The 

progress bar will disappear when the import is complete. 

NOTE: It is always wise to create a backup of your master database before and after doing 

any data import.  

  

o General Rules 

o Use Cases for import/export 

o Hierarchy of FFI export files 

o What data can be appended or replaced using import/export utility? 

o Data import options: No change, Append, Replace  

o Appending data from multiple field computers 

o Things to not do in the field database 

o How the Import/Export utility handles duplicates  

o How the Import/Export utility handles species/item codes  

o Where to find Import/Export functions  

o Exporting an administrative unit 

o Importing an administrative unit 

o Exporting a project units and macro plots  

o Importing project units and macro plots 

o Steps for using the import and export functionality with field computers  

General rules 

Once data are exported from the master database for use on a field computer, do not make 

changes to sample event data (sample and method attributes) in the master database as those 

changes will be overwritten when the data are imported from the field computer. 

Also see this section: Things Not to do in the field database. 

Use Cases for import/export 

The FFI import/export utility is designed for two functions:  

 Facilitate electronic data collection in the field by moving sample and method attributes 

between a master database and a field database on a field computer. 
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 Aggregate administrative units, project units, and/or macro plots into a comprehensive 

database.  

Hierarchy of FFI export files 

FFI saves all of the data needed to recreate the original FFI data hierarchy, regardless of 

whether you create an export file of an administrative unit, project unit or macro plot so the 

original data structure remains intact. 

What data can be appended or replaced? 

Only sample and method attributes in Data Entry and Edit and the sample event Date and Team 

fields in Project Management can be appended or replaced. If changes are needed for other 

Project Management data fields they should be made on the master computer.  

If method attribute records are deleted on a field computer the corresponding record will not 

be deleted when data is imported. Method attribute records must be deleted on the master 

computer.  

Data import options: No change, Append, Replace 

When data are imported, FFI checks the master database to see if data already exist in the 

sample event(s) the data are to be imported into and, if data exists, you will be prompted to 

choose an option for the import: No change, Append or Replace. If data is imported after 

mistakenly selecting the No Change option the data can be re-imported using the correct 

option.  

 

 

 

 The No change option will ignore any data in the import file so the data in the master 

databases will remain unchanged.  

 The Append option will make a fairly complex comparison of the data in the input file 

and in the master database to bring new data into the sample event. See the table 

below for more information about how FFI determines what data are imported when 

using the Append option.  

A deleted method attribute record in the field database will not result in the deletion of 

the corresponding record in the master database when using the Append option. Add a 
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note in the Comment field for the record that should be deleted and make the deletion 

in the master database after importing the data. 

 

Project Management 

Macro plot 

data 

All data fields Only the sample event date is imported. 

 

Data Entry and Edit 

Sample 

Attributes 

3-Part 

protocols 

(Trees and 

Surface Fuels) 

For required sample attributes in the master database, if the existing sample 

attribute is 0 or the field is null then the import utility brings the value in from the 

import file, otherwise the attribute value in the import file is skipped.  

For non-required sample attributes in the master database a sample attribute 

will be replaced if the corresponding field in the import file is anything other 

than null. 

All other 

protocols 

The required and non-required sample attributes in the master database will 

be replaced if the corresponding field in the import file is anything other than 

null. 

Method 

Attributes 

All protocols In the master database, if the record GUID exists then the data in that record is 

modified with the import data. If the record GUID does not exist then the new 

record is imported and added to the method attributes. Method attribute 

records are not removed from the master database if the attribute GUID does 

not exist in the import file.  

 The Replace option overwrites ALL existing sample and method attributes for ALL 

protocols - even for those protocols where Visited = No in the import file. If a data field in 

the import file is null the corresponding data attribute in the master database will be null 

after import. At the Project Management level only the sample event Date and Team is 

replaced. 

CAUTION: Use extra care when using the Replace option as there is no way to undo a data 

Replace change to a database. Never use Replace when importing data collected on 

multiple computers into the same sample event. Data overwritten using the Replace options 

will need to be re-entered or re-imported 

Things to not do in the field database 

These things should not be done on the field computer/field database. Do them in the master 

database instead: 

1.  Do not use the New menu to create Administrative Units, Projects Unit, Macro Plots or 

Sample Events. I.e., all Administrative Units, Projects Unit, Macro Plots and Sample Events 

should be imported to the field computer, not created on the field computer. 

2.  Do not change local species codes in Species Management 
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3.  Do not identify unknown species using the Identify Unknown utility in Species 

Management 

4.  Do not replace a species code using the Replace Species in Method Data utility in 

Species Management 

5.  Do not add or edit Monitoring Statuses 

6.  Do not assign Monitoring Statuses to Sample Events 

NOTE: If you use FFI-Lite to store your master database then items 1 through 6 can be done 

using FFI-Lite, but only in the master database.  

How the Import/Export utility handles duplicates - GUIDs 

FFI uses a Globally Unique Identifier (GUID) to identify almost everything in the database. A GUID 

is a 26-character random number that should never occur more than once in a database. 

When you save a value in FFI it is tied to a GUID. If you create a macro plot you can name it 

whatever you want but FFI will know it by the GUID, which is always unique. So you can create a 

macro plot and name it Plot001 and FFI will assign it a unique GUID and then you can create 

another macro plot and name it Plot001 and FFI will give it a different GUID. Thus it is possible to 

have two things with the same name – like two macro plots named Plot001 in one project unit – 

which is not a problem for FFI but might be a problem for whoever is trying to keep them 

differentiated while working with the data. If you know ahead of time that data will be 

combined with the Import/Export Utility you may want to rename macro plots to avoid 

duplicates. There is no fast way to rename a number of macro plots in FFI; you have to do it one 

by one in Project Management. 

When importing macro plots FFI will check to see if a duplicate macro plot GUID already exists in 

the administrative unit the data are being imported into. If a duplicate GUID is found - even if 

the macro plot name is different – you will be prompted to leave existing data unchanged, 

append existing data with the new data or overwrite the existing data with the new data. See: 

Data import options: No change, Append, Replace. 

How the Import/Export utility handles species symbols/item codes 

Species symbols and item codes are the only two import values where FFI first compares 

symbol/code text instead of the associated GUIDs. When data are imported, the import/export 

function compares species symbols/item codes (NRCS code, user species code or “unknown” 

code) associated with the method attributes in the import file and the symbols/codes in the 

local species list in the master database with one of three results: 

1) If a species symbol or item code in the import file but not in the local species list in the master 

database (case sensitive) then the symbol/code is imported as in the import file.  

2) If a species symbol or item code in the import file is the same as a symbol/code in the local 

species list in the master database (case sensitive) then FFI checks to see if the Local Species 

GUID field in the import file and the master database are the same. If so, the Master Species 

GUID is maintained. Any differences in these species property fields: UV1, UV2, UV3, Description 

and Comment; will be modified in the local species list in the master database. Changes in 

other species properties should be made in the master database, not on the field computer. 
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3) If a species symbol or item code in the import file is the same as a symbol/code in the local 

species list in the master database (case sensitive) then FFI checks to see if the Local Species 

GUID field in the import file and the master database are the same. If they are not the same 

then the symbol/code is considered “new” and is imported as in the import file even if the 

species property fields (Common Name, Lifecycle, Preferred Lifeform, Invasive, Of Concern, 

Native, Cultural, UV1, UV2, UV3, Description and Comment) in the import file match those in the 

master database.  

The local species GUID is never changed when symbols/codes are imported with the 

Import/Export utility. 

NOTE: The logic described above is different than how FFI handles duplicate species symbols 

when doing a species list import. 

Where to find Import/Export functions 

The Import/Export utility is available in two places: 

1.  On the Administrative Unit screen you see when you log in. From here you can export or 

import all of the data linked to an administrative unit. 
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2.  On the Utilities menu in Project Management you can import or export data in project units, 

macro plots and sample events. 

 

 

Exporting an Administrative Unit 

1.  Log in to FFI. Check the box for the administrative unit(s) you want to export and click Export 

Admin. Unit(s). 

NOTE: If multiple administrative units are selected they will be added to the same export file 

but they will not be combined into one administrative unit. 
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2.  Name the export file and click Save. 

 

 

 

3.  A progress bar will be displayed while the file is created. 

 

 

4.  Click OK in the dialogue box to complete the export. 
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Importing an Administrative Unit 

1.  Log into FFI. Click the Import Admin. Unit(s) button. 

NOTE: You cannot import an administrative unit with the same name as an administrative unit 

already in the database. You cannot import an administrative unit with the same GUID as an 

administrative unit already in the database. 

 

2.  Select a data file containing exported administrative units and click Open. 
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3.  Select the administrative unit to import and click Import. 

NOTE: If more than one administrative unit was saved when the export file was created the 

administrative units will need to be imported individually. 

 

 

4.  A progress bar will be displayed and, when the import is complete, the administrative unit will 

appear in the administrative unit selection window. 

 

 

5.  Select the administrative unit you want to view and click Continue. 
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Exporting Project Units and Macro Plots  

1.  In Project Management select Utilities > Export Project Units/Macro Plots 

 

 

2.  Scroll to the desired project unit and check the box(es) of the project unit and/or macro plots 

you want to export and click Export. 

NOTE: When you select a check box to export a project unit all of the macro plots and 

sample events associated with the project are automatically checked. Uncheck macro plots 

you do not want to be exported. In this example only the last sample event is selected. Even 

though the project unit name is not selected it will be included in the export file in order to 

maintain the data hierarchy. 
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3.  Name the file and click Save.  

 

 

4.  A progress bar will be displayed. When the progress bar closes the file has been saved. 

 

 

Importing Project Units and Macro Plots 

1.  Select Utilities > Import Project Unit(s) 
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2.  Select the file to import and click Open. 

 

 

3.  Check the box(es) for the projects you want to import and click Import. 

NOTE: If the sample event being imported already exists in the database radio buttons will be 

displayed under the No Change, Append and Replace column headers. 
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4.  The progress bar will display. When the progress bar closes the project(s) will appear in the 

directory tree. 
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Suggested steps for using import and export with field computers 

One benefit of the import and export functionality is being able to easily move sample event 

data back and forth between master and field computers. The steps below outline the 

suggested process.  

 

NOTE: The steps below assume you use FFI for managing your master database but 

you can use FFI-Lite to manage your master database, if desired. The same 

procedures apply.  

1. Log into your master database in FFI and, for each of macro plot you will (or may) sample 

during the field visit, create one new sample event and assign the protocols you will use in 

the field. 

2. Export the desired macro plots and sample events from the master database using 

Utilities>Export Project Units/Macro Plots. Save the export file on a flash drive.  

NOTE: Once the data have been exported do not make changes to those same 

macro plots and sample events in the master database until after they have been 

re-imported from the field computer.  

3.  On the field computer open FFI-Lite and create a new, empty “field” database. Name it 

something that clearly identifies the project sampled and the date. 

4.  Open FFI-Lite on the field computer and on the Admin Unit selection screen click the 

Import Admin. Unit(s) button, select the file you exported in step 2 and import the desired 

administrative unit. 

5.  Visit field sites and collect data. Remember these rules: Things to not do on a field 

computer.  

6.  Back at the office open the database on the field computer in FFI-Lite and, using 

Utilities>Export Project Units/Macro Plots, export the macro plots and sample events that 

have new field data added. Save the export file on a flash drive. 

7.  On the master computer, open FFI Database Administration and create a backup of the 

master database. Save the backup file in a safe location. 

8.  On the master computer open FFI, log into the master database and select the desired 

administrative unit. Import the file from the flash drive using Utilities>Import Project 

Units/Export Macro Plots using the Append or Replace options (Data import options: No 

change, Append, Replace). Importing into FFI can take a long time if there is a lot of data. 

Move the file you are importing from the flash drive to the computer desktop to make import 

faster. 

9.  Check your data, consider making a backup of your master database. As an extra 

measure of safety you might also want to save the files exported from the field computer. 
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Monitoring Statuses 

o Managing Monitoring Statuses 

o Adding a Monitoring Status 

o Deleting a Monitoring Status 

o Assigning Monitoring Statuses 

o Default Monitoring Statuses 

o Setting and changing Default Monitoring Status 

 

Each time macro plot data are entered in FFI the sample event date is used to link all of the 

data for that sampling visit. However, the sampling date alone is not a very helpful description 

when trying to organize sample events relative to the treatments you are monitoring. So FFI uses 

the Monitoring Status to assist in describing the sample events in ways that will help organize 

them for reports and analysis. All of the monitoring statuses are stored at the project unit level. 

Managing Monitoring Statuses 

You can add, edit, delete and order monitoring statuses by clicking on the Project Management 

navigation bar, highlighting a project unit name in the All Project Units tree view in the left pane 

and selecting the Monitoring Status tab.  
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Adding a Monitoring Status 

Add a monitoring status when you need a new name for a sampling event. With the Monitoring 

Status tab selected click Add and the Monitoring Status Builder window will open. 

 

 

Enter a Prefix, Base and/or Suffix for the monitoring status name. The dropdown boxes for each 

field list suggested values but you are not required to use them. You should name your 

monitoring statuses something useful for the project they will be used with. We suggest using all 

three fields but they aren’t required. Your entire monitoring status name can be entered in one 

field. Click OK & Close to save the new monitoring status. 
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The new monitoring status will be added to the monitoring statuses tab. 

 

Deleting a Monitoring Status 

Delete a monitoring status by highlighting the name on the Monitoring Status tab and clicking 

Delete. 

 

NOTE: FFI will not warn you if you try to delete a monitoring status that is assigned to a sample 

event. If you inadvertently delete an assigned monitoring status you can Add the monitoring 

status again and assign it to the sample event. 

Monitoring Status Order 

The order the monitoring status are listed on the Monitoring Status tab is the order they will be 

used in Reports and Analysis. To change the monitoring status order highlight the one you want 

to move and click Up or Down. 
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Assigning Monitoring Statuses 

You can assign monitoring statuses two ways: 1) using the Change Monitoring Statuses utility in 

Project Management or 2) on the Monitoring Status Assignment tab in Reports and Analysis. 

1.  In Project Management highlight a project unit or macro plot in the tree view and select New 

> Change Monitoring Statuses. 

 

 

Use the checkboxes to assign monitoring statuses in the Change Monitoring Statuses window. 

When complete click Save. 

 

NOTE: Column width can be reset by clicking and dragging the column edge. The position of 

the columns can be changed by clicking and dragging the column heading name. 
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2.  Click on Reports and Analysis, highlight a project unit in the tree view and select a monitoring 

status from the dropdown list for each sample event.   

 

NOTE: Any sample event with monitoring status set to None will be excluded from reports, 

analysis and queries. 

Default Monitoring Status 

FFI includes an optional field for each sample event called Default Monitoring Status to help you 

remember the original reason for establishing the sample event. This field is in addition to the 

assigned monitoring status that can be displayed in the tree view and used in Reports and 

Analysis. The Default Monitoring Status field was added because some users switch the assigned 

monitoring statuses pretty frequently as the plot is used for different reports and/or combined 

with data in other project units. The Default Monitoring Status field does not change as the 

assigned monitoring status changes so it is a reminder why the sample event data were 

originally collected. 

NOTE: Default Monitoring Status is not used in Reports and Analysis or the Query tool. Only the 

assigned monitoring status is used in these modules. 
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Setting and changing Default Monitoring Status 

You can set the Default Monitoring Status two ways. First, it can be set when creating new 

macro plots with the Batch Macro Plot Builder. Either select an existing monitoring status from the 

dropdown list or click New to add a new one. When using this feature the Default Monitoring 

Status and the assigned monitoring status will initially be the same. One or both can be changed 

later, if desired. 

 

 

Second, Default Monitoring Status can be set by highlighting a sample event in Project 

Management and either selecting an existing Default Monitoring Status from the dropdown list or 

clicking New to add a new one. 

 

 

In either case when you add a new monitoring status to use as the default it will be added in the 

monitoring status table with the other monitoring statuses tied to the project.   

Here is the table showing all the monitoring statuses assigned to this example project. 
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Remember, the Default Monitoring Status may or may not be the same as the monitoring status 

assigned to the sample event. In this screen shot the assigned monitoring status in the tree view 

has been changed to PostWildfireYear1 but the Default Monitoring Status remains set to 

PostHerbicide2001. 

 

 

The monitoring status displayed in the tree view is the same one used to order plots in Reports 

and Analysis. 

 

  

When a macro plot in one project unit is assigned to another project unit the Default Monitoring 

Status for the macro plot will be the same in both project units. 

 

 

 

 

 

 

 

Creating a Macroplot Report 

The Macroplot Report includes all macro plot data fields in Project Management, such as 

Elevation, Aspect, Slope, Latitude and Longitude. The report also includes Sample Event Date, 
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Monitoring Status and Default Monitoring Status for each sample event. The report is saved as a 

CSV file that can be opened in Excel. 

To create a Macroplot Report select Utilities > Macroplot Report in Project Management and 

select a location to save the file. 

 

 

View the file in Excel. 

 

Creating a Sample Event Report 

The Sample Event Report lists protocols and monitoring statuses for all sample events in an 

administrative unit. The report can be used to see what protocols have been assigned to what 

sample events and whether or not data have been entered for the protocol (if Visited is set to 

No then data has not been entered). The report is saved as a CSV file that can be viewed in 

Excel. 

To create a Sample Event Report select Utilities > Sample Event Report in Project Management 

and select a location to save the file. 
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Open the file in Excel and use the Sort and Filter functionalities to view the plot report. Here the 

report has been filtered to show only the PreTreatmentYear1 sample events with the Tree 

protocol assigned to them. 

 

NOTE: The Visited field will be set to Yes if data has been entered in the protocol even if it is 

just the sample attribute data that was copied from a previous sample visit. 
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PDA coordination 

NOTE: PDA application development ended in 2013. If you are using a PDA/data recorded 

running Windows Mobile 5.0 then the PDA application should still work. Some users have 

successfully installed in on Windows Mobile 6.0 and 6.1  

The PDA Coordination window is used to support use of FFI with PDAs (personal digital assistants). 

This functionality is not available in FFI-Lite.  

Use this section of the FFI User Guide together with the FFI PDA Field Handbook, which is also 

included in the installation package as a stand-alone PDF file. Operations that are performed 

only on the PDA, such as entering field data and performing backups, are covered in the 

handbook. 

The basic PDA Coordination interface on the desktop is shown here. 

NOTE: When FFI opens, it occupies the full screen. Whenever you use FFI with your PDA, be 

sure to resize the FFI window so that you can see the ActiveSync window. ActiveSync must be 

running every time you use FFI with your PDA. 
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Coordination tasks 

This section of the FFI User Guide covers PDA-related operations that are done on the desktop: 

o Setting up a new PDA for data collection. 

o Exporting sample events to the PDA for data collection in the field. 

o Importing monitoring data from the PDA to the desktop. 

NOTE: The FFI PDA Field Handbook is available as a PDF that you can load on your PDA for 

use in the field. This requires that you install Adobe Reader for Pocket PC 2.0, which can be 

downloaded at http://www.adobe.com/products/acrobat/readerforppc. 

  

Setting up a new PDA 

This section presents instructions on setting up a new PDA (personal digital assistant) for using 

FFI PDA in the field. The steps are: 

o Synchronizing the PDA. 

o Installing FFI PDA. 

o Loading any needed reference documents. 

FFI PDA is designed to be used on PDAs that run Windows Mobile 5.0. See FFI installation for 

memory and speed requirements. 

Synchronizing the PDA 

The first step in installing FFI PDA is synchronization. The User Guide assumes that you are using 

ActiveSync to synchronize your PDA. If you do not have ActiveSync on your PDA, you can 

download ActiveSync 4.5 from http://www.microsoft.com/windowsmobile/activesync. 

To synchronize your PDA and the desktop, place the PDA in its docking station. ActiveSync will 

begin automatically. During synchronization, you will see the ActiveSync screens, shown below, 

on your desktop.  

  

http://www.adobe.com/products/acrobat/readerforppc.html
http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
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NOTE: When FFI opens, it occupies the full screen. Whenever you use FFI with your PDA, be 

sure to resize the FFI window so that you can see the ActiveSync window. ActiveSync must be 

running every time you use FFI with your PDA. 

 

NOTE: When you run ActiveSync, be sure that all of the ActiveSync options are turned OFF, so 

that only ActiveSync itself is running. Follow the procedure shown below to turn off the 

ActiveSync options. 

When synchronization is complete, move on to Installing FFI on the PDA. 

 

A note about ActiveSync partnerships 

ActiveSync partnerships are optional. In a partnership, ActiveSync identifies your PDA with a 

specific desktop PC, and retains the information type settings for synchronization. You can also 

use ActiveSync as a guest, without forming a formal partnership. Because partnerships can 

trigger conflicts with FFI PDA, use them only if you also use your PDA for other applications, such 

as MS Outlook, that require a partnership. 

NOTE: If you use an ActiveSync partnership, be sure to turn your partnership OFF before 

running FFI PDA. FFI PDA operations conflict with ActiveSync operations. 
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To turn off your ActiveSync partnership: 

1. In the ActiveSync window on the desktop, click Options in the Tools dropdown menu. 

 

2. Unselect each of the checkboxes, and click OK. 
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Installing FFI on the PDA 

NOTE: Installing FFI PDA requires approximately 15 minutes, and requires that you carefully 

monitor your desktop and the PDA to read and respond to installation prompts and 

instructions. 

After synchronizing your PDA, follow these steps to install FFI PDA:  

1. Start FFI on your desktop computer and open PDA Coordination. 

2. In the Setup PDA menu, select Setup New PDA. 

 

3. The PDA Setup window opens on your computer. This window will remain open throughout 

the installation, and will periodically give you instructions and prompts. Click Continue in 

the window to begin the installation process. 
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4. IMPORTANT: Pay close attention during the installation process. You will need to watch 

both the desktop and the PDA windows to read and respond to dialogs. Although the 

installation procedure varies somewhat from PDA to PDA, the installation generally follows 

this sequence: 

a. Respond to all dialogs on the PDA until you reach the main PDA window and the 

PDA has synchronized. Let the PDA install any component it asks to. When it is ready, 

tap OK in the upper right corner of the PDA window. 

b. Click Continue in the desktop PDA Setup message box. 

c. Then continue through the next set of PDA dialogs, until you reach the main window 

and the PDA has synchronized again. 

d. Then click Continue in the PDA Setup message box on the desktop. 

e. This cycle may repeat another time or two. 

General installation notes: 

o Any time the PDA asks about reinstalling existing components, click Yes. 

o Any time the PDA asks to restart, click OK. 

o When the PDA announces that it has successfully installed something, click OK. 

o Click Continue in the PDA Setup window after the PDA has finished a particular task. 

5. When installation is finished, a Finished message box will display on the desktop. Click OK. 
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6.  After FFI is installed on your PDA, the FFI PDA program icon appears in the PDA Programs 

window.  

        

NOTE: You need only install FFI on the PDA once, although there is no harm in reinstalling it. 

 

Exporting sample events to the PDA 

To prepare for sampling in the field with the PDA, you must export sample events to FFI PDA. FFI 

will also export the local species list and its associated picklists to the PDA. 

Following are some important tips to observe when you export sample events: 

o If you have an ActiveSync partnership, be sure to turn it OFF before running FFI. Also turn 

off any ActiveSync options, so that only ActiveSync is running. 

o You can only collect data for the macro plots and sample events that you specify when 

you export to the PDA. Therefore, if you are installing a new plot, you must create the plot 

in the FFI Project Management module, even if you don't yet have any coordinates or 

other information about the plot. You can edit the macro plot description after you return 

from the field. 

o Sample events are unique to macro plots. You must select each sample event for each 

macro plot you wish to visit. Example: if you want to visit three plots on May 29, 2008, that 

date should appear three times in the PDA Coordination Details data grid, as shown 

below. 

o Be sure to export a sample event to the PDA only once. The PDA doesn't retain any data, 

so once you import a completed sample event into FFI, the PDA has no memory of it. If 

you export the sample event again later, none of its method data will be exported with it. 
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To export sample events: 

1. On your desktop, start FFI and select PDA Coordination. 

2. Place the PDA in its docking station. 

3. In the PDA Coordination tree view, navigate to the appropriate project unit and macro 

plot. 

4. Click each sample event to be exported. The events will be listed in the grid in the PDA 

Coordination Details window. Note that sample events for two macro plots will be 

exported. 

NOTE: To remove an event, select it and then click Remove Selected. To remove all events, 

click Clear Entries. 

 

5. Ensure that ActiveSync is running and that FFI PDA is not running. 
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6. On the desktop, select Export Sample Events to PDA in the Send/Retrieve menu. 

 

7. A progress bar will appear. The export process takes several minutes. When the bar 

disappears, the process is complete. The sample events will disappear from the 

PDA Coordination Details grid. 

You may also wish to load reference documents on your PDA before going to the field. 

Important: Before you go into the field, perform a self-restoring Sprite backup on each of your 

memory cards to protect against data and application loss. For information, see Creating a 

self-restoring Sprite backup file in the FFI PDA Field Handbook. 

To work with your sample events in the field, proceed to the FFI PDA field handbook. 

 

Loading reference documents 

You may also wish to transfer Word, Excel, and Acrobat documents from your desktop to the 

PDA for reference in the field. 

To transfer files, you need to establish an ActiveSync partnership. Then you can use the Explore 

icon on the ActiveSync window to bring up a Mobile Device explorer window, which can then 

be used to copy documents directly to the PDA. See your PDA operator's manual for more 

information on document transfer.  

NOTE: Be sure to turn your ActiveSync partnership OFF before running FFI. 
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Importing data from the PDA 

After you have collected field data and returned to the office, import your data into the 

administrative unit database on the desktop. 

NOTE: Be sure to turn your ActiveSync partnership and any ActiveSync options OFF before 

running FFI. 

1. Synchronize the PDA by placing it in the docking station. FFI PDA should not be running. Be 

sure that ActiveSync recognizes the PDA, ensuring that the computer and the PDA are 

communicating. 

NOTE: ActiveSync does NOT download your field data from the PDA.  

2.  On the desktop, start FFI and log into the appropriate administrative unit and database. 

3. Click PDA Coordination. 

4. In the Send/Retrieve menu, click Import Data From PDA. The import begins automatically 

and may take a few minutes. 
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5. When the import is complete, a message window opens. Click OK in the Data Capture 

PDA message window. 

 

NOTE: All of the field data that you designated for import is now contained in the 

administrative unit database on the desktop, and no longer resides on the PDA. However, if 

other administrative unit databases are present on your PDA, they will not be affected. 

6.   You can now go to Data Entry and Edit in FFI on your desktop and view the data for the 

sample events that you imported. The screenshot below shows the data that was 

imported for the Magic Kingdom October 11, 2007 sample event. 

NOTE: See Data entry and edit for more information on viewing and working with data. 
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Data Entry and Edit 

Use the Data Entry and Edit function to enter sampling data into the FFI database after a sample 

event has been completed, or to confirm data quality after uploading data from a PDA. Data 

Entry and Edit is protocol-based. 

NOTE: The Data Entry and Edit function assumes that you have worked with and understand 

the methods and protocols, and are familiar with the standard data forms used to collect 

monitoring data in the field. 

This section of the User Guide contains: 

o A brief tutorial on how to use the Data Entry and Edit function, with some very basic 

guidelines on data entry methods. 

o A brief discussion of fuel constants, which are integral to three of the surface fuels 

protocols. 

Data Entry and Edit user interface 

The basic Data Entry and Edit user interface is shown below.  
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Data Entry and Edit basics 

Protocols and sample events 

When you select a sample event from the Data Entry and Edit tree view, FFI opens the Data Entry 

and Edit Details window. A tab is displayed for each sampling protocol assigned to the sample 

event. 

This screenshot of the Project Management, Sample Event window identifies the 12 protocols 

that are assigned to the Sept. 5, 2003 sample event in macro plot TESTFOREST1 of the TEST project 

unit.  
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When in Data Entry and Edit, double-clicking on a sample event in the tree view opens the Data 

Entry and Edit Details window. Here the Sept. 5, 2003 sample event is opened in Data Entry and 

Edit, and tabs for all 12 protocols are displayed. 

o Click a tab to open the data entry form you wish to work with. 

o Save your data before moving from one protocol tab to another. 

o Use the toolbar to save the record, cancel data entry, or delete the entire visit. 

CAUTION: Clicking Delete Visit will permanently erase all data on the active tab. It will not 

affect other protocols attached to the sample event. 

 

 

 

 

 

 

 

 

 

 



148 
 

Basic data entry procedures 

This page outlines basic data entry procedures. See Data entry guidelines for additional 

information. 

To enter data for a completed sample event: 

1. With Data Entry and Edit navigation bar selected click a sample event in the tree view to 

open the Data Entry and Edit Details window. In this example, The Sept. 5, 2003 sample 

event for macro plot TESTFOREST1 is selected. 

2. In the Data Entry and Edit Details window, select a protocol data collection tab to work 

with. The Trees protocol is selected and the form is now open. 

3. If you wish, click the Picklist menu and select a picklist. Here, the Trees picklist is selected. 

(Also, see Using picklists in Data Entry and Edit) 

4. Begin to enter data by clicking in the first cell. Use the Tab key on your keyboard to move 

between cells. When you have completed entering data for the record hit the Enter key 

on your keyboard to begin a new row. Click Save when you are finished entering data on 

the current form.  

 

 

 

 

1 

2 

3 

4 
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Data entry guidelines 

o Hover over the column headings for a description of the data to be entered into the field. 

 

o Use the Tab key to move horizontally between fields. 

o The Enter key moves the cursor to the first (left-most) field in the next row. 

o Clicking Shift + Enter adds a new row and moves the cursor to the current column in the 

new row. 

o Click a column heading to sort ascending or descending. An arrowhead will appear 

when sorted. 

 

o Click View > Index Ascending to order records as they were entered. 

 

o To cancel data collection for a protocol, click Cancel. 

o To delete a record row, select the entire row (by clicking in the row selector box at the left 

of the row) and press Delete on your keyboard. 

  

o To delete all entered data for a protocol, click Delete Visit. Use carefully as this cannot be 

“undone”. 

o Grayed-out columns, are calculated fields. When you click Save after completing a 

record row, the calculated values will appear. You cannot enter data into these fields. 

o If you conduct a sample event but have no data to report, enter the required sample 

attribute(s) in the header area of the form (e.g., plot area) and click Save. This ensures 

that the plot visit is included in any calculations that you make, such as density or 

frequency calculations. 

o A record is a row. All fields (columns) within the record must be completed correctly 

before the record can be saved. For this reason, completing data entry row by row is 

preferable to a column-by-column approach. 
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o Data entry forms are columnar. Scroll all the way to the right to ensure that you locate 

and complete all fields. 

o Column widths can be changed and are saved when the database is closed  

o Press Enter on the keyboard to add a new record. 

o Method attribute codes and species data types, such as Species, Class, and Status, are 

entered into the forms through dropdown lists. The lists contain all permitted values for the 

attribute or species, and are identified in data entry forms by a lock symbol, indicated in 

the example below. Reach these lists by clicking on the lock icon to open the list, and 

then selecting the desired value. In this example, clicking the lock icon opens the species 

list and the species Carex is highlighted. 

 

 

o Method attribute codes and species data types can also be entered into the forms using 

the auto-complete feature. Tab into the field, and begin entering text. Tab away from the 

field when you see the desired value. 

o Grayed-out columns, like the Tape column above, contain calculated values. When you 

click Save after completing a record row, the calculated values will appear. Do not enter 

data into these fields. 

o Comment and User Variable (UV) fields are always text fields. 

o UV fields can be used to contain any data you wish to record but that is not specifically 

called for in the form. For example, when you are using a data entry form that uses 

specific ranges, use a UV field to enter and retain the actual readings. Or, you might use a 

UV to record whether the right or left side of a transect is being sampled. When performing 

analyses, you can stratify by UVs. When using the UV fields complete the UV description 

fields in header to describe the data. 

o You must Save or Cancel changes within a protocol tab before switching to another 

protocol tab. FFI will prompt you to cancel or save your changes.  
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o A red Attention icon will notify you of required data or form errors. Hover over the icon to 

view the message. A form cannot be saved until all errors have been resolved. Once you 

resolve the errors and click Save, the Attention icon will disappear. 

 

  

View settings 

FFI includes the ability to: 1) hide, 2) reorder, resize and 3) freeze columns in the data entry grid. 

The view settings are carried with the database. If you change protocol view settings in one 

sample event the view settings will apply to all sample events in the database. 

  

o How to hide and unhide columns 

o How to change column order 

o How to freeze columns 

o Changing column size 

o Importing view settings 
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How to hide and un-hide columns 

Click on the View button in the upper left corner of the data grid, uncheck the fields you do not 

want to see and select Save View Settings. Is this example no fields are hidden. Required fields 

are grayed out.  

 

 

To unhide columns click View and check the boxes of the columns you want to see.  
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How to change column order 

Change the column order by selecting the column header you want to move and dragging it to 

its new position. Column position is saved with the database. 

In this example the Tape field is moved to right of the Status field so the user doesn't have to tab 

over it during data entry. 

Place the cursor over the column label you want to move, click and hold the left mouse 

button... 

 

 

…drag the field to the position you want it… 
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…release the left mouse button. The Tape field is now right of the Status field. Click the view 

menu and select Save View Settings. 

 

How to freeze columns 

Freezing a column makes that column and every column to the left of it stay in place when 

scrolling right. Here is an example of freezing the Point and Transect fields. 

Place the cursor on the rightmost column label you want to freeze, right-click and select Frozen. 

Click the view menu and select Save View Settings. 
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Now when scrolling to the right the Transect and Point field remain in view. 

 

To un-Freeze column right-click and uncheck the Frozen box.  

Changing column size 

Column width and column header height can be changed by moving border while holding 

down the left mouse button. The column width changes are saved with the other view settings. 

Column height changes are not. 
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Importing view settings 

Export files created in FFI or FFI-Lite include the view settings for all protocols in the database 

(even protocols not in the export file). When importing you will have the option to import the 

view settings that were copied from the source database or maintain the view settings as they 

exist in the destination database. To import the view settings check the Import View Settings box. 

If left unchecked the view settings in the destination database will be unchanged. 

            

 

Using picklists in Data Entry and Edit 

Picklists are a subset of your local species list and are used whenever you want to use a subset of 

species during data entry or when querying your data. Picklists are saved at the administrative 

unit level. 

When you enter data for a sample event, you can apply the picklist that you used while 

collecting sample data in the field. This limits the number of species available for selection in the 

data entry forms to only those that you know to be present in the sampled area, which can save 

considerable time. You can readily switch between picklists at any time to using the Picklist 

dropdown. 

To select a picklist, click the Picklist dropdown menu in the toolbar of the Data Entry and Edit 

Details window and select the desired picklist.  

 

 

Select Local Species in the picklist dropdown to see the entire local species list again. 
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Method-specific data entry tips 

This section includes notes and tips that are pertinent to specific methods. 

o Disturbance history 

o Biomass - fuels 

Disturbance history 

For clarification of certain fields in the Disturbance History data entry form, see below. 

 

1. Severity Code: This is a user-defined field, since there is no standard set of codes for 

severity of disturbance. Establish a set of codes to meet your particular situation before 

going to the field. 

2. Date Precision: This is a decimal field that allows users to indicate how sure they are of the 

time of disturbance noted in the previous six data fields (these fields are truncated on the 

graphic above), in years. For example, you might know the precise date of a prescribed 

fire but not the dates or insect- or disease-related disturbance. In this field, you could, for 

example, enter a value of 2 to indicate that your level of certainty as expressed in the 

previous fields is within about two years. 

3. Change Description: This is a text field. Use it to describe the change that has occurred, or 

to provide additional data to describe the change agent. 

Biomass - fuels 

Biomass fuels values vary. Before going into the field, select a photo guide that describes fuels in 

your area. These guides generally divide fuels into either a >3" class or the smaller classes. In the 
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field, visually divide the fuels into the classes used in the selected photo guide and record these 

values in the data entry form. 

 

1. Units for the > fields (e.g., >3”–9”) are in tons per acre. 

2. Units for the % Rotten fields (e.g., %>3”-9” Rotten) are the percentage of the class that is 

rotten vs. sound. 

3. Information in the Source fields (>3”-9” Source) is a description of the source publication. It 

is a text field. 

 

 

Fuel constants 

Fuel constants are used in equations to calculate fuel loads. They are associated with the 

surface fuel protocols, as shown here: 

PROTOCOL FUEL CONSTANTS 

Surface fuels FWD (fine woody debris), CWD (coarse woody debris), and DL (duff/litter) 

constants 

Surface fuels - Alaska 

duff/litter 

Alaska DL constants 

Surface fuels - vegetation FL vegetation constants 

 

The use of the fuel constants is not required, however; the default values for the Surface Fuels 

and Surface Fuels - Vegetation protocols (duff, litter, FWD, CWD and vegetation) are typical for 

the U.S. Northern Rocky Mountain states and may not be applicable for your area. The fuels 

constants used in the Surface Fuels - Alaska duff/litter protocol are typical for that state. A partial 

list of references for fuel constants is available on Fuel Constant Set References page on the FFI 

http://www.frames.gov/ffi
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FRAMES website. Fuel Constants Sets are saved with the database and are available in all 

sample events. 

The Fuel Constants field is embedded in the protocol data entry sheets. As shown in the example 

below, the Fuel Constants for the Surface Fuels protocol includes FWD Constants, CWD 

Constants, and DL Constants.  

 

 

 

NOTE: Even though Fuel Constant Sets are entered at the sample event level, and appear to 

only be available for one sample event, they are available for every sample event in a 

database. 

 

 

 

 

 

 

In this example below, the FWD fuel constant data grid has been selected. Default values are 

displayed at the top of the Fuel Constant Set window. The first custom Fuel Constant Set named 

Westside has been entered in the grid below the default values and another row has been 

added with a default Fuel Constant Set name of NewConstants_2. The fuel constant values for 

the new set are initially the same as the default values at the top of the window. The second row 

is ready to be named by the user and new fuel constants entered. Click Save & Close when 

finished.  

 

NOTE: Fuel Constants are always entered in English units regardless of being added to a 

metric- or English-units protocol. The required units for each data field are displayed at the 

top of the Fuel Constants window. 

http://www.frames.gov/ffi
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The custom Fuel Constant Sets will be available in the dropdowns in the applicable protocols. 
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Query 

  

The Query screen lets you retrieve and explore your method data within a powerful and flexible 

user interface. Within the Query screen, you have complete control over the method data that 

you want to look at, the macro plots that you want to include in calculations, and even the 

types of calculations that you want to do. Query is used to: 

o View data for selected plots that fit designated criteria. 

o Group data in unique ways for exploration. 

o Explore how individual species change with monitoring status. 

o Explore the effect of treatments during each sampling event. 

o Classify attributes with user-defined names. 

o Calculate measures of density, DBH, or cover. 

o Export unique data combinations for further analysis. 

This section includes descriptions of the four main functions that are included within the query 

process. These functions include Filtering, selecting Additional Data, Classifying, and Grouping 

and Calculating summary data (see FFI screen below). Each function is described is this guide 

using examples that illustrate specific queries that can be developed. Because this feature is so 

flexible, however, these examples cannot show the many possibilities for creating data sets that 

a user has. 

NOTE: Be aware that FFI will not prevent you from making inappropriate selections. Not every 

query that can be created will be useful or meaningful. 
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NOTE: On each tab, click on Apply Selections after you have made your query selections  

o The Filter tab lets you quickly pick the method that you want to explore data from, the 

macro plots that you would like to include in a data set, the sample events or monitoring 

status that are important to you, species or group of species that you want to focus on; 

and it gives you many options to explore your data sets. 

o Classify let you break continuous values like DBH into classes, which can then be grouped 

in the results. 

o Additional/Calculated Fields allow you to include attributes from the event, plot and 

species table that would otherwise not be included in the results. 

o Grouping can be used to summarize data by the values in one or more field and perform 

calculations. 

o Summary Calculations is used to make the final calculations in the query 

NOTE: The Query Builder Calculation Guide provides helpful tips for making a number of basic 

queries. It is available on the Help Documents page on the FFI FRAMES website. Practice 

exercises can be found in the query exercises available on the FFI Training Materials page on 

the FFI FRAMES website. The exercises provide example queries for the most common query 

types: basic filtering; basic classification; and calculations of density, cover and frequency. 

  

Query – Filter tab 

The FFI Filter tab lets you select records by project unit, method, macro plot, sample event, and 

species. After you have selected the project, you can proceed through the filtering fields and 

other Query tabs to refine your query output. Filtered records are displayed in the grid at the 

bottom of the Query Details window and can be exported as an Excel file. 

 NOTE: Filter is based on method, rather than protocol. 

 

http://www.frames.gov/ffi
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NOTE: Basic descriptive data for a macro plot, such as Visited status and MacroPlotSize, is 

shown only in the first record of each macro plot in the lower grid. 

Using the Filter tab 

1. Select the project unit in the tree view. 

2. Select the protocol in the dropdown listing, and then select the appropriate method (Tree 

Data - Individuals is selected is in the example screen shot,). This limits the query to only 

those macro plots that include sample events using the selected method. 

3. Continue making choices in each field to create the query. In the example, no macro 

plots are highlighted so all plots will be included in the query and the option to exclude 

dead/down trees is checked.  

NOTE: If the Exclude non-vascular box is checked the query results will exclude records 

that are Not Biological (identified in the PLANT Characters box in Species 

Management). Checking the Exclude trees dead/down box excludes trees with Crown 

Class codes of DD, BBD and CUS from a query of the Trees-Individuals method. If the 

Live perennials and all annuals box is checked then species with a Status of Dead will 

be excluded from the query results. 

4. Click Export to export the grid as a data file for use in other software packages. The query 

itself is not exported. 

5. Click Clear at any time to clear all selections within the query. The Protocol field will remain 

selected until it is changed by the user so the lower table will also display all data from this 

protocol until it is changed. 

Some filtering guidelines: 

o You can filter all project units or one project unit at a time. If you would like to explore 

data from multiple project units (but not all the project units) within one query, you should 

create a new project unit under Project Management (you could name it analysis project, 

for example), choose the macro plots you would like to combine under the new analysis 

project, assign monitoring statuses to the sample events and then, in Query Builder, query 

to filter or group plots within that analysis project as described in the Query section. This 

gets around the ‘query within a single project’ rule.  

o Only one method can be queried at a time. 

o If no items in a list are highlighted then all items are included in the query. To filter a list, 

click an item once to include it in a query (it will be highlighted). If one item in a list is 

highlighted all other items will be excluded from the query. To unselect an item click it a 

second time to so it is no longer highlighted. 

o To select a range of sample event dates, enter a minimum and maximum date (inclusive). 

To select a single date, make the two the same. To include all dates, leave both blank (as 

in the example above) by unselecting the checkboxes. 

o You can select a picklist as a filtering criterion. 

o Click on any column heading to sort the records by that data element.  

o When viewing the records, scroll horizontally across the grid to view all record fields. 
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NOTE: If you click the Query All Project Units button on the Filter page, the query will show all 

of the macro plots (and all sampling events within each macro plot) for the selected method. 

All of the method attributes within the method will also be listed in the grid. You will not be 

able to filter on monitoring status in any query because all sampling events are already 

included in your output when you chose this option. 

 Query – Classify tab 

The Classify tab allows you to classify any attribute that is displayed as numeric field in your 

query, such as tree DBH or plant height. The classes that you create can be used in calculations 

within FFI or exported to use in other applications. 

NOTE: More information can be found in the query exercises available on the FFI Training 

Materials page on the FFI FRAMES website. The exercises provide example queries for the 

most common query types: basic filtering; basic classification; and calculations of density, 

cover and frequency. 

 

NOTE: Basic descriptive data for each macro plot, such as Visited status and SnagPlotSize, is 

shown in the first record for each macro plot in the data grid. The data gird contains all 

attribute data for your selected macro plots, status, method and field. 

 Using the Classify tab 

1. Select a protocol/method that contains the data you want to classify. Protocols and 

methods are selected on the preceding Filter tab. In the example above, the method that 

contains the DBH data that we want to classify is Tree Data – Individuals. 

http://www.frames.gov/ffi
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2. In the dropdown list on this Classify Tab screen, select the Field to classify. In this case, we 

chose DBH. 

3. On the first available line in the upper table, enter the Upper Cutoff value and a Class 

Label name that you want to assign to this class. In this example, there are two classes. 

From 0 to 9 (the upper cutoff value) our trees will be classified as Poles. Those trees greater 

than 9 will be classified as Overstory. Note that there is no upper limit to the overstory class 

in this example. 

4. Click Apply and then Apply Selections to classify the records, or Clear to clear the values. 

The Clear button below the Apply button will clear only values in the upper table where 

the classification is set. When you click Apply Selections, the original numeric values for the 

classified column (i.e., DBH) in the lower table are replaced with your new class names. 

These new names cannot be cleared or changed by clicking Clear. They must be 

reclassified to change them. The classify procedure only changes the data in Query 

Builder. The data in the FFI database remains unchanged. 

Some guidelines: 

o For the first class, provide only a class label, not a lower cutoff value (It defaults at ‘0’). 

o For each subsequent class, the lower cutoff you provide will also be the upper cutoff for 

the previous class. All you need to supply is your upper value for the class and a class label 

on each line. 

o If you make a mistake in your classification process, click clear or use the arrows to 

maneuver to the cell with the error and begin your classification process again. 

o You may classify more than one field when you are within the Classify tab. 

o To exclude missing values from the classification, label the lowest class 'missing' and then 

set the Lower Cutoff of the next class to > 0. (This is the default when you enter the Classify 

Tab.) If you want to eliminate this option, begin typing your classification on the first line by 

changing the ‘MIN’ to ‘0’ and setting the ‘Upper cutoff’ and ‘Class Label’ as described 

above. 

o Your new class descriptions will show up automatically in the lower table of the Filter tab 

and in the Grouping tab when you click Apply. 

o Click on any column heading to sort the records by that data element. In the example 

above, the records are sorted by Date. 

o When viewing the records, scroll horizontally across the grid to view all record fields. 
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Query – Additional/Calculated Fields tab 

The Additional/Calculated Fields tab lets you include additional fields in your query. As indicated 

below, you can select any of the description fields that are assigned to a macro plot, sample 

event, monitoring status, or species if the field contains data. 

NOTE: More information can be found in the query exercises available on the FFI Training 

Materials page on the FFI FRAMES website. The exercises provide example queries for the 

most common query types: basic filtering; basic classification; and calculations of density, 

cover and frequency. 

 

NOTE: Basic descriptive data for a macro plot, such as Visited status and MacroPlotSize, is 

shown in the first record for each macro plot. 

Using the Additional/Calculated Fields tab  

1. Select additional data fields to expand the query. In this example, the species fields 

Scientific Name and Genus are displayed after Apply Selections is clicked.  

2. Each time you apply a filtering criterion and apply the selection, the record grid updates. 

Note that columns have been added for Scientific Name and Genus. 

3. Click Export to export the grid as a data file for use in other software packages. The query 

itself is not exported. 

4. Click Clear at any time to clear the query. 

http://www.frames.gov/ffi
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Some guidelines:  

o If the selected method does not have species data, the Species checkboxes will be 

grayed out. 

o Select only fields that contain values. 

o If you choose to query All Project Units, monitoring status will not be available. The query 

will show all macro plots (and all sampling events within each macro plot for the selected 

method). All of the method attributes within the method will also be listed in the grid. You 

will not be able to filter on monitoring status in any query because all sampling events are 

already included in your output when you chose this option. 

o Some methods that are sampled in quadrats have length and width attributes, but not 

area. To calculate area, enter the Width and Length and click the Calculate Area 

checkbox. Calculated areas will be summed automatically in the Grouping tab.  

o Click on any column heading to sort the records by that data element. In the example 

above, the records are sort by date. 

o When viewing the records, scroll horizontally across the grid to view all record fields. 
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Query – Grouping tab 

The Grouping tab allows you to group data by any method field. You can group by macro plot, 

sample event date, monitoring status, and various species fields.  

NOTE: More information can be found in the query exercises available on the FFI Training 

Materials page on the FFI FRAMES website. The exercises provide example queries for the 

most common query types: basic filtering; basic classification; and calculations of density, 

cover and frequency. 

 

Using the Grouping tab 

1. Click on fields you want to group the data by and click Apply Selections. In the 

example, Trees Individual data have been grouped to show the number of rows (tree 

records) for each genus and size class, for each macro plot and monitoring status. 

2. Click Clear at any time to clear the query. 

Some guidelines: 

o Don not group by tally fields. For example, in the method Cover - Points, don't group by 

number of transects or points per transect. 

http://www.frames.gov/ffi
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 Query –Summary Calculations tab 

The Summary Calculations tab allows you to sum values in any numeric method field for 

selected records.  

NOTE: The Query Builder Calculation Guide provides helpful tips for making a number of basic 

queries. It is available on the Help Documents page on the FFI FRAMES website. More 

information can be found in the query exercises available on the FFI Training Materials page 

on the FFI FRAMES website. The exercises provide example queries for the most common 

query types: basic filtering; basic classification; and calculations of density, cover and 

frequency. 

For any set of filtered/grouped data, you can calculate the total area, total transect length, or 

total count of transect points sampled by summing the appropriate sample attribute. Using the 

count or sum of the grouped data, along with the area, length, or number of points, you can 

calculate density, frequency, or percent cover. Filtered and grouped records are displayed in 

the grid at the bottom of the Query Details window and can be exported to Excel. 

 

NOTE: Basic descriptive data for a macro plot, such as sum_MacroPlotSize, is shown in the first 

record for each macro plot. 

http://www.frames.gov/ffi
http://www.frames.gov/ffi
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Using the Summary Calculations tab 

1. Select fields to sum and click Apply Selections. In the first screen shot Plot Size has 

been selected as the field to sum (shown as sum_MacroPlotSize in the data grid). 

2. Select the Calculation fields. In the second screen shot Density fields were entered: 

Area=sum_MacroPlotSize, Count Field=RowCount, and Unit Conversion=Acres – Acres 

(feet). The Density checkbox was selected and, after clicking Apply Selections, the 

Density of pole trees and overstory trees for every macro plot/monitoring status were 

displayed in the data grid. 

Some guidelines: 

o Be sure to review the summed area or point counts in your results. Your sample 

configuration may result in sums that do not reflect reality. 

Using saved queries 

Once all the query selections have been made you can save the query to repeat the same 

query again later. Type a query name in the field and click Save Query. (Queries are saved in 

this folder: C:\ProgramData\FFI\SavedQueries). 
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To use a saved query select it from the dropdown list and the query will run immediately. To 

remove an unused query, select the query in the dropdown and click Delete Query. 

Exporting query results 

The results of queries generated by the FFI query builder can be saved and exported as a *.csv 

file for use in reporting or analysis. To export a query as a *.csv file: 

1. Develop a query that contains the fields and data list that you would like to work on in an 

external application. 

2. Click Export in the Query Details toolbar. 

 

3. Browse to the location where you would like to save the file, enter a name for the export 

file, and click Save. 
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Reports and analysis 

This section of the User Guide presents procedures for using FFI's Reports and Analysis functions. 

NOTE: In FFI, all analysis takes place within a project unit. If you wish to perform an analysis 

using data representing multiple project units, you can create an analysis project unit and 

assign the macro plots of interest to the new project unit. 

o Reports 

o Analysis 

 

  

Creating reports 

In FFI, you can create data summary reports for a project unit based on the standard FFI 

protocols or other protocols that you have imported. Reports can be printed, or exported as 

comma delimited, Excel, Acrobat PDF or Microsoft Word files. 

The standard FFI reports are listed below. For descriptions of each report type, see About the 

reports. 
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Biomass - Plants CBI Cover - Line Intercept Cover - Points 

Cover - Points by 

Transect 

Cover - Species 

Composition 

Cover - Frequency Density - Belts 

Density - Quadrats Disturbance History Fire Behavior (CSV 

only) 

Pilot Sampling 

Plot Description (CSV 

only) 

Post Burn Severity Surface Fuels Surface Fuels - Alaska 

Duff/Litter 

Surface Fuels - Piles Surface Fuels - 

Vegetation 

Trees Trees by species 

Trees – Fire Effects Trees – Fire Effects by 

Species 

Trees – Seedlings, 

Saplings 

Trees – Seedlings, 

Saplings by Species 

Trees Variable Radius Trees Variable Radius 

by Species 

  

To create a report: 

1. Select Reports and Analysis navigation bar to open the Reports and Analysis Details 

window. 

2. Select the desired project unit. The Monitoring Status Assignment window opens, listing all 

associated macro plots and sample events for the selected project unit. 

3. Using the dropdown lists, assign the appropriate monitoring status for each sample event 

to be analyzed. Click Save when finished. 

 

NOTE: A monitoring status can be assigned to one sample event per macro plot. In this 

example, an error is shown for TESTFOREST1 because ReMeasurementYear1 has been 

assigned to two sample events. 
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4. Using the Settings tab, you can select report options. 

o Use the Stratify by: dropdown to select stratification criteria, if desired. 

NOTE: The available stratification criteria are the organization codes, or user variables, 

that you may have assigned to the macro plot during creation or subsequent editing. 

For more information, see Creating a Macro Plot. 

 

o Select either English or metric Report Units. 

o Select the desired data summary report in the Report Settings tab. 

NOTE: For information on the data summary reports available in FFI, see About the 

reports. 

o In the Included Monitoring Statuses tab, unselect any monitoring statuses that you 

do not wish to include in the report. 

o In the Included Macro Plots tab, unselect any macro plots that you do not wish to 

include in the report. 
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5. To view the report, click View Report in the Report dropdown. 

NOTE: Reports can also be saved as .csv files. The comma delimited files are easier to 

work with in Excel because they do not have multiple row headers or merged cells. 

 

 

6.   A tree data summary report is shown here. Note that the report can be saved as an Excel, 

PDF or Word file. 
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Calculations for data entered in 3-part protocols 

FFI has two 3-part protocols: Trees and Surface Fuels. Each of these protocols includes three, 

related methods. However, the protocols have only one Visited field, which is used to identify 

whether or not data collection was attempted for that protocol during a plot visit. When 

Visited=No FFI Reports and Analysis assumes the protocol was not sampled and the plot is not 

included in the plot count used for calculating report averages. Because the 3-part protocols 

have only one Visited field for three methods, FFI uses special rules to determine whether or not 

sampling was attempted for each individual method during a plot visit.  These rules discriminate: 

1) plots that were sampled but no data was collected for a method (e.g., trees were sampled 

but no seedlings were found) and 2) plots with a method that was not sampled (e.g., no 

seedling data collection was attempted on the plot). 

If Plot Size (on any of the methods related to the Trees protocol) or Number of Transects (on any 

of the methods related to the Surface Fuels protocol) is set to zero then Reports and Analysis 

assumes data collection for the method was not attempted. If Plot Size or Number of Transects is 

greater than zero then FFI assumes data collection for the method was attempted.  

Specifically: 

 If Plot Size (Trees protocol) or Number of Transects (Surface Fuels protocol) for all methods 

on a 3-part form are zero then: 

o Un-stratified report: No row for the macro plot is displayed in the report. 

o Stratified Report:  The macro plot is not included in number of plots (n) used to 

calculate the average attribute values displayed in the report. (True even if there are 

data records for any method). 

 If Plot Size (Trees protocol) or Number of Transects (Surface Fuels protocol) for some 

methods on a 3-part form are zero then: 

o Un-stratified report: A row for the macro plot is included in the report but blanks are 

displayed in the report for attributes corresponding to the method(s) were Plot Size or 

Number of Transects is set to zero. 

o Stratified Report:  For those methods where Plot Size or Number of Transects are set 

to zero the macro plot is not included in number of plots (n) used to calculate the 

average attribute values displayed on the report. (True even if there is method 

attribute data). 

 If Plot Size (Trees protocol) or Number of Transects (Surface Fuels protocol) for some 

methods on a 3-part form are not zero then: 

o Un-stratified report: The calculated attributes are included in the report with zeroes 

displayed on the un-stratified report if no method attribute data is entered. 

o Stratified Report: The macro plot is included in the number of plots (n) on the stratified 

report and zeroes are included in the average for methods where Plot Size or Number 

of Transects is not zero and no method attributes are entered. 

The same rules apply to the Analysis reports – if Plot Size (Trees protocol) or Number of Transects 

(Surface Fuels protocol) is zero then any calculated attributes for that method will be excluded 

from the analysis report. 

About the reports 

The data summary reports are available through the Reports and Analysis menu. Each of the 

summaries can be customized by selecting specific macro plots and monitoring statuses 

needed with the Report Settings tab. Any of the results from these summary reports can also be 
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copied and pasted into external applications for more comprehensive analysis if desired. Each 

report type is summarized below. 

Biomass - Plants 

The Biomass report simply returns the average biomass for each macro plot. Dry weights are 

totaled by analysis group (such as lifeform or individual species) and the totals are divided by 

the number of transects. The average dry weight is then multiplied by a conversion factor that 

takes the transect areas and converts the weights by transect area to lbs/acre or kg/m2. 

CBI 

The CBI summary report displays an average burn severity rating (Composite Burn Index) for 

three analysis scales including (1) the total plot, (2) each vegetation strata requested, (3) and 

the substrate. Severity ratings range from 0 (no burn effect visible) to 3 (highest burn effect). For 

each analysis, the burn effects are averaged. The greater the average CBI number, the greater 

the burn severity for the analyzed unit. 

Cover/Frequency 

The Cover/Frequency summary displays the average percent cover for a macro plot and the 

average frequency of each species within nested plots. It also displays an average species 

height for each species sampled. To calculate the percent cover for each species sampled on 

a macro plot, the mid-point of the estimate range for the species’ cover in each quadrat is 

summed by transect (this midpoint is actually entered when you use the dropdown box during 

data entry). The transect sums are divided by the number of quadrats to give an average 

percent cover for the species on that particular transect. The averages for each transect are 

summed and then divided by the number of transect lines to give an Average Cover (%) for the 

macro plot in the summary report. Average height is computed by summing all measured 

heights (by species and status) and dividing by the number of species’ entries on each transect 

line. These average heights are summed and divided by the number of transect lines to get the 

Average height for each species in the macro plot.  

The Average Frequency for the nested samples in the Cover/Frequency summary is obtained by 

first determining where each species is located within each quadrat (see the Cover/Frequency 

description of subplots in FIREMON method descriptions at http://www.frames.gov/firemon). If 

the species is located only in a small corner of the quadrat, the plant is located in subplot “1.” If 

it is located in the right half of the quadrat, the plant is located in subplot “4.” The average 

nested-root frequency for subplot 1 is calculated by counting the number of times the species is 

in subplot “1” in the quadrats and dividing by the total number of quadrats in the macro plot. 

For the frequency of plants in subplot 2, the numbers of occurrences in subplot 2 and subplot 1 

are summed and the total is then divided by the total number of quadrats in the macro plot. The 

process for calculating the frequency in For subplots 3 and 4 is the same as for subplot 2 (i.e., 

count all the times a plant occurs in the desired group, add the number of times it occurs in all 

lower groups, and divide by the total number of quadrats). Results are displayed as a percent. 

Density - Belt 

The Density-Belt summary report displays a summary by macro plot and monitoring status for 

each species that is sampled using the density method. The total count of each species in the 

http://www.frames.gov/firemon
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belt transect is divided by the number of transects to get an average count. The average 

counts are converted to an average per unit area (per ft2 (m2) or per acre (hectare)) by 

dividing the average count by the sample area and applying the appropriate conversion 

factors. The average height in feet (m) is also calculated for each item. 

Density - Quadrat 

The Density - Quadrat summary report displays the average number of items per quadrat rather 

than per belt. It calculates average items per unit area and average height just as in the 

Density-Belt report. 

Disturbance History 

The Disturbance History summary report displays information on change agents, damage 

severity, and timing of disturbance for each macro plot if the information is entered during visits 

to the plot. There are no calculations attached to this report. 

Cover - Line Intercept 

The Cover - Line Intercept summary report displays (1) the average percent cover for each 

species by macro plot and monitoring event; and (2) the average height values for each plant 

species sampled using the line intercept method. The percent cover of each species on an 

individual transect is calculated by totaling the species’ intercepts on one transect and dividing 

by the total transect length. The Average Cover % for the macro plot, however, is calculated by 

adding the percent cover values (by species) for all transects and dividing by the total number 

of transects in the macro plot. The Average Height value is obtained by totaling the species 

heights by status and size class. The totals are then divided by the number entries in each class 

to obtain an average. Average height is displayed in feet or meters depending on the output 

units selected. 

Pilot Sampling 

The Pilot Sampling summary displays the counts species and substrate elements in four quadrats 

by macro plot and monitoring status. No calculations are made within this report. 

Cover - Points 

The Cover - Points summary report displays the average count, average hits, average cover 

percent, and average height values for plant species sampled on a macro plot using the point 

intercept method. The average count and average hits calculations take into consideration that 

multiple hits may occur at each point. The percent cover on an individual transect is computed 

for each plant species and substrate item by dividing the number of hits for an item by the total 

number of points sampled. The average cover for the macro plot is computed by summing the 

individual transect-cover values and dividing by the total number of transects. Average heights 

for each species in feet (m) are calculated for the macro plot if they were estimated. Plant 

species and ground cover values for point frames are calculated by dividing the number of hits 

for an item by the total number of points per frame. The frame cover values are used to 

calculate an average cover value for the plot. 
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Cover - Points by Transect 

The Cover - Points by Transect summary displays the average cover and average height of each 

species or substrate item by macro plot and monitoring status. Unlike the Cover – Points 

summary, this summary report uses the only the summary of total hits for each species or 

substrate item. Percent cover for each transect is calculated by dividing the total number of hits 

for a species/substrate by the total number of points sampled on the transect. Average cover 

for the macro plot is computed by summing all percent covers by species or substrate and 

dividing by the number of transect lines. 

Post Burn Severity 

The Post Burn Severity summary report gives separate assessments of burn effects for the 

substrate and vegetation strata. The severity rating for each assessment is an average obtained 

by adding all values and dividing by the number of points on a transect and by the total 

number of transects. The percent severity values are determined by counting the number of hits 

within each substrate category (i.e., how many hits in substrate 1) and dividing each by the total 

number of points per transect. If more than one transect is taken at a macro plot, all subplot 

totals are averaged by the total number of points on the multiple transects. 

Cover - Species Composition 

The Cover - Species Composition summary report displays the species cover and height data just 

as it is entered in the data entry/edit. No calculations are made within this report. 

Surface Fuels 

The Surface Fuels summary report displays the average fuel loadings in tons per acre (or kg per 

m2) for each macro plot. The loadings are calculated from fuel counts and duff/litter estimates 

on the fuels transects along with average vegetation cover and heights. Down woody loadings 

are calculated for 1-hr, 10-hr, 100-hr, 1-100-hr, 1000-hr sound, 1000-hr rotten, and 1-1000-hr fuels. 

Biomass is calculated based on the equations presented in the Handbook for Inventorying 

Downed Woody Material (Brown, 1974). Non-slash, composite values are used for quadratic 

mean diameter, non-horizontal correction and specific gravity of fine woody debris. Pieces of 

coarse woody debris in decay class 1, 2, and 3 are considered sound and assigned a specific 

gravity of 0.40. Decay class 4 and 5 pieces are considered rotten and assigned a specific gravity 

of 0.30. Loading of litter and duff is calculated using bulk densities of 2.75 lbs/ft3 and 5.5 lbs/ft3, 

respectively. The fuel constants used to calculate loading can be modified by adding custom 

Fuel Constant Sets. Duff and litter depth summaries are provided.  

Surface Fuels - Alaska Duff/Litter 

This report computes the average biomass for litter, moss, duff, and lichen for each macro plot 

and then converts the values to tons/acre (or hectares/m2) biomass. Depths for each element 

are averaged and displayed by macro plot and monitoring status within the report. 
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Surface Fuels - Vegetation 

The Surface Fuels – Vegetation report returns an average percent cover, average height, and 

average biomass for shrub- and herb- fuels for each macro plot and monitoring status. All results 

are output by lifeform (herb, shrub) and status (live, dead) within the report. Biomass of live and 

dead shrubs and biomass of live and dead herbaceous plants are calculated using the 

equation: 

B = 21.87 * (H*C*BD) 

Where; B = biomass (tons/acre), 21.87 is the conversion of lb/ft2 to tons/acre (43,560/2000), H = 

height (ft), C = percent cover/100, and BD = bulk density (lb/ft3). 

Default bulk density used for the live and dead, herbaceous and shrub components is 0.11 

lbs/ft3. Custom bulk density values can be entered in Fuel Constant Sets. 

When metric report units are specified biomass is reported in kg/m2. 

Trees; Trees by Species 

The Trees summary report displays tree densities (i.e. trees per unit area) for mature trees, 

saplings, seedlings, and snags by macro plot. For mature trees, it also displays the calculated 

basal area, average live crown base height, average height, and quadratic mean diameter 

(QMD) for each macro plot and monitoring unit. The Trees by Species summary report displays 

the same elements as the Tree Data report except that each element is displayed by species for 

the macro plot. Within this report are the densities, basal area, average live crown base height, 

average height, and quadratic mean diameter for each mature tree separated by species. 

Densities of each species for in the sapling, seedling, and snag classes are also computed. 

Custom Tree Report 

The Custom Tree Report provides the same report data as the standard tree reports but with tree 

data divided into user defined classes. Data stored in the Trees – Variable Radius protocol 

cannot be included in the Custom Tree Report at this time.  

On the Settings tab in Reports and Analysis select the report units, macro plots and monitoring 

status you want to include in the report. 

 

When the Custom Tree Report tab is selected FFI will search the database for species symbols to 

be added to the species selection boxes. In a large database this process may take a few 

seconds.  
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The Report Calculation Options provide options for grouping the classes in the report: 1) All the 

classes for each method together or 2) one row for each class. 

 

The Report Species Options provide a way to; 1) create a report with one row for each selected 

species or 2) create a report that groups all species together. 
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The Macroplot Report Options provide a way to; 1) create a report with one row for each 

selected macro plot or 2) create a report that groups all macro plots. 

 

If most or all of the species you are interested in creating a report for are in a species Pick List you 

can select the pick list in the Species Pick List dropdown. All species symbols in the pick list will be 

moved to the right side of the species selection window even if they have not been recorded on 

the plots selected on the Settings tab; however, species will not be included in the report if they 

were not recorded on the included macro plots/sample events.  

 

Select species codes to include in the report by highlighting the symbols in the left window and 

clicking the arrow in the center to move to the symbols to the right. Move species symbols from 

the right window to the left to remove them from the report.  

 

When all species codes are included in a report the report format can look awkward. 

Unchecking the Include Species Codes in Report box will replace the codes with the text All and 

make the report more readable. 

 

The custom tree report screen provides data grids for classifying the three standard FFI tree 

methods: Tree-Individuals, Trees by Diameter Class (saplings) and Trees by Height Class 

(seedlings). A report for each method will be created if the Include in Report checkbox above 

the data grid is checked. 

Each row in the data grid also has an Include checkbox. Check the Include checkbox for all 

methods and classes that you want included in your reports.  

Use the dropdown list above each method grid for setting the Class Units. Data will be classified 

based on the Class Units selected, not on the method units. For example, you can set the class 
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units as English, run a custom tree report for a metric method and FFI will convert the 

classification values from English to metric.  

 

 

 

Enter the classification data (Dia./Ht, Min., Max., etc.) in the appropriate method data grid. 

Blank fields are not allowed.  

 

NOTE: Classes are displayed alphabetically in the reports. Use a number prefix in the class 

name so they are ordered as desired in the report. 
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After you have entered the data classes you can save them for future use by selecting Project > 

Export, entering a file name and clicking Save. Use the Import feature to use the classes again in 

the future.  

  

 

 

 

 

 

 

Create a report for each method by selecting Report > View Report. 

 

 

 

NOTE: One report will be created for each method with the Include in Report checkbox 

marked. 

 



185 
 

Example 

Two macro plots and one monitoring status have been selected on the Settings tab. All reports 

created for this example will use these same settings.  

     

 

In the screen shot below four DBH classes have been defined for the Trees - Individuals method. 

Based on the classes entered by the user the report will include all tree species 0 to 99 inches 

DBH in one class because the Avg All Selected Class radio button has been selected as well as 

the radio button to group species and macro plots. The only tree records in the Trees - Individuals 

method that will not be included in this report are those greater than 99 inches DBH. 

NOTE: Two classification fields available in the Custom Tree Report are not required fields in FFI 

Data Entry and Edit: 1) Crown Class in the Tree – Individuals method and 2) Age Class in the 

Trees – Trees by Height Class (Seedlings) method. If these fields are left blank in Data Entry 

and Edit the associated records will only be included in a Custom Tree Report if the A – All 

selection is made for that field in the Custom Tree Report.  

  

 

Selecting Report > View Report creates the output showing there is an average of 55 trees per 

acre on the two plots. 
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Next, the Row For Each Class radio button is selected and a report is created. Instead of one row 

the report now has a row for each class as identified in the Class Name column. Looking at the 

row of 0 – 11 inch trees there is an average of 30 trees per acre in that class and that includes all 

four species.  

 

 

In the next report the only change is the box for Include Individual Species has been checked. 

Now there is a row in the report for every species in every size class.  
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In the last report the Ave All Selected Classes radio button is selected and the Include Individual 

Species box is still checked. The report show one row for each species with all classes combined. 
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Creating FVS files 

The Forest Vegetation Simulator (FVS) is a powerful, complex tool. The FVS team provides 

numerous training opportunities each year and we highly recommended taking a class if you 

are going to use the FVS application. See the FVS website for FVS user manuals, software, 

training classes and other information. 

FFI creates files that can be used in FVS and the associated Fire and Fuels Extension (FFE). The 

FVS-FFE files exported from FFI include data from the Trees-Individual, Trees-Sapling, Trees-

Seedlings and/or Trees–variable radius protocols, and fuels data from the Surface Fuels, 

Photoloads and/or Biomass-Fuels protocols. If data for one or more fuel components are found 

in more than one protocol then the average loading of that component across all protocol will 

be exported to the FVS file (excluding null values). If no fuels data is entered in FFI then FVS-FFE 

will use default values. Only one monitoring status at a time can be exported. 

To create the FVS files in FFI click on the FVS-Export tab and select the Variant-Region, Forest-

District and Habitat Type. If you have collected tree growth rate data in FFI and wish to include it 

in FVS then set the Years for Growth Increment Measure field. The increment value entered will 

be used to calibrate growth for all sample events included in the FVS export file. Choose a 

grouping option for the data: one FVS stand per FFI macroplot/sample event, one FVS stand for 

all selected FFI macroplot/sample events or one FVS stand per FFI strata (set in the Stratify By 

filed on the Reports and Analysis, Settings tab). Click Select Access DB Name and File Directory 

and choose a database name and a folder to store it in. The path to the folder cannot have 

spaces. (E.g., you cannot store in My Documents).  

 

 

 

http://www.fs.fed.us/fmsc/fvs/
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When all the selections have been made click Export Files. A dialog box will be displayed when 

the export is complete. 

 

NOTES: The Trees-Individual, Damage and Severity code fields 1 through 3 are included in the 

FVS database if they are numeric values. Character based damage codes and damage 

and severity code fields 4 and 5 are ignored.  

Height to Top Kill (HtTopK) is calculated for live trees (i.e., where status = L, H, U, S) and added 

into the FVS database when the following three fields are entered for a FFI tree record: tree 

height, damage code (set to 96 or 97) and severity code fields (either the ‘900’ codes or a 

percent value). HtTopK=TreeHt – (TreeHt * (percent top dead/100)) 

Creating FuelCalc and FOFEM files 

FFI will create files that can be imported directly into the FuelCalc and FOFEM applications. 

Select the macro plots and monitoring status you want to export data from on the Settings tab in 

Reports and Analysis. The data is exported at the plot level. You can export multiple monitoring 

statuses. Plots cannot be grouped/stratified for FuelCalc/FOFEM export; only English unit values 

are exported. 

Check the Include Seedlings box if you want to have seedlings in the export file. Set the DBH 

range of saplings and individual trees and the class units. Select the FuelCalc/FOFEM – Export 

tab. Click the Select FuelCalc/FOFEM filename button and select a filename that will be used as 

the prefix for the exported files. Click Export FuelCalc/FOFEM files.  
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The export feature creates a .FFI file and .TRE file with the same prefix. The file with the .FFI file 

includes component fuel load and the .TRE file includes tree information. The table below lists the 

data that are exported. Null data fields in FFI will be null in the export files. 

 
FuelCalc/FOFEM export data. 

Method1 Data exported 

Surface Fuels2 Duff depth and duff, litter, 1-hr, 10-hr 100-hr and 3”+ load 

Biomass-Fuels Loading of upper and lower duff3, live and dead moss, lichen, litter, 1-hr, 10-hr 

100-hr, >3”, %>3” rotten, grass, low shrub and high shrub3. 

Surface Fuels - 

Vegetation 

Live herb and live shrub load 

Surface Fuels – Alaska 

Duff and Litter 

Duff, litter, lichen, and live and dead moss load 

Trees - Individuals Species, status, tree density, diameter, height, crown base height, crown class, 

crown ratio 

Trees by Diameter 

Class (saplings)  

Species, status, tree density, diameter class, avg. height, avg. crown ratio 

Trees by Height Class 

(seedlings) 

Species, status, tree density, height class, avg. diameter, avg. crown ratio 

1 If a fuel component is present in more than one FFI method then the value exported to FuelCalc is the 

average component values. 
2 3”+ fuel load is exported by decay class in these classes: 3”-6”, 6”-9”, 9”-12”, 12”-20” and >20” 
3 The two components are summed for FOFEM and FuelCalc export. 

 

Performing Analyses 

In FFI, you can configure various types of statistical analyses. Results can be formatted, printed, 

or exported as either Excel files or Acrobat PDFs. 

The analyses available through the Analysis menu are summarized below.  

Descriptive statistics 

Descriptive statistics display the raw data and any summary data. 

o In the Parametric option, the descriptive statistics are the mean, standard deviation, and 

confidence intervals based on the selected alpha value. 

o In the Nonparametric option, the descriptive statistics are the median, distribution-free 

confidence intervals based on the selected alpha value, and the actual confidence 

levels (the closest possible confidence level to the selected alpha value given the sample 

size).  

Statistical analysis 

In the Statistical Analysis option, the descriptive statistics are displayed along with tests for 

significant differences between monitoring statuses. 
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o The Parametric analysis generates a One-Way ANOVA with a Dunnett’s T-test.  

o The Nonparametric option generates a Friedman’s test with a nonparametric multiple 

comparison test. 

Analysis setup 

FFI offers several options to configure a statistical analysis. Select either a descriptive statistics or 

statistical analysis. 

o A Descriptive Statistics analysis report will display the raw data and any summary data. If 

you select the Parametric option, the descriptive statistics are the mean, standard 

deviation, and confidence intervals based on the selected alpha value. If you select the 

Nonparametric option, the descriptive statistics are the median, distribution free 

confidence intervals based on the selected alpha value, and the actual confidence 

levels (the closest possible confidence level to the selected alpha value given the sample 

size). You can select the decimal precision of the analysis report. 

o If you select the Statistical Analysis option, the descriptive statistics are displayed along 

with tests for significant differences between monitoring statuses. The parametric analysis 

generates a One-Way ANOVA with a Dunnett’s T-test. The nonparametric option 

generates a Friedman’s test with a nonparametric multiple comparison test. You can 

select the decimal precision of the analysis report.  

NOTE: These analyses are further explained in the section Analysis Output Types.  

To prepare for an FFI analysis: 

1. Select Reports and Analysis from the main FFI menu to open the Reports and Analysis 

Details window. 

2. Select the desired project unit. The Monitoring Status Assignment window opens, listing all 

associated macro plots and sample events for the selected project unit. 
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3. Using the dropdown lists, assign an appropriate monitoring status for each sample event 

to be analyzed. Click Save when finished. 

NOTE: See: Managing Monitoring Statuses for more information. 

4. Click the Settings tab. 

5. Use the Stratify by: dropdown in Macro Plot Stratification to select a stratification criterion, 

if desired. 

NOTE: The available stratification criteria are the organization codes, or user variables, that 

may have been assigned to the macro plot during creation or subsequent editing. For 

more information, see Creating a macro plot. 

 

6. Select either English or metric Report Units. 
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7. Select the desired analytical parameters in the Analysis Settings tab. 

 

8. In the Included Monitoring Statuses tab, deselect any monitoring statuses that you do not 

wish to include in the analysis. 

9. In the Included Macro Plots tab, deselect any macro plots that you do not wish to include 

in the analysis. 

10. In the Report Settings tab, select the appropriate summary data report. 

11. In the Analysis Settings tab: 

a. Select the desired Statistics Options. 

b. Select the appropriate Alpha Value. 

c. Select the appropriate Precision. 

d. Select the appropriate Summary Report and Report Attributes. 

e. If your analysis involves species data, select the appropriate Species. 

Running the analysis 

To run the analysis and view the resulting report or graph: 

1. Select View Report or View Graph in the Analysis menu. 
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2. To see the report and graph resulting from this analysis, see Analysis results.  

NOTE: See Analysis Output Types for examples of each analysis type. 
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Analysis results 

Report 
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Graph 
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Analysis output types 

This section contains examples of the reports and graphs generated in FFI: 

 Parametric statistical report 

 Nonparametric statistical report 

 Parametric bar chart by strata 

 Nonparametric bar chart by strata 

 Non-stratified bar chart 

Note that reports and graphs can be saved or copied. The Copy button copies the report or 

graph to the Windows clipboard for pasting into a document. The Save button saves reports to a 

Rich Text file and graphs to a high-resolution bitmap file. 

Parametric statistical reports 

 

 

The FFI parametric statistic routine uses a one-way analysis of variance procedure for a single 

attribute by two or more monitoring statuses. Analysis of variance is used to test the hypothesis 

that several means are equal. In addition to determining that differences exist among the 

means, FFI determines which means differ when the ANOVA F-test indicates a significant 

difference. A Dunnett’s pairwise multiple comparison procedure is used to compare a set of 

treatments against a single control mean. FFI uses the first monitoring status as the control and 

the subsequent sampling events as the set of treatments. 
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The FFI analysis report displays the attribute value for each plot and the absolute and percent 

difference for each value relative to the first monitoring status. The mean values, standard 

deviation, and differences in mean values are displayed at the bottom of the plot attribute 

value table. Confidence intervals are also displayed at the bottom of the plot attribute table. 

The confidence level of the interval is the alpha value selected in the main analysis form. The F-

statistic and associated P-value for the ANOVA table are displayed below the plot attribute 

table. If the F-statistic is significant FFI reports the significance value for each pairwise 

comparison at the bottom of the report.  

Nonparametric statistical reports 

 

 

The FFI nonparametric statistic routine uses a Friedman’s test for a single attribute by two or more 

sampling events. Friedman’s test is a nonparametric analysis of variance used for randomized 

block or repeated measures experimental designs. The analysis is performed by using ranks (not 

the actual data) and is useful with data that do not meet the parametric analysis of variance 

assumptions. Data is ranked within a block (plot) among treatments (sample events). Friedman’s 

analysis of variance is used to test the hypothesis that several treatments (sample events) are 

equal. In addition, a nonparametric multiple comparison test based on Friedman rank sums is 

used to compare a set of treatments against a single control mean. FFI uses the first monitoring 

status as the control and the subsequent sampling events as the set of treatments. 

The FFI analysis report displays the attribute value for each plot and the absolute and percent 

difference for each value relative to the first monitoring status. The median values and 

differences in median values are displayed at the bottom of the plot attribute value table. 

Confidence intervals are also displayed at the bottom of the plot attribute table. The 



199 
 

confidence level for the confidence interval is determined by the user in the main analysis form. 

For example, an alpha value of 0.05 will generate a 95% confidence interval. However, since 

distribution-free confidence intervals are based on integer numbers of order statistics (positions 

of ordered data around the median) the actual confidence level is slightly greater than the 

user-specified level. FFI displays the actual confidence level along with the upper and lower 

limits. The Friedman chi-square statistic and associated P-value are displayed below the plot 

attribute table. The pairwise comparisons between monitoring statuses and the first monitoring 

status are displayed at the bottom of the report.  

Parametric statistics bar chart by strata 

If you choose to stratify macro plots, FFI displays a stratified bar chart. If you select the 

Parametric option under Statistics Options, the graph displays the mean value by strata for each 

monitoring status and the confidence intervals associated with the selected alpha value. 

 

Nonparametric statistics bar chart by strata 

If you choose to stratify macro plots, FFI displays a stratified bar chart. If you select the 

Nonparametric option in the main Analysis window, the graph displays the median value by 



200 
 

strata for each monitoring status and the distribution-free confidence intervals associated with 

the selected alpha value. 
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Bar chart using non-stratified data 

If you choose to not to stratify macro plots, FFI displays a bar chart of your plot data. The values 

displayed on the chart are the values for each plot by monitoring status. 
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Species management 

FFI's Species Management component incorporates the Natural Resources Conservation Service 

(NRCS) PLANTS database, from which you can create a local species list for an administrative 

unit. The PLANTS database is searchable by symbol, scientific, and common name, and 

addresses vascular plants, mosses, liverworts, hornworts, and lichens of the U.S. and its territories. 

For further information, visit http://plants.usda.gov. 

In Species Management, you can: 

o Add from Master list - create a local species list for an administrative unit by selecting 

species symbol from the PLANTS database. 

o Add User Species - add up to 100 local species not identified in the PLANTS database, 

which can be used to represent substrates or generic classifications. 

o Add Unknowns - add placeholder species for use in the field. 

o Identify Unknown - replace an unknown species with a species from the PLANTS database 

or a known local species. 

o Replace Species in Method Data – replace the symbol for either an unknown or a known 

species after data has been collected for that species in the field without affecting the 

data. Replacement is made at the protocol level. To make a species symbol replacement 

for every instance in a database use the Global Species Replacement utility in the 

Toolbox. 

o Export - export species lists for use by other administrative units. 

o Import - import FFI species lists representing other administrative units, or import converted 

FEAT or FIREMON species lists. 

o Work with Picklists - create and manipulate picklists for field projects. 

NOTE: Do not do any species management in a field database/field computer. See FFI-Lite: 

Things not to do on a field computer. 

 

 

 

 

 

 

 

 

 

 

 

 

http://plants.usda.gov/
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The basic Species Management interface and menu options are shown below. Save, Cancel, 

and Delete functions are available from the Species Management Details window toolbar. 

 

 

Internally, FFI tracks each species with a Globally Unique Identifier (GUID). Any species that you 

add to your local species list, including user-defined species that you enter by hand, will have 

the same GUID across all of your FFI databases. As you record field data, species observations 

will be tied to the species list using the GUID. This means that edits in the species list will carry over 

to all existing data. 

  

Creating a local species list 

You can create a new local species list for your administrative unit by: 

o Adding species from the master list 

o Entering user species from scratch 
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Adding species from the master list 

To build a local species list by selecting entries from the NRCS PLANTS database: 

1. Click on the Species Management navigation bar and the Species Management Details 

window opens. 

2. Select Add from Master list in the Species menu. 

 

 

3. The Local Species Creator form opens. You can select species either by scrolling through 

the complete PLANTS list or by filtering the complete list. 
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4. To select species by scrolling, scroll through the list and select plants of interest. Use the 

CTRL key to select more than one species. When you are done, click Add to add the 

selected species to your species list. 

 

NOTE: Click on any column heading to order that column alphabetically. Drag and drop 

column headings to change the order in which the columns appear. 
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5. To add species by filtering, enter your filter criteria - scientific or common name, plant 

symbol, or TSN. In this example, camassia is used with the wildcard %. When you are ready, 

click Apply Filter. 

NOTE: The PLANTS database contains a series of codes, prefaced with the number 2, for 

generic species and substrates. To locate and add a generic or substrate, see  

 

NOTE: The PLANTS database contains approximately 90,000 records. Pick your filter criteria 

with care, and be prepared to wait a moment or two for the command to be executed. 

6. The resulting filtered list, shown below, contains all of the camassia species in the PLANTS 

database. Make your selections by scrolling through the filtered list. Use the CTRL key to 

select more than one entry. 
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7. Click Add to add your selections to the local list. 

 

 

The resulting local species list appears in the central pane of the Species Management window, 

as shown here. You can: 

o Scroll horizontally through the list to view all fields. 

o Drag and drop column headings to rearrange the list to suit your needs. 

o Click any entry to display Identity and Properties data for that species. 
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NOTE: The Local Characteristics data can be edited. Make any necessary changes to the 

data to reflect local conditions, and click Save. 

Locating and adding generics and substrates 

The PLANTS database contains a set of symbols and descriptive common names for generic 

substrates and plant categories such as ‘deciduous tree’ or ‘herbaceous vine’ that are useful in 

survey, monitoring, and inventory work. These symbols and categories are widely used by a 

number of federal agencies. 

NOTE: See Adding user species for incorporating your own generic substrates and plants to 

the species list. 

To locate and add a generic species or substrate from the PLANTS database to your species list: 

1. Enter 2% as the Symbol search criterion. 

2. Enter any other search criteria to focus the search. In this example, grass% is being used 

as a search criteria. 

3. Scroll through the resulting list to select the desired symbol. 

 

4. Click Add & Close to add the selected symbol to the local species list. 
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Adding user species 

You can easily add species that occur locally but that are not found in the PLANTS master list. 

Also, you can create species that represent substrates, such as rocky soils, or you can create 

generic, non-taxonomic identifiers, like “fern”. 

NOTE: The PLANTS database contains a comprehensive catalog of generic substrates and 

plants that may be useful to you. See Locating and adding generics and substrates for 

incorporating PLANTS database generics to the species list. 

 To add a user species to your local species list: 

1. Open the Species Management window. 

2. Select Add User Species in the Species menu. A new blank row is added at the end of the 

local list. 

 

3. In the Species Details - Identity box, replace the default XXXX code with a code that is 

meaningful to you. 

NOTE: Check the new code that you want to assign against the codes in the PLANTS 

database to ensure that, for example, a code you assign does not already represent a 

known plant in the database. 
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4. In the right-hand pane of the Species Management window, add as much information as 

possible to describe the species or identifier. (Be sure to scroll all the way down the pane 

to complete the Description and Comment text fields.) 

 In this example, the code SANS, representing bare sandy soils, does not occur in the PLANTS 

database. 

 

5. Click Save in the Species Management Details window toolbar. In this example, the new 

species SANS appears at the bottom of the species list. 

NOTE: Click any column heading to order that column alphabetically. Drag and drop column 

headings to change the order in which the columns appear. 

 

Working with unknowns 

An unknown is a placeholder that can be used to represent a species that you did not expect 

to encounter or cannot identify, and that is therefore not included in your species list. FFI lets you 

easily create and then replace unknowns.  

If using multiple field crews assign a range of unknowns to each crew. Doing so will avoid issues 

when identifying unknown later on. For example, if you create 10 unknown species codes assign 

unknowns 1- 5 to one field crew and unknown 6 - 10 to the other field crew.  
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Adding unknowns to the local species list 

You can add up to 999 unknown species to your species list to accommodate the needs of your 

field work. To add unknowns to the local species list: 

1. In the Species Management window, select Add Unknowns in the Species  

 

2. The Add Unknowns box opens. In the box, stipulate the first number to be used, and 

stipulate how many unknowns you wish to add to the local list. In this example, 10 

unknowns will be added, and the first one will be numbered 2. Click OK. 

               

 



212 
 

3. Ten unknown species are added to the local species list, as shown below. The first 

unknown is coded in the default numbering format as UNK_002. UNK_002 is shown as the 

Local Symbol in the Codes box in Species Details, and refers to the local plant code.  

NOTE: The User Added box is automatically checked. 

  

NOTE: You can either accept the default numbering format or use your own identification 

code for unknowns. Be aware that if you accept the default, the symbol may be identical to 

that of unknowns added to other administrative unit species lists. 

4. Edit the symbol and enter any information you have for the unknown species in the right-

hand pane of the Species Management Details window. Scroll down through the pane to 

see all available information fields. 

5. When you are done, click Save to save your work. 

Identifying unknowns 

When you are able to identify an unknown species, you can easily replace it with the correct 

species. 

1. In the Species Management Details window, highlight the unknown you wish to replace. 
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2. Select Identify Unknown in the Species menu. 

 

 

3. The Identify Unknown window opens. By filtering or scrolling, locate and highlight the 

correct species. Click Apply. 
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4. The unknown is replaced with the correct species. Note that the Species Details in the 

right-hand pane are updated to reflect the correct species. 

 

 

Replacing species in method data 

If you collect data for a species in the field but later determine that the species was incorrectly 

identified, you can replace it with the correct species from your local species list.  

CAUTION: This procedure involves risk to existing data. Try to use the Identifying Unknowns 

function if possible. If you must use the Replace Species in Method Data procedure, be sure 

to carefully limit the scope of the replacement. 

The following procedure will replace the name of the misidentified species only. All data 

collected during sampling remains intact. 

NOTE: If you want to change species codes in an entire Administrative unit see Administrative 

Unit Species Replacement in the Toolbox section. 

To replace an unknown for which you have collected field data (If the correct species is not 

already on your local species list, add it before you follow this procedure): 

1. Back up your database. 

2. In the Species Management Details window, select the species to be replaced. 
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3. Select Replace Species in Method Data from the Species menu. 

 

 

4.  The Species Replacement window opens. Enter the appropriate criteria: 

o In the Select Your Method list, select the method for which data needs to be 

replaced. In this example Cover Frequency–metric is selected. 

o In the Filter Visits tree view, select the applicable project unit, macro plot, and 

sample event. In this example the 2003/09/08 sample event for TESTFOREST8 is 

selected. 

NOTE: If you select the Project Unit, all sample events within that project will be 

changed. If you select the Macro Plot, all sample events in that plot will be updated. To 

update several, but not all, sample events within a macro plot, you will need to update 

each sample event individually. 

o By scrolling or filtering, select the species to be replaced (the Old Species; 

LOCAL003 in this example) and the correct species (the New Species; in this 

example, a member of the helianthus family). 
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5.  Click Apply. 

6.  You will be given the option to save a copy of your data. Select Yes or No depending on 

your level of comfort about the proposed change. If you select Yes enter a file name, select a 

location and click Save. 

 

 

 

7.  If the species to be changed was found in the selected sample event(s) and protocol the 

dialog box will say Replace complete. If the species was not found in the selected sample 

event(s) and protocol the dialog box will report No species found. Click OK to close the 

dialog box. 
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Exporting and importing species lists 

FFI species lists and their associated picklists can be exported and imported as *.xml files for use 

in other administrative units.  

o You can import a species list from another administrative unit to apply to your own 

administrative unit, even if your own species list already exists. 

o If another administrative unit contains similar species to your administrative unit, you can 

save time and effort by importing that unit's existing local species list instead of creating a 

new list from scratch. After import, you can edit the list as needed. 

o When you export and import a species list, all picklists associated with the administrative 

unit are also exported and imported. You can edit or delete the imported picklists. 

o Picklists are also matched by species symbol, so if your local list already includes a 

particular species that is included in an imported picklist, the species will appear. 

o If you already have a picklist in your administrative unit that has the same name as a 

picklist in the file that you are importing, your existing list will be retained but you will have 

two picklists with the same name. You can change the name of picklists in Species 

Management, if desired.  

Exporting a species list 

You can export your local species list as an *.xml file for use by another administrative unit. The 

species list will be exported along with all associated picklists. 

To export a species list: 

1. In the main Species Management window, select Export in the Species menu. 
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2. In the Save As window, assign a name for the export file, or accept the default name. 

Click Save. 

 

3. In the Export Species window, click OK. 
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Importing a species list 

An administrative unit's species lists and picklists can be imported into another administrative 

unit. To import a species list with its associated picklists: In the main Species Management 

window, select Import in the Species menu. 

 

2. In the Open file window, select the *.xml file to be imported and click Open to import the 

file. 
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3. FFI adds the unique species to the local species list and adds the picklists. “Unique 

species” are defined as species that have the same PLANTS species code and identical 

species properties (e.g., local characteristics, user variables, description and comments). 

The species properties for each species record can be viewed in the right pane in Species 

Management. In this example, 172 species from the PLANTS database and 13 user-added 

species were added to the local species list. Five picklists were added. Click OK in the 

Species Import Results window to confirm this information. 

 

 

Handling of species symbols/item codes during import 

The species import function compares the species symbols/item codes (NRCS symbol, user 

species code or “unknown” code) in the species list import file and in the local species list in the 

master database. If a species/code is in the import file but not in the local species list then it is 

imported as in the import file. If a symbol/code in the import file is the same as one already in the 

local species list (case sensitive) then all the species Properties are compared (Lifeform, 

Lifecycle, Invasive, etc.). If there are no differences in the Properties then the symbol/code in the 

imported file is given the same GUID as the matching symbol/code in the local species list in 

master database. If the Properties for a symbol/code in the import file and local species list are 

different then the species code, properties and GUID are imported as in the import file resulting 

in two instances of the same species symbol/user code in the local species list. You can 

consolidate species codes using the Species Replacement tool in the Toolbox.  

NOTE: The logic described above is different than when importing method attribute data. 

 

Using picklists 

A picklist is a subset of the local species list that represents species specifically known to inhabit a 

project unit or species of a specific lifeform. You can develop picklists for specific sample events 

that you can download onto a PDA or print and use in the field. FFI lets you easily create, 

manipulate, and delete picklists. 
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To reach the picklist functions, click the Edit Picklists radio button in the Species Management 

window. The Picklists menu becomes available. 

 

 

The available picklist functions are: 

 

o Creating a new picklist 

o Duplicating a picklist 

o Editing a picklist 

o Deleting a picklist 

o Printing picklists or species reports 
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Creating a new picklist 

Once you have created your local species list, you can create picklists to more specifically 

describe the species present in a project unit to support specific sample events. 

To create a new picklist: 

1. In the Species Management window, click the Edit Picklists radio button, as shown. The 

Picklists menu will become available. 

 

2. Select New in the Picklists menu. 
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3. The Picklist properties form opens. Add a Name and Description for the new picklist. If you 

wish, add any user variables to further describe the list or the area to which the list 

pertains. Click Save & Close. 

 

 

Populating a new picklist 

After you have created the new picklist, the Species Assignments window opens. To populate 

the list: 

1. Select, by filtering or scrolling through the Available Species list, the plants to be added to 

the new picklist. In this example, the Available Species list was filtered with the wildcard 

camas%. 

2. Click the right-arrow button to add the species to the Assigned Species list or click the left-

arrow to remove species. 

 

3. Continue selecting and adding species until the new picklist is complete. 

4. Click Save. 
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NOTE: The new picklist will be associated only with the administrative unit in which it was 

created. To use a picklist in another administrative unit, see Importing or exporting lists. 

NOTE: Click the Edit Local Species radio button go back to your local species list. 

 

 

Duplicating a picklist 

In some cases, it may be more practical to duplicate and modify an existing picklist than create 

a new one for a sample event. To duplicate a picklist: 

1. In the Species Management window, click the Edit Picklists radio button. 

2. Select the picklist to be duplicated. 

3. In the Picklists menu, select Duplicate. Note that the menu obscures the list of available 

picklists. 

 

4.  The Picklist properties form opens. Add a new Name and Description for the duplicate 

picklist. If you wish, add any user variables to further describe the list or the area to which 

the list pertains. Click Save & Close. 

 

5.  In the Unsaved Changes box, click Yes. 

6. In the Species Assignment window, modify the list to meet your requirements. Delete 

assigned species or add additional species using the right or left arrow buttons. 

7. Click Save when finished. 
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Editing picklist properties 

To edit the name and description for a picklist: 

1. In the Species Management window, click the Edit Picklists radio button. 

2. Select the picklist to be edited. 

3. In the Picklists menu, select Edit. The Picklist Properties window opens. 

 

4. Make any necessary changes. Click Save & Close when finished. 

Updating a picklist 

If necessary, you can add or delete species from a picklist. To update a picklist: 

1. In the Species Management window, click the Edit Picklists radio button. 

2. Select the picklist to be updated. 

3. In the Species Assignment window, delete assigned species or add additional species 

using the right or left arrow buttons. 

4. Click Save when finished. 

Deleting a picklist 

Picklists can be deleted once they are no longer needed. To delete a picklist: 

1. In the Species Management window, click the Edit Picklists radio button. 

2. Select the picklist to be deleted. 
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3. In the Picklists menu, select Delete. Note that the menu obscures the list of available 

picklists. 

 

4. In the Confirm Delete window, click Yes. 

 

 

Editing a species list 

Updating local information  

To update local information for a species: 

1. In the Species Management window, select the species to be edited. 

2. Edit the Local Characteristics information as appropriate. 

3. Click Save. 
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Removing a species from the species list 

To remove a species from the species list: 

1. In the Species Management Details window, select the species to be deleted. 

NOTE: Species cannot be deleted from the local species list if they have been used in data 

entry. 

 

2. Click Delete to remove the entry from the list. Confirm the deletion in the pop-up window. 

3. Click Save. 

Printing species reports 

You can print your complete local species report or print an individual picklist report.  

To create a report of the local species list: 

1. In the Species Management window, click the Edit Local Species radio button. 
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2. Select Species > Local Species Report 

 

 

3. After the report is displayed print the report or save as an Excel, PDF or Word file to be 

printed later. 
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To create a report of a picklist 

1. In the Species Management window, click the Edit Picklist radio button. 

2. Highlight the picklist you wish to create report for and select Picklists > Picklist report. 

  

 

2. 3. After the report is displayed print the report or save as an Excel, PDF or Word file to be 

printed later. 
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Toolbox 

The FFI Toolbox includes these functions: 

o External Data Analysis provides a link between FFI and other analysis programs by 

supporting import of external files for analysis. 

o Protocol Management lets you retire, unretire, or delete protocols that you do not need 

for your monitoring programs. 

o Administrative Unit Species Replacement is used to replace all instances of a local species 

symbol or user symbol entered in any protocol in an entire database. 

o Calculate CBI Summary Statistics simply refreshes the CBI summary fields in all instances of 

the CBI protocol in a database. 

 

  

External data analysis 

The External data analysis function in the Toolbox is used to import data contained in Excel 

spreadsheets for statistical analysis within FFI. The types of analyses that can be run are the same 

as those that are described in the Data analysis section of the User Guide. 
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Format requirements for imported spreadsheets are outlined in Spreadsheet Requirements.  

 

 

Data import and analysis 

To import an Excel spreadsheet and analyze the imported data: 

1. In the Toolbox Details window, select File > Open. 
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2. Navigate to the desired Excel file and click Open. FFI imports the spreadsheet and displays 

its name in the File Name box. After you select the desired Worksheet, FFI populates the 

Excel Spreadsheet Data window. 

 

NOTE: Data cannot be edited in this view. To make changes to your data, edit the Excel 

spreadsheet and then import it again. 

3. Using the dropdown lists, populate each field in the Analysis Variables window. The Strata 

field is optional, but all other fields are mandatory. 

4. Populate the Report Headers text boxes. These fields will be used to fill in the header rows 

in the analysis report and graphs. 
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5. Select the desired Statistics Options. For information about these options, see Performing 

analyses. 
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6. To run the analysis and view the resulting report or graph, select View Report or View 

Graph in the Analysis menu. 

 

To see the report and graph resulting from this analysis, see Analysis output. Reports and graphs 

can be saved and copied. 

Spreadsheet requirements 

The sample spreadsheet below identifies the minimum requirements for an Excel spreadsheet to 

be imported into the FFI analysis tool. Each row in the spreadsheet must contain: 

o Monitoring status order (column B), as an integer. 

o Monitoring status label (column C). 

o Macro plot name (column D). 

o At least one data attribute of numeric data (column E). 
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As shown, a strata name (column A) can also be included. 

Each individual worksheet in the spreadsheet should be named to reflect the name of the 

protocol for which data is being analyzed. The name of the worksheet in the sample below is 

TreeDensity; the data attribute (column E) is Trees per Acre. 
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Analysis output 

The sample report and graph shown here were generated using the data described in Data 

import and analysis. Note that reports and graphs can be saved and copied directly from the 

Analysis Report toolbar. 
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Protocol management 

The Protocol Management function allows you to retire or delete protocols that are not needed 

for your programs.  

o Retire a protocol for which data exists, but which you do not plan to use again. All data 

attached to the protocol will be maintained safely. The protocol can be Unretired should 

it be needed again in the future. All protocols that are retired are automatically listed in 

the Unretire Protocol window. 

o Delete a protocol that is not required for your monitoring program. Should you need it in 

the future, you can re-import it into FFI. 

NOTE: When you retire or delete a protocol, all methods attached to it will be unavailable 

until you un-retire or re-import the protocol into FFI. 
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In the example above, the protocol Disturbance History was retired. It is longer available for 

assignment in the Sample Event creator in Project Management, but all data attached to it is 

retained. To un-retire Disturbance History, click Unretire. 

  

Using Protocol Management 

To use Protocol Management: 

1. Using the dropdown lists, select the protocol to be Retired, Unretired, or Deleted. 

2. Click the appropriate button. 
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3. If data is attached to the protocol, it cannot be deleted, as indicated here. Click OK to 

acknowledge the message. Create a Sample Event Report to determine the sample 

events protocols are assigned to. 

 

 

Administrative Unit Species Replacement 

Administrative Unit Species Replacement is available only in FFI and is used to change every 

instance of a species symbol in an administrative unit. The primary function is for updating 

species symbols when a new version of the master species list is added in FFI. The species 

replacement utility is more powerful than the Replace Species in Method Data utility in Species 

Management. It is also more perilous if it is not used carefully because the changes are wide 

ranging.  You should create a backup database before making any administrative unit species 

replacement(s).  

Replacing a species symbol 

New species symbols that will be replacing old ones need to be added to the local species. See 

Creating a Local Species List for more information. 

The symbol/species in the right pane will replace the symbol/species in the left pane. To replace 

a species enter in a Symbol, TSN, Scientific name or Common name into the appropriate fields 

and click Apply Filter. If more than one record is returned, highlight the desired record and click 

Apply.  
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If you are certain you want to continue, click OK.  

Create a copy of the database if desired.  

 

 

The window will indicate the number of species changes made or will report that no 

replacements were made. Click OK to close the window.  

 

 

 

Calculate CBI Summary Statistics 

In rare cases the summary statistics for the CBI protocol are not automatically calculated in Data 

Entry and Edit. Click the Calculate button to refresh the summary calculation for all instances of 

the CBI protocol in the database. 
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Additional information 

This section contains supplemental information, tables, and links that may be helpful for FEAT and 

FIREMON users. 

o Information on administrative units, project units, and macro plots. 

o Comparison of FFI, FEAT, FIREMON, and FMH program elements. 

o Comparison of FFI, FEAT, FIREMON, and FMH sampling protocols. 

o Description of FFI protocols. 

Administrative units, project units, and macro plots 

FFI uses a unique set of terms derived from FEAT and FIREMON to describe land areas and 

monitoring events. The basic units are: 

o Administrative unit – An administrative unit is an area that is managed as an individual 

entity, such as a park, forested area, county or city, hunting unit, watershed study area, or 

other discrete land area. In FFI, an administrative unit corresponds to an SQL Server 

database. Although multiple administrative units can reside on a computer, there is no 

communication between them. All analysis takes place within an individual administrative 

unit, and GIS data is managed and analyzed at the administrative unit level. An 

administrative unit is comparable to the landunit used in FEAT. 

o Project unit – a project unit (equivalent to the FEAT monitoring unit) is a division of the 

entire sample population of an administrative unit. Project units are usually defined to 

represent an area on the ground. For example, a project unit could consist of "all areas in 

the Ponderosa vegetation type between 1500 and 2000 meters above sea level, more 

than 500 meters from the nearest road, and more than 1000 meters from the nearest 

stream." However, project units are not required to have any spatial meaning, but can be 

defined for temporary administrative or analysis purposes. They provide a means to 

functionally group macro plots for management and analysis. Project units can be 

defined so that they overlap spatially, and macro plots can be associated with multiple 

project units. Use FFI Spatial module to spatially define a project unit.  

o Macro plot – a macro plot is a distinct place on the face of the earth that can be 

sampled one or more times. A macro plot established within an administrative unit defines 

the location of the primary sample. The plot is used to establish and define permanent 

sampling sites as well as sites that contain multiple subsamples and sample types. 

Examples of macro plots might include: 

 A forest plot with four quadrants, two veg lines, ten herb frames, and four fuels lines. 

 A CBI plot with an understory circle and an overstory circle. 

o Candidate site – A geographic point within a project unit that has been identified as a 

potential macro plot. 

o Sample event -  

To understand other differences between terms used in FFI and terminology used in FEAT and 

FIREMON, see the nomenclature table. 
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About the FFI protocols 

Each FFI protocol is based on FIREMON and/or FEAT/FMH sampling procedures and created 

within Protocol Manager. A description of the FIREMON procedures can be found on the 

FIREMON pages at http://www.frames.gov/firemon. A description of the FEAT and FMH 

procedures can be found at http://www.nps.gov/fire/wildland-fire/resources/documents/fire-

effects-monitoring-handbook.pdf. 

Most FFI protocols consist of only one sampling method. Some, like the Tree Data protocol, 

however, combine three distinct sample methods within a single protocol. For quick reference, 

all FFI protocols are briefly summarized below. 

ARS – Cover Points 

This protocol is a modification of the line-point intercept method described in the USDA 

Agricultural Research Service (ARS), Monitoring Manual, Vol. I (Herrick et al. 2005). The line-point 

intercept protocol in general is described further in Measuring and Monitoring Plant Population 

(Elzinga et al. 1998) and FIREMON: Fire effects monitoring and inventory system (Lutes et al. 

2006). Sampling is generally accomplished along a series of parallel transects. Plot size, number 

of transects and number of points per transect are determined by the user based on objectives, 

vegetation and resources. One suggested plot design for line-point intercept sampling has five 

parallel 50 meter transects set 10 meters apart. Sample points are at 1 meter intervals along 

each transect for a total of 250 sample points per plot. 

 

The ARS Cover Points protocol in FFI is less tedious to use than the standard FFI Cover Points 

protocol but is limited to a maximum of six species hits and one soil surface hit per sample point, 

compared to an unlimited number of species hits per sample point in the standard Cover Points 

protocol. Data collection is more intensive with the ARS Cover Points protocol that with the 

standard FFI Cover Points by Transect protocol but that protocol does not allow the species 

sampled at each point to be tracked through time like the ARS Cover Points protocol does.  

For more information the ARS Cover Points Protocol Overview posted on the Other Documents 

page on the FFI FRAMES website. 

Biomass - Fuels 

The Biomass-Fuels protocol is used to record actual measured weights of fuel on a macro plot 

using laboratory analysis. Biomass may also be available from legacy data or from photographic 

guides that incorporate biomass data as part of their fuel load calculations. Examples of 

photographic guides developed using biomass data are the Photo Series, Photoload, and Photo 

Guides published by the U.S. Forest Service. These photographic guides cover many ecosystems 

and are available for many parts of the U.S. Newer versions published by the USFS. Pacific 

Northwest Research Station includes biomass data for several different fuel attributes. Attribute 

biomass estimates from photographic publications are entered into the FFI biomass form in the 

same way as actual measured weights. Biomass using measured weights is obtained from field 

plots using a three-step process that includes collecting and separating all fuels from a macro 

plot, drying the collected samples in an oven, and weighing the dried samples with an 

analytical scale. The fuels are usually separated into size classes as they are gathered in the field, 

then dried and weighed by the same sampled size classes. The resulting weights for each size 

class are stored in the Fuel Biomass protocol in FFI. If desired, the biomass data may be 

http://www.frames.gov/firemon
http://www.nps.gov/fire/wildland-fire/resources/documents/fire-effects-monitoring-handbook.pdf
http://www.nps.gov/fire/wildland-fire/resources/documents/fire-effects-monitoring-handbook.pdf
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combined with other plot-level fuels data to provide an extensive description of the fuelbed at 

the macro plot scale.  

Biomass - Plants 

The Biomass-Plants protocol is used to record actual measured weights of each type of plant 

material on a macro plot. Biomass is a very accurate measure of plant cover, but it is also a 

destructive and time consuming sampling method. Biomass is obtained by clipping all plant 

material from each plot and separating it into the groups of interest, such as lifeform, family, 

species, or any other grouping appropriate to study objectives. The material for each group is 

separated into bags in the field. It is then taken back to a laboratory, dried in ovens, and the dry 

material is weighed by sampling group using an analytical scale. The Plant Biomass protocol in 

FFI is used to enter the weights of each sampled group. If the samples are weighed prior to 

drying, the pre-drying weight is entered under “Green Wt” in FFI. The weight after drying should 

be recorded under “Dry Wt.”  

CBI 

CBI is the Composite Burn Index sample protocol. The CBI protocol is used to quantify, rate, and 

track the burn effects on the substrate or each vegetation layer after a fire and to correlate 

those effects with changes observed in the moderate-resolution Landsat Thematic Mapper. Plot 

sampling is used to calibrate and validate remote sensing results and to relate radiometric 

change to actual fire effects on the ground. Because the fire effects are correlated with Landsat 

images, CBI plots can be rather large (>100 ft or 30 m wide). CBI is most effective when all 

vegetation layers are sampled in the field and then compared with the Landsat Imagery. 

However, the protocol can also be used as a stand-alone tool without remote sensing data to 

describe and evaluate localized burn sites for a variety of purposes.  

For CBI, burned percentages are visually estimated for the substrate elements and for the 

different size classes (layers) of vegetation and recorded on the CBI protocol form. The substrate 

and vegetation layers are evaluated by attribute (litter, duff, richness cover, etc.). Each attribute 

has an associated burn effect that the observer evaluates (e.g., unchanged, 50% loss, etc). The 

loss percentages recorded on the form are used to calculate a burn severity rating within FFI for 

each vegetation layer and for the entire plot. The greater the CBI number, the greater the burn 

severity on the macro plot. For more information on this protocol and what the ratings mean, see 

the online FIREMON user manual (Landscape Assessment) on FRAMES.  

Cover - Line Intercept 

The Line Intercept protocol is used to assess changes in plant species cover over time on a 

macro plot. It uses a permanently-marked base line for sampling the within-stand variation and 

quantifying statistically valid changes in plant species cover and height over time. The protocol 

is applicable for most forest and rangeland communities and is one of the fastest ways to 

estimate percent cover in areas with dense cover or tall trees. It is especially useful when users 

need to quantify shrub cover greater than 3 feet (1 m) tall because ocular estimation of cover 

for large shrubs or dense vegetation is difficult using most other methods. The Line Intercept 

protocol can also be used in conjunction with cover-frequency transects when vegetation over 

3 feet (1 m) exists or to calibrate ocular estimates of shrub cover with the Species Composition 

protocol (see description). 
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 The Line Intercept protocol uses a tape measure stretched between two permanently-marked 

end points either on the ground or at a specified height above the vegetation canopy, 

depending on the purpose of the sampling. Vegetation cover is determined by calculating how 

much of the measuring tape is covered with plant material. To use this protocol, the stop and 

start points for each species’ foliage or substrate attributes are recorded along the measuring 

tape. For example, if a small tree starts at 10.0 ft along the tape and ends at 15.0 ft, it covers an 

interval of 5 ft. If a single grass species starts at 25 ft and ends at 27.5 ft, it covers an interval of 2.5 

ft. The start and stop points are recorded in the cover- line intercept form. The amount of tape 

that a specimen covers is referred to as the interval or intercept and is also recorded on the line 

intercept form. The percent cover of each species is the total of all intercepts for the species 

divided by the line length. In addition to cover intervals, a size class is recorded on the form to 

indicate how tall the particular plant is. Height estimates should only be made for the part of the 

plant that is intercepted by the tape, not the whole plant.  

Cover - Ocular Macro Plot (Species Composition) 

The Species Composition protocol uses a combination of ocular estimates for canopy cover and 

actual measurements of height to sample each plant species on a macro plot. It is relatively fast 

and efficient to conduct in the field and is suited for sampling a wide variety of vegetation 

types. It is especially useful in plant communities with tall shrubs or trees to inventory large areas 

when there are few examiners available to help with sampling. Like other sampling methods, this 

protocol is useful for describing a stand or plant community and documenting important 

changes over time. However, it does not quantify the variability within a stand and cannot be 

used to detect statistically significant changes over time. The data that are required for this 

protocol are species name, status, canopy cover, and height. Canopy cover is an ocular 

estimate of the area of ground covered by the vertical projection of the outermost perimeter of 

the natural spread of the plant’s foliage. Height measurements are made either by using a size 

class or by measuring each specimen.  

Cover - Points 

The Point Cover protocol is used to assess changes in plant species cover or ground cover for a 

macro plot. It is primarily suited for vegetation types less than 3 feet (1 m) in height and 

particularly useful for recording or tracking changes in ground cover. The protocol uses a narrow 

diameter pole that is lowered to the ground at systematic intervals (usually every foot or meter) 

along a measuring tape. Plant species or ground-cover that touches the pole are recorded as 

'hits' along the measuring tape/transect. The “hits” are the samples in this protocol and they are 

recorded by tape location, species, and height. The samples are statistically valid 

representations of the stand variation and of the amount of change in cover and height over 

time when they are reassessed on permanently-marked transects. Canopy cover is calculated 

by dividing the number of 'hits' for each plant species or ground cover class by the total number 

of points along a transect.  

Cover - Points by Transect 

Point Cover transect data is collected in exactly the same way as the Cover-Points data and it is 

used for the same types of sampling (see section above). The only difference is that the points 

are not recorded individually in Cover – Points by Transect. The “hits” on each species are 

summarized in the field and each species is entered only once on the form. If there are different 
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size classes for the species, they may be entered multiple times; but, in general, this protocol uses 

a summary approach to record and analyze the hits.  

Cover/Frequency (FIREMON and Daubenmire cover classes) 

The Cover / Frequency protocol is used to assess changes in plant species cover and frequency 

for a macro plot. This protocol uses quadrats (small sample frames) to sample within-stand 

variation and to statistically quantify changes in plant species cover, height, and frequency over 

time. Frame sizes may vary depending on the objectives of the study and the method used. 

Since it is difficult to estimate cover in quadrats for larger plants, this protocol is primarily suited 

for grasses, forbs, and shrubs less than 3 feet (1 m) in height.  

For this protocol, quadrats are placed systematically along randomly located transects. Canopy 

cover is assessed within each quadrat by visually estimating the percent of the quadrat that is 

occupied by the vertical projection of each species (or each substrate element) onto the 

ground. Species frequency is recorded as the number of times that it occurs within a given 

number of quadrats. Frequency is typically recorded for plant species that are rooted within the 

quadrat. 

Within the cover frequency protocol, there are two different scales available for visually 

estimating plant cover. The first is the FIREMON scale, which uses 13 intervals to span cover 

estimates of 0 to 100%. The second is the Daubenmire scale (from R. Daubenmire, 1959, A 

canopy coverage method. Northwest Science 33: 43-64), which uses 6 intervals. Do not mix 

scales. Rather select the one set that meets your study objectives most closely and use it 

exclusively within a sample event.  

Density - Belts 

The Density– Belts protocol is used to assess changes in plant species density and height for a 

macro plot. The protocol is most commonly used to sample shrubs and trees. Belt transects have 

a length and a width and are usually much larger than the density-quadrat frames. Like the 

quadrat frames, belt transects need to be randomly located on the landscape to give 

statistically valid results for cover or frequency over time. Sampling within the belt boundaries is 

done by counting the number of individual plants within each species. The total number of 

individuals for each species is recorded along with a height class. Density is calculated as the 

number of individuals per unit area. The accuracy of the density estimate depends largely on 

the size and shape of the belt, and the optimum belt size and shape depends on the plant 

species distribution (see discussion on shape and boundary problems associated with belts and 

quadrats in the FIREMON users guide. 

To estimate tree density, we recommend using the Tree sampling protocols in FFI rather than the 

density-belt approach.  

Density - Quadrats 

The Density–Quadrats protocol is used to assess changes in species density and plant height for 

a macro plot. The protocol generally requires a sample frame that is sized appropriately to the 

lifeform of interest and that is placed randomly on the landscape so that the sampling will be 

statistically valid. Density - Quadrats is primarily suited for grasses and forbs where individual 

plants or stems can be distinguished, while longer, wider belt transects are most appropriate for 

sampling shrubs and trees. The numbers of individuals for each plant species within each 
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quadrat are counted and the count for each quadrat is recorded. Density is calculated as the 

number of individuals per unit area. 

Disturbance History 

The Disturbance History protocol provides a means of tracking disturbances on a macro plot. 

Although the protocol is purely descriptive, it can be extremely useful to relate ecologic effects 

and disturbance factors during monitoring. The protocol contains 31 causal agents that can be 

used to describe disturbance on each macro plot. These agents include a range of factors, from 

the introduction of exotic species to clear-cutting. The duration of each disturbance event can 

be recorded using start and stop dates if they are known. The effects caused by each agent 

and the relative amount of damage they cause can be summarized within the protocol by 

using the “change” field or by using one or more of the three user variables provided.  

FCCS 

The Fire Characteristic Classification System (FCCS) was developed by the Forest Service Pacific 

Northwest Research Station as a way to characterize all of the combustible components of a 

fuelbed. The FCCS fuelbeds are linked to a classification system that uses seven variables. 

Directions for sampling the variables are provided in the FCCS user guide. 

FFI stores data for the seven FCCS variables in a special table. The values for these variables can 

be entered directly into FCCS software to classify a fuel bed or used to describe an entirely new 

FCCS fuelbed. To describe a new fuel bed, the user samples the fuelbed (vegetation, down 

woody material, trees, etc.) using the FFI sampling protocols and records values for the seven 

variables. The fuelbed description is then linked to the classification variables in FCCS to define a 

custom FCCS fuelbed. Biomass of some fuelbed strata can be calculated using FFI summary 

reports (e.g., down woody material, duff, litter, etc.). Other biomass estimates will need to be 

calculated outside FFI (e.g., allometric equations to calculate shrub biomass from cover and 

height measurements).  

Fire Behavior 

The Fire Behavior protocol is used to describe the behavior of a particular fire and the ambient 

weather conditions that influence the fire’s behavior. This protocol is not plot based. Users collect 

fire behavior data by fire event and time-date, instead of collecting data at one specific macro 

plot location. If users want to describe fire characteristics at a particular macro plot, they should 

use the Plot Description protocol and fill in the information on Flame Length, Spread Rate, and 

Fire Behavior Picture fields at each specific location (see below). The FireID and Fire Date fields in 

the Plot Description protocol link a macro plot’s specific fire behavior information and physical 

and biological characteristics to the broader fire-event information described within the Fire 

Behavior protocol. The data that should be collected for the Fire Behavior protocol includes 

information on location, burning conditions, fire behavior, and fuel moistures. To adequately 

describe a fire event, all fields within the protocol form should be completed.  

Fuel Load 

Fuel Load is a line transect technique that estimates loadings of downed dead woody in a 

variety of size classes (Brown 1979). Litter and duff depths will be estimated along the transect 

using methods outlined in Keane (1999). The FL methods are used to sample dead and down 
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woody debris, estimate the depth of the duff/litter profile, and estimate the proportion of litter in 

the profile. Down woody debris is sampled using the line transect method (Brown, 1974). Pieces 

are tallied in the standard fire size classes: 1-hour (0-0.635 cm), 10-hour (0.635-2.54 cm), and 100-

hour (2.54-7.62 cm). Pieces greater than 7.62 cm are recorded by diameter and decay class. 

Duff and litter depth are measured at two points along each of 25-meter line transect segments. 

Litter depth is estimated as a proportion of total duff and litter depth. 

Plot Description 

The Plot Description protocol is used to describe general macro plot characteristics that provide 

an ecological context for data analyses. Within this protocol, many of the plot characteristics 

that are important to analyzing relationships or fire behavior data are described. This protocol 

provides the general ecological data that can be used to stratify or aggregate fire monitoring 

results. The data collected in the plot description characterize the topographical setting, 

geographic reference point, general plant composition and cover, ground cover, fuels, and 

soils information for a macro plot. Comment fields also allow for documentation of plot 

conditions and location using photos and notes. None of the data fields are required in the plot 

description form, but all should be filled out at least once for each macro plot to give the 

sampling events ecological context.  

Post-Burn Severity 

The Post Burn Severity protocol is used to assess changes in vegetation and substrate after a fire 

and is most useful to determine how much of an area has been lightly burned versus scorched 

or unburned. Essentially, it is a point-transect method for sampling burn severity. The samples are 

statistically valid representations of both the stand variation and the effect that the burn has on 

the vegetation and the substrate. 

For the Post Burn Severity protocol, a transect line is laid out for a specified distance. At 

systematic intervals along the line, the vegetation and substrate are examined. Each point is 

evaluated for burn severity and assigned a corresponding code value (1= heavily burned, 5 = 

unburned; 0 = not applicable, -1 = not assessed). The location on the tape and the severity 

codes for both vegetation and substrate are recorded within this protocol.  

Rare Plant Species 

The Rare Plant Species protocol is used to assess changes in uncommon, perennial plant species 

when other monitoring methods are not effective. Individual plants are identified and monitored 

for statistical changes in plant survivorship, growth, and reproduction over time. This protocol is 

primarily used for Threatened and Endangered species and uncommon grass, forb, shrub, and 

tree species of special interest.  

In this protocol, individual plants are spatially located using distance measurements along and 

from a permanent baseline. Each located plant is marked in the field using a permanent tag, 

which is recorded in the rare plant species form. Data are collected on the plant’s status (living 

or dead), stage (seedling, non-reproductive, or reproductive), size (height and diameter), and 

reproductive effort (number of flowers and fruits). Extra variables are also available if the 

observer wants to make observations or comments on each of plant.  
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Surface Fuels 

The Surface Fuels protocol is a planar- and line-transect technique used to assess the downed 

woody debris, duff, and litter on a macro plot. This protocol consists of three sample methods. 

Data is required in all fields for each method so that total fuel load can be computed for the 

macro plot.  

Down woody debris is sampled using the planar transect method (Brown, 1974). Counts of the 

pieces are tallied for the standard fire size classes: 1-hour (0-0.635 cm), 10-hour (0.635-2.54 cm), 

and 100-hour (2.54-7.62 cm). For 1000 hr fuels, which are greater than 7.62 cm in diameter, the 

diameter, decay class*, and slope of each log are required. Duff and litter are entered as depths 

or the entire fuel bed depth can be specified. If duff and litter depth are measured, 

measurements are taken at specified points along each 25-meter line transect segment. Litter 

and duff depths can also be estimated along each transect using methods outlined in Keane 

(1999). Litter depth is estimated as a proportion of total duff and litter depth. Fuel constants can 

be entered separately for each fuel type or users can use a default value provided in FFI. 

* “Sound” and “rotten” are not included in the coarse woody debris (CWD) decay class 

dropdown list. When recording the decay class of CWD, we suggest using the five-decay-

class classification instead of the two class system of "sound" and "rotten". The two-class 

system is useful for fire information, but the five-class system has proven more useful for a 

number of ecosystem applications and should be used whenever possible. This is 

especially true if the Fuel Constant Sets (FCS) are used. The FCS lets you modify some fuel 

attributes that are used to calculate biomass. For example, the specific gravity of CWD in 

each decay class can be defined in an FCS. In the default FCS, the specific gravity of 

decay classes 1 through 3 are set to 0.4, and the specific gravity of decay classes 4 and 5 

is set to 0.3. If you wish to use the two-class system, we recommend that you use decay 

class 3 for sound or decay class 4 for rotten. Enter S or R in one of the UV fields as 

appropriate to remind yourself that the two-class system was used. The characteristics 

used to identify logs in each of the decay classes are discussed in the FIREMON FL 

sampling methods. The FIREMON discussion is based on the CWD classification presented 

in: Maser, C., Anderson, R., Cromack, Jr., K., Williams, J.T., Martin, R.E., 1979. Dead and 

down woody material. In: Thomas, J.W. (Ed.), Wildlife habitats in managed forests: the Blue 

Mountains of Oregon and Washington. USDA Agricultural Handbook 553. pp. 78–95. 

Surface Fuels - Alaska Duff and Litter 

The expanded duff and litter protocol is based on the standard duff and litter sampling method 

found in the Surface Fuels protocol, but it also includes sampling guidelines for collecting the 

depth of the live moss, dead moss, upper duff, lower duff, and lichen layers. The protocol was 

developed primarily for Alaska systems, but it can be used in any ecosystem where assessment 

of any of these components is important. If desired, the user may build a Fuel Constant Set within 

FFI, which includes the bulk density of each component. FFI will calculate the biomass of each 

component of the expanded duff and litter table and provide it in summary reports. 

Surface Fuels - Piles 

The Surface Fuel – Piles protocol is used to assess the biomass of piled fuels. Piles are generally 

composed of post-treatment harvest material (slash) and tend to be scattered across a 

treatment area. In FFI, each pile is considered a plot. In general, the Surface Fuels - Piles protocol 

should only be applied on the piles on a macro plot. Other sampling protocols should be 

applied to describe the other coarse-woody debris fuels.  
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Piles are assessed by measuring the height, width, length, and pile shape. Estimates of the 

packing ratio, species composition and soil content are entered using Hardy, CC, 1998, 

Guidelines for Estimating Volume, Biomass, and Smoke Production for Piled Slash, USDA Forest 

Service Pacific Northwest Research Station General Technical Report PNW-GTR-364, Portland OR, 

28p. The FFI summary reports use these attributes to calculate biomass for individual piles and all 

piles across the sampling site. Emissions can be calculated using the figures in Hardy (1998) or by 

using fire-effects simulation models.  

Surface Fuels - Vegetation 

The Surface Fuels – Vegetation protocol is used to describe the lifeform types on the macro plot 

that may contribute to fire severity and fire spread. This protocol does not include measures of 

downed woody debris, which are sampled using the Surface Fuels protocol (see above). This 

protocol characterizes only the live and dead shrubs and live and dead herbs.  

Surface Fuels – Vegetation uses two 6-ft (2-m) cylindrical sample areas located at specific 

positions along a transect line to describe shrub and herb fuels. Within the cylinder, canopy 

coverage of live woody species (trees and shrubs), dead woody species, live non-woody 

species (herbs), and dead non-woody species are estimated. A height is also estimated for 

each of the four types of fuels. “Cover” is the vertically projected cover contributed by each 

category estimated within the cylinder. It includes plant parts from plants rooted in the sampling 

cylinder and plant parts that project into the sampling cylinder from plants rooted outside. 

Cover is estimated by imagining all of the vegetation in each class pressed to the ground and 

determining what percentage of the cylinder is covered. “Height” is the average height of each 

group as it appears within the cylinder. Detailed information on implementing this protocol can 

be found in the FIREMON User guide. 

Tree: Trees - Individuals; Trees - Saplings; Trees - Seedlings 

The Tree protocols are used to sample individual trees, snags, saplings, poles, and seedlings in a 

fixed-area plot or to estimate tree density, size, and age class distributions before and after fire 

so that tree survival and mortality rates can be assessed. These protocols can also be used to 

sample individual shrubs over 6 ft (2 m) tall. The Trees protocol consists of three distinct methods – 

single tree, diameter class, and height class. If the user does not wish to record data for all three 

methods on a macro plot, each method can also be accessed individually by using the (1) Trees 

– Individuals; (2) Trees – Saplings; or (3) Trees – seedlings protocols.  

Each of the tree forms can be used for specific classes of trees, as long as the user defines the 

diameters or size/height classes of interest. For example, within the single-tree form, all sizes of 

trees (including saplings or seedlings) that meet user-designated break-point diameters can be 

recorded by species. The Trees by Diameter Class form can be used to record trees less than 

diameter class 4 (e.g., saplings) or used to represent some user-defined diameter-based 

classification as long as it is defined in the metadata, comment or user-variable fields. The Trees 

by Height Class form can be used to record trees less than 4.5 ft (1.37 m) tall (e.g., seedlings)) or 

to represent a user-defined height classification.  

The three methods within the Tree protocol provide comprehensive descriptions of tree 

characteristics on a macro plot. The Single-Tree data form allows the user to record measures of 

diameter, height, age, growth rate, crown length, pathogen evidence, fire damage, and snag 

information for each tree above a user-specified diameter. The protocol also includes 

descriptions of how the tree has been affected by burning, where the tree is located on a 

landscape, and what other types of damage that the tree has sustained. The Diameter- and 
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Height-Class forms allow users to track changes in status, number of individuals, and amount of 

crown growth only.  

Vegetation - Line Intercept 

The Line Intercept method is used to assess changes in plant species cover for a macro plot. This 

method uses line transects to sample within stand variation and quantify statistically valid 

changes in plant species cover and height over time. This method is suited for most forest and 

rangeland communities, but is especially useful for quantification of shrub cover greater than 3 

feet (1 m) tall, given that ocular estimation of cover for such species is difficult. The LI method 

can also be used in conjunction with cover-frequency transects when vegetation over 3 feet (1 

m) exists. Line intercept is also used to calibrate ocular estimates of shrub cover when the 

Species Composition (SC) method is used. Canopy cover is recorded as the number of 

centimeters intercepted along a transect. Percent canopy cover is calculated by dividing the 

number of centimeters intercepted by each item by the total length of the transect.  

Comparison of program elements 

The following table compares FFI program elements with those of its predecessor monitoring 

programs. 

FFI FIREMON FEAT FMH 

Administrative Unit PD Plot Description > 

Registration Unit 

Land Unit Park/Unit 1 

Project management 

tab > Project Unit 

(name, agency, 

objectives, description, 

monitoring status, 

candidate plots, 

metadata) 

PD Plot Description > 

Project ID (plot ID, 

organizational 

information) 

Monitoring Unit 

> Macro plot 

Management 

Monitoring Unit > 

Assign macro plots 

(plot ID, monitoring 

objectives, metadata, 

burn prescriptions, 

creation and 

retirement dates) 

Park/Unit 1 

Form FMH-4 

Form FMH-7 (burn 

and/or treatment 

status) 

Also, all information on 

plot ID, burn status, 

treatment history 

required by other FMH 

forms 

Project management 

tab > Sample Event 

(name, type, purpose, 

site characteristics, 

position/location, 

PDOP, installation and 

retire dates. All 

sampling protocols 

and timing are 

assigned here.) Note: 

all biophysical 

descriptions are 

located in separate 

Plot Description 

method. 

PD Plot Description > 

Sample Event (plot ID, 

georeferenced 

information, all 

biophysical 

characteristics) 

Monitoring Design > 

Monitoring Event 

(biophysical 

descriptions, locations, 

etc.) 2 

Form FMH-4 (choosing 

sampling protocols 

and monitoring types) 

Form FMH-5 (GIS, 

location, directions to 

plot, and metadata) 

Form FMH-5a (history 

of site visits) 3 

Form FMH-7 (sampling 

areas) 
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PDA Coordination tab. 

Allows data entry from 

a PDA 

Not available Need separate 

module (FEAT Mobile > 

FEAT for PPC2) to run 

FEAT on PDA 

Not available 

Query tab. Filter, add 

data. classify, group 

and calculate, export 

or print from within FFI 

Simple Query Builder. 

Export all queries for 

printing outside 

program 

Summary Builder. Filter, 

more fields, classify, 

group and calculate, 

export - Access query 

or Excel .xls files 

Not available 

Reports and analysis 

tab > Report 

1. Summary reports by 

sample method or 

attribute or strata 

2. Reports by 

monitoring status 

3. Save, print, or export 

reports 

Reports 

1. Data summary 

reports by sample 

method or attribute 

2. Sampling event filter 

3. Create, clear, save, 

print, or export reports 

Print Monitoring Unit 4 

Metadata 

Print Species List 

Summary Builder 

(export file, print 

outside program) 

 Not available. Entry of 

records indexed for 

checking data input 

Reports and analysis 

tab > Analysis 

1. Custom reports for 

user-defined groups 

2. Bar charts available 

by method and 

attribute 

3. Statistical 

significance 

calculated where 

applicable 

4. Computes 

confidence intervals 

5. Multiple comparison 

procedures 

6. FVS-FE data export 

Data analysis - 

Separate program, 

FMAT, used for analysis 

and statistics 

1. Custom reports for 

special group analyses 

2. Bar charts available 

by method and 

attribute 

3. Statistical 

significance 

calculated where 

applicable 

4. Computes 

confidence intervals 

5. Multiple comparison 

procedures 

Data analysis only for: 

1. Fuel Load 

calculations (under 

Reports and Analysis 

> Fuel Load) 

2. Density, basal area, 

cover and frequency 

calculations (in 

Summary Builder under 

Group & Calculate 

tab) 

Analysis 

1. Single status 

summary, grouped by 

plots, species, 

native/non-native, 

live/dead, size class 

2. Change over time, 

grouped by same as 

above 

3. Confidence intervals 

computed 

4. Bar/line/area graphs 

available 

5. Sample size 

calculations 

Form FMH-26 (data 

analysis record) 5 

Species Management 

tab. Create species list 

that functions with 

dropdown menu upon 

data entry (import lists, 

create new list, add 

from master 

USDA NRCS list, make 

user list, handle 

unknowns, global 

replace feature, print 

species lists. SQL 

database-driven. 

Add species to fields 

as needed from 

lookup table; Access 

database-driven 

Species Management. 

Comparable to FFI 

although screens are 

different; Access 

database-driven 

Form FMH-6 (species 

code list) 6 
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Toolbox tab > External 

data analysis. Import 

data from Excel for 

analysis in FFI 

Copy and paste Excel 

data into Access 

database 

Not available Not available 

Toolbox tab > Protocol 

management. 

Manage (delete, 

retire, or reinstate 

protocols) 

Not available Not available Not available 

FFI GIS spatial analysis 

module. ArcGIS 

toolbar 

Not available Need added module 

(FEAT Spatial for 

ArcGIS) to use GIS with 

main FEAT program. 

ArcGIS toolbar 

Not available 

Protocol Manager 

module. Create new 

method definitions for 

FFI 

Not available Not available Not available 

Photo Management. 

Make separate photo 

folder and store 

photos in it, with link 

from user variable (UV) 

fields if desired. 

Photo storage within 

individual method 

forms (PD form or local 

code fields) 

Data Entry and Review 

> Photos (date, time, 

status, photo list, 

actual photos 

displayed within form) 

Form FMH-23 

(photographic record 

sheet) 

Notes: 

1 The Park/Unit in FMH can correspond to either an administrative unit OR a project unit in FFI depending on 

how a study is set up. For example, if managers wanted to do a study of rare plants in several parks for 

restoration purposes, an administrative unit might be entitled “Western and Central US rare plant study” 

and each park would be a project under that umbrella. In this case, non-agency rare plant studies could 

also be included as separate projects. Each project would be analyzed separately in the reports and 

analysis but all would be accessible within the same FFI user screen. Alternately, if a park/unit was set up as 

an administrative unit, only data from that park would be accessible within FFI at any one time. Projects 

would be specific to the individual park. To view data from another park, you would have to close FFI, 

reopen, and chose another administrative unit (park). 

2 FFI incorporates several FEAT forms, and parts of forms, into the Sample Event, including several fields 

under Monitoring Design (i.e., macro plot, subsamples, assign protocols, and plot templates. 

3 FFI maintains a record of each site visit by sampling event. When you revisit a site, you start a new 

sampling event. After data is entered into a sampling event, the list of sampling events under a macro plot 

becomes the list created in the FMH-5a form. Note: There is no FFI equivalent for form FMH-25, Plot 

Maintenance Log. 

4 FEAT printouts are located in various places within the program and accessed individually. The list 

included here may not be complete. 

5 FFI analyses can be saved and printed or exported to another application and printed to fulfill the 

requirements of FMH-26. 

6 The standard protocols in FFI do not contain a form for recording information on voucher specimens. 

Voucher information would have to be stored within the metadata or within FFI user variables located in 

the method that was used to collect the sample. If a protocol is needed for collecting voucher specimens, 

however, it can be created within Protocol Manager and imported into FFI to fulfill sampling needs. 



253 
 

Comparison of sampling protocols 

The following table compares available sampling protocols in FFI with those of its predecessor 

monitoring programs. 

FFI FIREMON FEAT FMH 

Biomass (Fuels). 

Weights for all live and 

dead surface fuel 

types 

Not available Not available Not available 

Biomass (Plants). 

Green and dry 

weights for clipped 

vegetation 

Not available Biomass. Herbaceous 

wet and dry weight 

  

Not available 

Composite Burn Index 

(CBI) 

1. Plot information 

2. Substrate 

3. Herbs - low shrubs 

<1 m tall 

4. Tall shrubs 1 - 5 m 

tall 

5. Intermediate trees 

6. Big trees 

7. Summary values 

(plot mean) 

CBI 

1. Plot information 

2. Substrate 

3. Herbs, low shrubs, 

tree seedlings 

4. Tall shrubs, saplings 

5. Intermediate trees 

6. Big trees 

7. Composite burn 

index calculation 

CBI 

1. Plot information 

2. CBI A Substrates 

3. CBI B Herbs 

4. CBI C Tall shrubs 

5. CBI D Intermediate 

trees 

6. CBI E Big trees 

7. CBI Summation 

Not available 

Cover - Line intercept. 

Transect, species, 

status, size and age 

class, start point, stop 

point, intercept, 

height 

LI - Line intercept Line Intercept. Line 

intercept, basal and 

aerial 

Not available 

Cover - Species 

composition. Species, 

status, NRF, type 

code, cover, height 

SC - Species 

composition. Species, 

status, cover, height 

Ocular 

cover/observed 

species. Species, 

cover, status 

Form FMH-15 (50 m 

transect data, species 

observed but not 

intercepted)1 

Form FMH-16 (30 m 

transect data, species 

observed but not 

intercepted) 

Cover - Points. 

Transect, point 

number, tape 

location, order, 

species, status, height 

Not available Point transect 
Form FMH-15 (50 m 

transect data) 

Form FMH-16 (30 m 

transect data 
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Used for shrub and 

herbaceous covers 

Cover - Points by 

transects. Transect, 

species, status, hits 

PO Tran - Points 

Intercept by Transect 

PO Frame - Points 

Intercept by 

Frame/Grid 

Not available Not available 

Cover - Frequency CF - Cover Frequency Cover by Frame Not available 

Density - Belts. 

Transect, species, 

status, size and age 

class, count, height 

DE - Belt Density. Herbaceous, 

shrub, and tree density 
Forms FMH-17 and 17a 

(herbaceous density 

data) 

Forms FMH-10 and 10A 

(seedling tree data) 

Density - Quadrats. 

Quadrat number, 

species, status, size 

and age class, count, 

height 

DE - Quadrat Density. Herbaceous, 

shrub, and tree density 

Form FMH-18 

(herbaceous density 

data) 

Disturbance History. 

Change agents, 

disturbance codes, 

and timing variables 

Not available Event Type and 

Disturbance Type 

recorded in Monitoring 

Event 

Not available 

Fuel Characteristic 

Classification System 

(FCCS). Ecoregion, 

vegetation formation, 

structural stage, cover 

type, change agent, 

fire regime, FRCC 

Not available Not available Not available 

Fire Behavior. Fire 

information, location 

information, burning 

conditions, fire 

behavior, fuel 

moisture, and user 

variables for photo 

links 

FB - Fire Behavior Not available 
Forms FMH11, 1a 

Forms FMH-2. 2a 

Form FMH-3 (wind 

speed for smoke use 

only) 

Form FMH-3a (fuel 

load calculations only) 
2 

Metadata. Entered at 

project unit or in any 

of the UV fields in 

each form 

MD - Metadata Metadata entered in 

Monitoring Unit 

Comments or Notes 

area on most FMH 

forms 

Pilot Sampling Not available Pilot Sampling Not available 

Plot Description. Plot 

dimensions, 

biophysical 

description, photo 

PD - Plot Description. 

Biophysical 

description, fuels, 

General plot 

characteristics 

descriptions 

associated with Macro 

Form FMH-4 

(biophysical 
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plots, general fire 

behavior 

photos, plot-level fire 

behavior 

  

Plot and Monitoring 

Unit 

descriptions, 

monitoring type) 

Form FMH-5 (Plot 

location) 

Form FMH-7 (plot 

photo order only) 

Post Burn Severity. 

Tape distance, burn 

effects on vegetation 

and substrate 

Not available Post Burn Severity 
Form FMH-21 (forest 

plot burn severity) 

Form FMH-22 (brush 

and grass plot burn 

severity) 

Rare Plant Species. 

Species, location 

along and from 

baseline, status, 

stage, size, number of 

stems and fruiting 

structures 

RS - Rare Species Not available Not available 

Surface Fuels (3-part 

form) 

1. Fine woody debris 

2. Coarse woody 

debris 

3. Duff and litter 

FL - Fuel Load 

1. Fine woody debris 

(includes duff and litter 

depth) 

2. Coarse woody 

debris 

Fuels 

1. Fuels 1 - 100 

2. Fuels 1000 

3. Fuels LD (litter and 

duff) 

Form FMH-7 (fuel-load 

transect azimuth and 

slope only) 

Form FMH-19 (forest 

plot fuels inventory) 

Surface Fuels - Alaska 

DuffLitter. Transect, 

sample location, 

offset, litter depth, live 

and dead moss 

depth, upper and 

lower duff depth, 

lichen depth, fuelbed 

depth, fuel constant 

Not available Not available Not available 

Surface Fuels - Piles. 

Pile number, pile 

count, shape, 

dimensions, pack 

ratio, specific gravity 

Not available Not available Not available 

Surface Fuels - 

Vegetation. Sample 

location, herb and 

shrub status, cover, 

and height 

FL - Fuel Load 

3. Vegetation (live and 

dead herbs and 

shrubs) 

Not available Not available 

Trees (3-part form) 3, 4 

1. Single trees 

TD - Tree Data 

1. Mature trees 

2. Saplings 

Overstory and Pole 

Trees. Contains 

damage code and 

severity fields, status, 

Form FMH-8 (overstory 

tagged tree data) 
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2. Trees by diameter 

class 

3. Trees by height 

class 

3. Seedlings and break-point 

diameter 

Form FMH-9 (pole-size 

tree data) 5 

Forms FMH-10 and 10a 

(seedling tree data) 

Form FMH-20 (tree 

post-burn assessment) 

Notes: 

1 The Species Composition method could technically be used for Forms FMH-15 and FMH-16 by leaving 

Cover blank. FFI's summary report will not be accurate if Cover is left blank. 

2 FFI has no equivalent for FMH forms FMH-3 and 3-a, which describe visibility, CO exposure, emissions, 

particulates, and smoke. Sample protocols for these elements can be created in Protocol Manager and 

imported into FFI if they are important to sample for a particular study. 

3 The Trees protocol in FFI is a combination of three protocols that incorporate information from several FMH 

forms. If managers want to sample only one size class, they can use the individual FFI tree protocols, which 

include Trees-Individuals, Trees-Saplings, or Trees-Seedlings. These forms include only data entry fields for the 

size class of interest. 

4 FFI does not have protocols for plot-tree mapping (Forms FMH-11, 12, 13, and 14). X-Y coordinates can be 

entered in the Trees (or Trees-Individual) protocol or users can enter X - Y coordinates into the FFI GIS 

module to plot the maps required in these forms. 

5 Only the Trees and Trees-Individual protocols in FFI store the information on tree tags and damage codes 

that is required in Form FMH-9. 


